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Attenzione!

Indipendentemente da quanto possiate odiare i manuali, dovrete leggere per intero questa sezione
per iniziare ad usare il programma.

Vi consigliamo fortemente di completare almeno tre dei cinque progetti tutorial prima di iniziare a
lavorare seriamente con Sibelius. Sebbene Sibelius sia facile da apprendere e in molti casi auto-esplicativo,
se non completate questi progetti rischierete di non scoprire mai alcune delle funzioni base, soprattutto
se siete abituati a lavorare con programmi di notazione che funzionano diversamente. Completando
i progetti — che richiedera solo qualche ora - sarete in grado di inserire, modificare, riprodurre e
stampare musica elementare, e saprete cavarvela anche con musica pitt complessa.

Questa Guida presume che abbiate una conoscenza di base su come usare il vostro computer (il mouse,
la tastiera, menu e file).

Manuale operativo su schermo

Argomenti pill complessi vengono trattati nella Guida di Manuale Operativo Sibelius che
spiega ogni funzione nel massimo dettaglio (con un Glossario di termini speciali). Per ﬁ
aprire il Manuale operativo su schermo fare clic sul pulsante nella barra degli strumenti
indicato a destra, oppure selezionare File » Aiuto e quindi fare clic sul pulsante Manuale
Operativo di Sibelius 7 (comando rapido F1 0 #7?).

Il Manuale Operativo non & pensato per essere letto dall'inizio alla fine, considerato che la maggior
parte degli utenti useranno comunque solo una minima parte della notazione musicale. Potrete
consultare le parti relative del Manuale Manuale Operativo di Sibelius a vostro piacere.

Il Manuale Operativo ¢ anche disponibile come libro stampato acquistabile a parte; per acquistarlo se
non l'avete gia fatto visitate lo store online Avid (shop.avid.com) o la vostra libreria online preferita.

Tipografia e riferimenti incrociati

Riquadri Manuale
Operativo

Si noteranno riquadri
come questi sparsi in tutto
il Manuale operativo, che
illustrano svariate regole
dinotazione e tipografia

I nomi di tasti del computer, menu e finestre di dialogo appariranno cosi.

I comandi di Sibelius si trovano principalmente sul nastro, una larga banda di
pulsanti di comandi che si trovano in cima allo schermo quando fate clic su
una scheda come File o Home. Ogni scheda indica un set di comandi specifico
(Inserimento nota, Notazioni, Testo, Layout, ecc.); quando fate clic su una

scheda, il nastro cambia per mostrare i pulsanti che vi permettono di usare quei
comandi. Ogni scheda del nastro contiene un numero di gruppi di comandi.

Per descrivere rapidamente come accedere a uno specifico comando, questi tutorial usano il seguente
formato: "selezionate Home » Strumenti» Aggiungi o rimuovi" significa "Fate clic sulla scheda Home,
cercate il gruppo Strumenti e fate clic sul pulsante Aggiungi o rimuovi."

Il nastro ¢ spiegato maggiormente nel dettaglio nelle pagine seguenti, per cui se qualcosa non vi ¢ chiaro
non vi preoccupate.

I3 2.1 Alterazioni significa "consultare il capitolo Alterazioni (nel Manuale Operativo)" (o su schermo
o scegliendo File » Aiuto » Manuale Operativo di Sibelius 7, o consultando il libro opzionale del
Manuale Operativo).
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Terminologia elementare
La maggior parte della terminologia informatica riportata di seguito dovrebbe risultare di facile
comprensione per quasi tutti, ma ¢ stata comunque inclusa nel caso qualche termine non sia del tutto

familiare:

Alcuni tasti sono identificati in modo diverso su diversi tipi di tastiere, soprattutto su Mac.
All'interno di questi tutorial sono state usate le seguenti convenzioni:

Simbolo Mac ~ Nome Mac  Equivalente Windows

¥ Command Ctrl ("Control")

& Maiusc Maiusc

~ Option Alt

J Invio Invio (sulla tastiera principale)
~ Invio Invio (sul keypad)

Sibelius ¢ quasi identico sia su Windows che su Mac, ma laddove esistano differenze, sopratutto nei
comandi rapidi da tastiera, la versione per Windows & mostrata per prima. Per ulteriori informazioni
sulle differenze tra i comandi rapidi da tastiera per Mac e Windows, consultare €1 Comandi
rapidi da tastiera nel Manuale Operativo Manuale, che elenca tutti i comandi rapidi da tastiera
disponibili. I comandi rapidi sono comunque visualizzati anche nei menu.

"Premere Ctrl+A o 3A" significa mantenere premuto il tasto Ctrl (Windows) o & (Mac) e premere A.
Sebbene A sia scritto in maiuscolo, non usate Maiusc a meno che non vi venga esplicitamente
richiesto. In maniera simile, per comandi rapidi standard come Ctrl+? 0 #? quando sia / che ?
sono associati allo stesso tasto, dovete digitare Ctrl+/ o 3£/ senza usare Maiusc.

Allo stesso modo, "Alt+clic 0 ~ -clic" significa mantenere premuto il tasto Alt (Windows) o~
(Mac) e fare clic con il mouse.

In Windows, fare clic su qualcosa significa muovere la freccia del mouse sopra [oggetto e fare clic con il
pulsante sinistro del mouse. Un clic destro invece sta ad indicare I'azione di puntare un oggetto
con il mouse e quindi fare clic con il pulsante destro.

Su Mac, fare clic su qualcosa significa muovere la freccia del mouse sopra loggetto e fare clic con il
pulsante sinistro del mouse; se state usando un vecchio modello di mouse con un solo pulsante,
cliccate con l'unico pulsante disponibile. Loperazione Control-clic significa mantenere premuto il
tasto Control sulla vostra tastiera (qualche volta chiamato Ctrl) e fare clic con il pulsante sinistro
(o Tunico pulsante disponibile) del mouse; se disponete di un mouse con pulsante destro potrete
invece semplicemente fare clic con il pulsante destro.

Con trascinare qualcosa si intende I'azione di puntare un oggetto con il mouse, fare clic su di esso
e mantenere premuto il pulsante sinistro (o lunico pulsante disponibile su Mac) mentre muovete il
mouse. Per terminare il trascinamento rilasciare il pulsante del mouse.

Una riquadro ¢ una finestra contenente pulsanti. Alcune finestre di dialogo sono divise in varie
pagine e offrono dei combo box (Mac), identificati come schede nella parte superiore, o box elenco,
su cui potrete fare clic per cambiare pagina nel riquadro.
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« Il keypad ¢ il rettangolo di numeri e altri caratteri situato allestrema destra della tastiera del vostro
computer. (I computer portatili generalmente non dispongono di un keypad dedicato - £ Comandi
rapidi da tastiera nelManuale Operativo per ulteriori informazioni.)

« "Invio" rappresenta il tasto pili grande situato alla destra dei tasti delle lettere. Sebbene su alcune
tastiere sia indicato con "Enter" o con un simbolo speciale a forma di freccia, qui verra sempre
chiamato Invio.

« "Enter" rappresenta il tasto grande situato in basso a destra del keypad. Su alcune tastiere non ¢
chiaramente identificato, ma rappresenta comunque Enter.

Troverete esempi di terminologia meno comune , Glossario alla fine del Manuale Operativo.

Inglese americano e britannico
Sibelius e questi tutorial sono scritti in inglese americano, ma per facilitare la comprensione ai lettori
di altre nazionalita, alcuni termini non americani come "crotchet" sono inclusi tra parentesi.

Ai lettori del Regno Unito potrebbe interessare sapere che in America sono di uso corrente sia "bar"
che "measure" (abbiamo quindi optato per l'universale” bar") e "staft" ¢ 'equivalente dell'inglese "stave".
Tutti i lettori del Regno Unito che dovessero sentirsi offesi dalla scrittura americana di termini come

"center", "color" e cosi via potranno usare una penna per correggere i termini sul Manuale Operativo o
(meno efficacemente) sullo schermo.

Suggerimenti
Segnalazioni di errori e refusi sono sempre ben accette, cosi come qualsiasi suggerimento su come
migliorare i tutorial e il Manuale Operativo. Inviatele via e-mail a docs@sibelius.com.

Ci piacerebbe anche ricevere i vostri suggerimenti su come migliorare Sibelius stesso; pubblicate i vostri
suggerimenti nella pagina di discussione sul sito web di Sibelius, o contattando il supporto tecnico.
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Informazioni sui progetti

Questi tutorial sono composti da cinque progetti, che richiederanno circa otto ore per essere analizzati
dallinizio alla fine. Si consiglia di studiare almeno i primi tre progetti, in cui vengono illustrati i concetti
base e le funzioni che userete pili frequentemente in Sibelius. Il quarto e quinto progetto si centrano
su funzioni piu specifiche, sebbene sia consigliabile analizzarli comunque, nel caso disponiate del
tempo necessario.

Progetto 1 (2 ore)
Questo progetto mostra come aprire una partitura, introduce i concetti di spostamento all'interno
della partitura usando sia la finestra Navigator sia i vari comandi rapidi da tastiera e mouse, come eseguire
operazioni di selezione e copia e incolla. Usando un arrangiamento del brano folk Scarborough Fair,
apprenderete a modificare e inserire note utilizzando il mouse, la tastiera del computer e la tastiera MIDI,
e come inserire testi. Sara illustrata la riproduzione e come contrassegnare la partitura con testi e
dinamiche.

Progetto 2 (2 ore)

In questo progetto si apprendera a ricreare un estratto della composizione di Elgar "Quartetto d’Archi
in Mi Minore", Op. 83 attraverso la scansione delle quattro parti strumentali usando PhotoScore Lite
e successivamente a copiarle e incollarle in una nuova partitura. Si apprendera a creare cambi di chiave
e di indicazione di tonalita, modalita pitt complesse di immissione note, tra cui i gruppi irregolari e
a esplorare i diversi tipi di oggetti, comprese articolazioni, linee, legature di valore, legature di portamento
e testo, comunemente usati per arricchire le partiture. Verrete inoltre introdotti all'uso delle parti
dinamiche e a come esportare file grafici da Sibelius.

Progetto 3 (2 ore)
Questo progetto illustra i concetti fondamentali della composizione per tastiera, chitarra e batteria,
includendo un’introduzione alla creazione dei simboli di accordo e strutture di ripetizione (comprese
linee di 1° e 2° finale, D.S. e al Coda). Scoprirete inoltre come regolare la riproduzione attraverso la
finestra Mixer, e come utilizzare la finestra Idee di Sibelius per memorizzare e riutilizzare piccoli
frammenti musicali.

Progetto 4 (1 ora)
Questo progetto si rivelera particolarmente utile se prevedete di creare materiale didattico per studenti
o di insegnare in classe con Sibelius, oltre a mostrare alcune tecniche avanzate per configurare e formattare
la vostra musica. In questo progetto creerete un quaderno di lavoro di scale e apprenderete a ordinare
righi, nascondere righi vuoti, cambiare il font del testo e molto altro ancora.

Progetto 5 (1 ora)
Questo progetto introduce la finestra Video ed esplora le tecniche di composizione per video, tra
cui 'impiego di timecode, hit points e un plug-in dedicato a modificare la durata di una sezione di musica.
Utilizzando un video dalla serie animata Mr. Bean, apprenderete inoltre ad esportare una traccia audio
da Sibelius per aggiungerla come colonna sonora ad un video, all'interno di un programma come
Avid Studio.
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1.1 Aprire una partitura

1.1 Aprire una partitura

Il primo capitolo di questo progetto mostra come aprire una partitura in Sibelius e come spostarsi
all'interno di essa; apprenderete inoltre a stampare una copia dell'arrangiamento che creeremo nei
prossimi capitoli.

Aprire un file
Sibelius offre alcune partiture d’ esempio che dimostrano vari aspetti del programma. Potete modificarle
senza preoccupazione alcuna, visto che gli originali rimarranno intatti sul DVD-ROM di installazione.
Aprirne una adesso.

Selezionate la scheda Recenti del riquadro Avvio rapido e fate clic su Progetto 1, quindi fate clic su Apri.

In alternativa, potete aprire il file con il vecchio metodo: selezionate File» Apri (scorciatoia
Ctrl+O oro #0). Apparira una finestra di dialogo standard Apri.

In Windows dovreste trovarvi in una cartella chiamata Partiture, che conterra un collegamento
alla cartella chiamata Partiture Esempio di Sibelius. Fate doppio clic su di essa e spostatevi allinterno
della cartella File Progetto, selezionate la partitura Progetto 1 e fate clic su Apri. Si tratta di un
arrangiamento della tradizionale ballata Scarborough Fair.

Da notare che & anche possibile aprire le partiture mentre Sibelius non ¢ in esecuzione -
individuate il file sul vostro computer e fate doppio click su di esso in modo da aprirlo f
direttamente in Sibelius (se non era gia in esecuzione, Sibelius si aprira automaticamente). '

Le partiture di Sibelius usano icone come quella qui mostrata alla destra. [_siB__]

Dopo aver aperto la partitura Scarborough Fair la musica verra visualizzata e dovrebbe apparire

piti 0 meno cosi:
Mimimizzare 1l

Barra del titolo pulsante del nastro  Pulsanti Finestra
| | —l—
Le schede del R pilaerior -sivenus? | =&
Home  InserimentoMots  Netarioni  Testo  Riproduci  Layout  Aspetto  Pati  Revisions  Vists e 5 @ Pulsante
nastro 4 Toge = i B g Yow Y Vo = m @M@ ¥
Il nastro Incali z i o Aggiungi Eimina o M fil :: L‘:':w M pssaagio Accolurs NTf:Z‘"v Colore :IV:::N Propricts | Plgrins Aiuto
Schede dei B Cc;lm;uare
documenti scheda
E .
SCARBOROQUGH FAIR = | Aprireuna
T e ég,: nuova scheda
"TRADITIONAL FOLK SONG
Alego I
Voice ré.w i | | i ol éﬁ
7
Cuinaians (63 = F =—= — nor ST
R 5 —— ==
s — _— = zoas Fe—
semsccnie B2 = R e e e 3
i o= ==
ElecticBass (D532 et | Fe === =
o
o = = [
Droki, [ —r—llr—v—a—H s s . & = 1
S = : * wa [
38 7z fr e — ==
i [[655 = :
‘ PN —
i e e e =
e, |2
o =1 = ; =
lvigmmﬁ T Alte concerto FEEEL A ) ®
T I 7 A}
Informazioni Barra di stato Pulsanti visualizzazione  Controlli di zoom
documento
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Il nastro
Il nastro ¢ la larga banda di pulsanti di comando presente in cima a ogni finestra di Sibelius che
contiene tutte le funzioni del programma, organizzate a seconda delle operazioni.

12

Il nastro stesso ¢ diviso in 11 schede. La scheda File ¢ diversa dalle altre schede, permettendovi di
importare ed esportare file di formati diversi, stampare, accedere alle funzioni didattiche, ottenere
aiuto approfondito, tutta la sezione £ 1. Scheda File nel Manuale Operativo ¢ dedicata a questo.

Le altre schede sono disposte indicativamente secondo 'ordine nel quale si eseguono normalmente le
operazioni quando si lavora a una partitura, per cui dall'inizio alla fine del progetto vi muoverete

attraverso le schede del nastro da sinistra a destra.

Le 10 schede rimanenti contengono i seguenti tipi di comandi, organizzati in gruppi:

Home: operazioni di impostazioni di base della partitura, come aggiungere o rimuovere strumenti
(righi) e battute, oltre a operazioni cruciali come quelle relative agli appunti e ai potenti filtri di
Sibelius. - 00 2. Scheda Home nel Manuale Operativo.

Inserimento note: relativi agli inserimenti alfabetico, step-time e Flexi-time, pit le operazioni di
modifica delle note, come il cambio delle voci, nonché strumenti di composizione come espandi/riduci
e le trasformazioni come inversioni e cosi via - [0 3. Scheda Inserimento note nel
Manuale Operativo.

Notazioni: tutte le indicazioni fondamentali che non siano note, incluse chiavi, indicazioni di tempo,
stanghette speciali, linee, simboli, tipi di testa di nota, ecc. - €3 4. Scheda Notazioni nel Manuale
Operativo.

Testo: comandi per lo stile e le dimensioni del font, scelta dello stile testuale, versi, simboli
accordo, richiami per le concertazioni e opzioni per la numerazione di battute e pagine — consultare
(0 5. Scheda Testo nel Manuale Operativo.

Riproduzione: configurazione di riproduzione, controlli di trasporto, Live Tempo, Live Playback e
opzioni per l'interpretazione da parte di Sibelius delle indicazioni sulla partitura durante la
riproduzione - J 6. Scheda Riproduci nel Manuale Operativo.

Layout: impostazione del documento, dimensioni della pagina e dei righi, spaziatura tra i righi,
nascondi righi, opzioni Layout magnetico e comandi per la formattazione - [ 7. Scheda
Layout nel Manuale Operativo.

Aspetto: opzioni che influiscono sull'aspetto visivo della vostra partitura, tra cui una scelta di
house style, spaziatura tra le note e nomi degli strumenti, e inoltre comandi per reimpostare l'aspetto,
la posizione e le altre proprieta degli oggetti della partitura — (3 8. Scheda Aspetto nel Manuale
Operativo.
Parti: opzioni relative alle singole parti strumentali - €3 9. Scheda Parti nel Manuale
Operativo

Revisione: aggiunge e revisiona i commenti nota adesiva, crea e gestisce diverse versioni
all'interno della vostra partitura, confronta revisioni e accede a diversi plug-in di verifica di
lettura - 3 10. Scheda Revisione nel Manuale Operativo.

Vista: cambia le impostazioni relative all'aspetto di "invisibili" (indicazioni utili che non vengono
stampate, ma che forniscono informazioni utili sull impostazione della vostra partitura), mostra o
nasconde pannelli extra per operazioni avanzate e organizza o scorre tra diverse finestre dei documenti
aperte - [ 11. Scheda Vista nel Manuale Operativo.



1.1 Aprire una partitura

Per saperne di piti sul nastro, L) Lavorare con il nastro nel Manuale Operativo. Per ora torniamo a
vedere come navigare attraverso una partitura.

Muoversi nella partitura

Esistono vari modi per spostarsi all'interno della partitura, ma il piti semplice ¢ usare il mouse per
trascinare il foglio sullo schermo. Per far cio, fare clic su una parte vuota del foglio e trascinare la pagina.
Durante loperazione notate come il display nel rettangolo grigio nell'angolo in basso a sinistra dello
schermo si muove a sua volta. Questo rettangolo si chiama Navigator; mostra una vista in miniatura di
alcune delle pagine. Il rettangolo bianco sul Navigator mostra quale porzione della musica viene
visualizzata su schermo.

Se il Navigator non ¢ aperto, attivatelo tramite Vista » Pannelli» Navigator (scorciatoia Ctrl+Alt+N
0 ~¥N) - consultare Mostrare e nascondere i pannelli sotto.

Facendo clic in qualsiasi punto del Navigator la vista saltera immediatamente alla sezione della
partitura selezionata.

In alternativa & possibile fare clic sul rettangolo bianco del Navigator e trascinarlo, muovendo in
modo controllato la finestra allinterno della partitura. Leffetto visivo risultante é particolarmente
impressionante, come se si stesse muovendo una telecamera sulla partitura.

In spartiti particolarmente lunghi, se trascinate il rettangolo bianco verso il lato sinistro o destro
del Navigator, la vista continuera a spostarsi verso sinistra o verso destra. Piu si trascina, pill rapido
sara il movimento attraverso la partitura. In questo modo potremo muoverci di forma continua
attraverso qualsiasi numero di pagine.

Mentre vi muovete nella partitura con il Navigator sara possibile vedere che le pagine sono affiancate su
una scrivania color blu. In partiture particolarmente lunghe, le pagine sono combinate traloro in coppie,
come se la partitura fosse aperta su una superficie piana, in modo da poter vedere chiaramente ogni
cambio di pagina. Possiamo cambiare il modo in cui le pagine della partitura sono organizzate,
secondo una visualizzazione dall’alto verso il basso, laterale e come pagine singole o affiancate -
v.[d 11. Scheda Vista nel Manuale Operativo.

Non ¢ possibile trascinare il rettangolo bianco al di fuori del margine superiore o inferiore della pagina
mostrata nel Navigator, o oltre il margine sinistro della prima pagina o quello destro dell'ultima.
E invece possibile fare clic sul foglio e trascinare la partitura oltre i margini dello schermo. Se i si trova
in questa situazione, fare clic in qualsiasi punto del Navigator per visualizzare di nuovo la partitura.

Se si nota che il movimento attraverso la partitura & troppo lento, provare a impostare il foglio e/o la trama
del fondo dellintera partitura e delle parti in modo che usino colori semplici. Per suggerimenti su come
cambiare la visualizzazione in Sibelius, consultare £J 1.25 Impostazioni visive nel Manuale
Operativo.

Se si dispone di un mouse con rotella, & possibile usarla per scorrere la partitura:

« Scorrere la rotella in alto e in basso per muovere la pagina in alto o in basso; tenere premuto Alt o ~
per muoversi di una schermata alla volta

 Mantenere premuto Maiusc e scorrere la rotella per spostare la pagina a sinistra e a destra;
tenere anche premuto Alt 0 ~ per muoversi di una schermata alla volta

« Potete usare la rotella anche per lo zoom, tenendo premuto Ctrl 0  — vedere Zoom sotto.

13
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E inoltre possibile spostarsi nella partitura mediante comandi rapidi da tastiera. Sibelius offre numerosi
comandi rapidi che ci permettono di eseguire unoperazione digitando un tasto, invece che usare il mouse.
Vi consigliamo di apprendere almeno i comandi rapidi da tastiera utili per le operazioni piti comuni —
trovate lelenco in fondo alla Guida, e tutti i dettagli in C3Comandi rapidi da tastiera nel Manuale
Operativo.

Provare a sperimentare con i seguenti comandi rapidi, utili per spostarsi nella partitura:

+ PagSu ( #su alcune tastiere Mac) e PagGit (¥ su Mac) muovono in alto o in basso l'intera schermata

« Home (K su Mac) e End (N su Mac) muovono di un’'intera schermata verso sinistra e destra,
o di un’intera pagina nel caso I'intera larghezza della pagina sia visibile.

« Ctrl+Home 0#~ e Ctrl+End 0 N per spostarsi alla prima o allultima pagina. (Alcune tastiere Mac
non dispongono di un tastoN (End), nel cui caso usate < K invece, per muovervi di una schermata
verso destra, e &3 per spostarvi all'ultima pagina.)

All'interno di Sibelius premere il tasto Ctrl 0 #abbinandolo a un altro tasto generalmente crea un
effetto del tipo "fai questo, ma in grande" — in altre parole, premere laltro tasto senza Ctrl o ¥ eseguira
loperazione normalmente; abbinandolo ai tasti Ctrl 0 #otterremo una versione ingigantita della stessa
operazione. Varie operazioni all'interno di Sibelius ricorrono all'uso di Ctrl 0 & per un effetto maggiore,
tra cui spostare note o altri oggetti (come testo), aumentare o ridurre la spaziatura della nota, ecc.

Probabilmente il tasto piti utile durante l'utilizzo di Sibelius ¢ il tasto Esc. Esc vi salvera in qualsiasi
situazione vi troviate! Se fate clic su una nota (o qualsiasi altro oggetto nella partitura) e la selezionate
non intenzionalmente, sara sufficiente premere Esc per deselezionarla; premete Esc anche nel caso in
cui vogliate cancellare o interrompere unoperazione in Sibelius.

Panorama
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Sibelius offre numerosi strumenti in grado di rendere piti semplice il vostro lavoro su una partitura.
Una forma pit comoda di visualizzare una partitura mentre state lavorando ¢ attraverso I'impiego
di Panorama.

Per passare a Panorama, selezionate Vista» Vista documento» Panorama (scorciatoia ﬁ
Maiusc-P), oppure fate clic sul pulsante Panorama sulla barra di stato sul fondo della finestra.
Il pulsane ¢ sulla destra.



1.1 Aprire una partitura

La vostra partitura verra immediatamente organizzata come un singolo sistema su una pagina
infinitamente larga:
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Panorama vi permettera di inserire musica senza che Sibelius muova la pagina in alto e in basso, che
potrebbe risultare dispersivo; invece la partitura si muovera solo da sinistra verso destra. Tutti i metodi
di navigazione gia visti funzionano in Panorama esattamente come nella normale visualizzazione, eccetto
il Navigator, che non appare all'interno di Panorama (perché la partitura non & pili organizzata in pagine).

In altri programmi questo tipo di visualizzazione & talvolta chiamata veduta a scorrimento o galleria.
Disattivate nuovamente Panorama selezionando Vista » Visualizzazione documento » Panorama,
oppure facendo clic nuovamente sul pulsante della barra di stato. Forse avrete notato il margine
magico blu, che mostra sempre chiave , tonalita e nome dello strumento per ciascun rigo, sovrapposto
sul margine sinistro di Panorama.

Per maggiori informazioni su Panorama, consultare CJ 11.1 Visualizzazione Documento nel
Manuale Operativo.

Zoom

Ci sono diversi modi per regolare lo zoom della partitura, ma il pit1 veloce ¢ usare le scorciatoie da tastiera:
Ctrl++ 0 &+ per ingrandire, oppure Ctrl+— or 3— per rimpicciolire. Se avete una nota o altro oggetto
selezionati, Sibelius eseguira lo zoom centrandolo sulla selezione. Fate clic sulla prima nota del
rigo della voce della partitura Scarborough Fair e zoomate. Fate caso al fatto che cosi facendo la
percentuale dello zoom nel menu a tendina della barra degli strumenti cambia. E possibile
selezionare un grado di zoom specifico dalla casella di riepilogo o digitare il valore direttamente.

Se disponete di un mouse con rotella potrete eseguire zoom in e out continui mantenendo premuto
Ctrl 0 #e muovendo la rotella verso l'alto e il basso.

Si provi a ridurre in modo da visualizzare 'intera pagina di musica sullo schermo. Successivamente
tornate ad uno zoom del 100%, che offre dimensioni adeguate per la maggior parte delle operazioni
all'interno di Sibelius.
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Mostrare e nascondere i pannelli

Se il vostro schermo comincia ad essere troppo disordinato potete usare Vista» Pannelli per nascondere
qualsiasi pannello di Sibelius, compreso il Navigator, gia analizzato precedentemente.

Il keypad in basso a destra dello schermo rappresenta uno strumento indispensabile per inserire note,
alterazioni, articolazioni e altri segni, e puod essere mostrato o nascosto attivando/disattivando
Vista» Pannelli» Tastierino.

Potete anche nascondere tutti i pannelli di Sibelius selezionando Vista» Pannelli» Nascondi tutto.
Fate clic nuovamente sul pulsante per mostrare i pannelli aperti precedentemente.

Versioni

Mentre state lavorando su un brano musicale puo essere utile salvare due differenti versioni della
stessa partitura — specialmente se state sperimentando o se state lavorando su diversi arrangiamenti
dello stesso pezzo. Sibelius permette di memorizzare tutte queste differenti versioni all'interno dello
stesso file, in modo da potersi muovere indietro (o in avanti) attraverso levoluzione della vostra partitura.

Tutti i file relativi ai progetti su cui lavorerete all'interno di questa Guida contengono varie versioni
differenti, corrispondenti ai titoli del capitolo, per poter facilmente capire da dove cominciare a lavorare.

Potete vedere rapidamente quale versione state visualizzando, nonché le altre versioni nel file dalle
schede dei documenti, sotto il nastro. Queste vi permettono di aprire diverse visualizzazioni dello
stesso documento in una singola finestra.

Potete aprire nuove schede utilizzando il pulsante + sul lato destro della barra delle schede, EI
che apre un menu con tutte le possibili visualizzazioni della partitura corrente, versioni incluse. —
Potete inoltre arrivare a questo menu facendo clic con il tasto destro(Ctrl-clic su Mac)
ovunque nella barra delle schede.

Tutte le versioni, eccetto la Versione corrente, non sono modificabili, per cui, sebbene non potrete
applicare alcun cambio alla partitura, potrete riprodurle, stamparle, selezionare note e altri oggetti,
e copiarne la musica. Per vedere un'altra versione, selezionatela dal menu per aprirla in una nuova
scheda documento.

Visto che per completare il resto di questo progetto avrete bisogno di una stampa dell'arrangiamento
finale di Scarborough Fair, proviamo a stamparlo adesso. Selezionate Revisione » Versioni» Modifica
Versioni oppure fate clic per aprire il riquadro Modifica versioni. Dallelenco di versioni selezionare
1 Aprire un file e fate clic su Rendi Corrente. Sibelius vi chiedera se desiderate rendere questa versione
la versione corrente e creare una versione non modificabile di quella esistente. Fate clic su Si.
Dovreste adesso essere in grado di vedere un arrangiamento completo di Scarborough Fair senza i
righi degli archi visibili.

Per ulteriori dettagli, consultare L3 10.3 Versioni nel Manuale Operativo.

Evidenzia su righi
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La partitura appena resa corrente usa la funzione Evidenzia Righi Selezionati di Sibelius per rendere
invisibili i righi su cui non stiamo lavorando. Dato che in questo progetto non dovremo lavorare su
nessuna delle parti di archi, risparmieremo un po’ di carta facendo si che non appaiano nella stampa!

Selezionate Layout» Nascondi righi » Evidenzia righi (scorciatoia Ctrl+Alt+F o ~&F) per disattivare
Evidenzia righi.



1.1 Aprire una partitura

Immediatamente le parti nascoste vengono mostrate. Dato che non ci servono, riattivate Evidenzia righi
selezionando Layout*Nascondi righi» Evidenzia righi. (Si puo capire al volo se sono stati nascosti
dei righi in questo modo guardando la barra di stato sul fondo della finestra, che riportera"Evidenzia
righi" quando la funzione ¢ attivata.)

Per maggiori informazioni, consultare £ 7.4 Evidenzia su righi nel Manuale Operativo.

Stampare una partitura

Selezionate File» Stampa (scorciatoia Ctrl+P or 3P) per vedere il pannello Stampa e l'anteprima.
Non preoccupatevi delle opzioni: fate clic sul pulsante Stampa per stampare la vostra partitura.

Nel giro di pochi secondi una stampa di alta qualita della partitura di Scarborough Fair dovrebbe uscire
dalla vostra stampante. Conservare questa stampa perché sara necessaria per leggere la musica
quando in breve si analizzeranno le modalita di inserimento note.

Se incontrate un problema, consultate £1 1.10 Stampa nel Manuale Operativo per aiuto.

Per il prossimo capitolo di questo progetto avremo bisogno di modificare una differente versione.
Selezionate nuovamente Revisione» Versioni» Modifica versioni. Dallelenco di versioni
selezionate 2 Modifica e inserimento note e fate clic su Rendi Corrente. Sibelius vi chiedera se
desiderate rendere questa versione la versione corrente e creare una versione non modificabile di
quella esistente. Fate clic su Si. Adesso dovreste essere in grado di vedere un arrangiamento incompleto
di Scarborough Fair.
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1

.2 Modifica e inserimento delle note

Per completare questa sezione del progetto dovreste aver gia fatto si che la versione 2 Modifica
e inserimento note sia la Versione corrente (vedere sopra). Se non l'avete gia fatto, selezionate
Revisione » Versioni» Modifica Versioni, selezionate questa versione dalla lista e fate clic su
Rendi corrente.

La gran parte delle operazioni che compirete all'interno di Sibelius sono relazionate all'inserimento di
note e alla modifica di cio che & stato immesso. Sibelius vi permette di inserire musica in vari modi —
attraverso la scansione di un foglio musicale stampato, suonando una tastiera o una chitarra MIDI,
inserendo le note con il mouse, aprendo file provenienti da altri programmi — ma la forma piti rapida &
impiegando la tastiera del computer e modificando i risultati durante il processo.

Il tasto Esc é la migliore risorsa disponibile

Prima di apprendere a immettere e modificare le note in una partitura, ricordate che abbiamo
scherzosamente considerato il tasto Esc come la carta jolly che puo salvarci in ogni situazione?
Effettivamente, sia che stiate inserendo 0 modificando la vostra musica in uno dei tanti modi previsti
da Sibelius, il tasto Esc si rivela della massima importanza. Puo essere usato in qualsiasi situazioni
tra quelle seguenti:

« Durante l'immissione di note con il mouse, premendo Esc interromperemo I'inserimento di ulteriori
note

« Durante 'immissione di note usando la tastiera del computer, premendo Esc interromperemo
Iinserimento di ulteriori note lasciando selezionata 'ultima nota inserita

« Durante la modifica di una parte di testo, premendo Esc interromperemo l'inserimento o la
cancellazione del testo lasciando selezionato loggetto

« Nel caso sia presente una selezione, premendo Esc verra deselezionata
« Nel caso Sibelius stia riproducendo la vostra partitura, premendo Esc interromperemo la riproduzione.

E inoltre possibile fare clic il pulsante in alto a sinistra di qualsiasi layout del keypad — quello che mostra
I'immagine del puntatore del mouse - per eseguire la stessa funzione (vedere Il keypad, in seguito).

Muoversi tra le note
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Sebbene Sibelius vi permetta di fare clic su una nota per selezionarla (cambia colore e diventa blu, cosi
sara possibile modificarla), la forma pili rapida per muoversi tra le note all'interno di Sibelius rimane la
tastiera del computer. Potete muovervi avanti o indietro da una nota o pausa alla successiva usando i
tasti € e > per spostarsi alla prima nota o pausa della battuta semplicemente premete Ctrl+< o Ctrl+->.
Si ¢ fatto caso? Questo ¢ un altro tipico esempio di "fare una cosa, ma alla grande".

E possibile usare il tasto Tab (sopra Caps Lock sulla vostra tastiera del computer) per muoversi in
avanti attraverso ogni oggetto attaccato ad un rigo specifico. Tab seleziona il primo oggetto della pagina,
in modo da evitare completamente l'uso del mouse. Provatelo nella partitura Scarborough Fair:
assicuratevi di non avere selezionato nulla (premendo Esc) e quindi premete Tab. Si dovrebbe notare
come la prima nota del rigo vocale della partitura diventa blu. Continuate a premere Tab per avanzare
attraverso le note, le pause, i segni dinamici e cosi via. Per muoversi all'indietro nello stesso modo,
premete semplicemente Shift-Tab.



1.2 Modifica e inserimento delle note

Il keypad

Il keypad in basso a destra dello schermo vi permette di scegliere valori di nota, [ Tastierino nume.. [
alterazioni, articolazioni, legature e altri segni utili alla creazione e modifica =B~ 7B
delle note. (Le articolazioni sono simboli al di sopra o al di sotto di una nota, || x| =] - |-
come staccato, tenuto e accento. I valore di una nota ne indica la durata. Queste || 4 | # | | |4
parole e altri esempi di terminologia musicale e tecnica sono spiegati nel Glossario || j | |, | »
all'interno del Manuale Operativo.) NN

—~
I tasti numerici a destra della vostra tastiera del computer corrispondono ai pulsanti il_‘__\
del Tastierino. Premere questi tasti & assolutamente identico a fare clic conil || 2 2/3 # Al

mouse sui pulsanti, ed ¢ piti veloce. Se usate un computer portatile (laptop),
vedere Comandi rapidi per Notebook (portatile) in seguito.

Le sei piccole pagine situate sotto la barra denominata Keypad vengono usate per scegliere sei differenti
layout di simboli musicali sul keypad, che identificheremo come primo layout, secondo layout, ecc.
Per cambiare layout ¢ possibile sia cliccare sulle pagine con il mouse che premere F7-F12, o cliccare
sul [*] pulsante (comando rapido +) per scorrere tutti i layout; il ¥ pulsante (comando rapido F7
sotto Windows, — sul keypad per Mac) ci riporta al primo layout.

Si osservi rapidamente che cosa contengono gli altri layout — a quanto pare cose abbastanza oscure.
Il primo layout & quello che si utilizzera pit frequentemente.

La fila di numeri in basso al keypad ¢ usata per determinare la "voce" della nota che state inserendo o
modificando. In questo modo si possono avere ritmi multipli suonati simultaneamente sullo stesso rigo.
Si approfondira questo aspetto in seguito.

Dato che il keypad viene usato da Sibelius per funzioni specifiche, mentre usate Sibelius non sara
possibile disattivare Num Lock per usare i tasti numerici come tasti cursore alternativi, ecc., a
differenza di altri programmi.

usato in sostituzione del tasto Esc - particolarmente utile nel caso usiate Sibelius su una
lavagna interattiva in classe, per non doversi portare una tastiera sotto braccio tutto il tempo
per premere Esc!

|‘ N | 1l pulsante nell'angolo superiore sinistro di ciascun layout (mostrato alla sinistra) puo essere

Comandi rapidi per Notebook (portatile)
Se si utilizza un computer notebook (portatile) sprovvisto di keypad dedicato, probabilmente ci si
chiedera come sara possibile inserire le note. Per fortuna non sarete costretti ad immettere laboriosamente
ogni singola nota usando il mouse; e neppure avrete bisogno di un amico che mantenga premuto il tasto
Fn durante la digitazione!

Sibelius dispone infatti di alcuni comandi rapidi alternativi interni, che con la pressione di un solo
tasto offrono la stessa liberta e velocita durante immissione delle note. Per usarle, selezionate
File » Preferenze (scorciatoia Ctrl+, or 3,), quindi selezionate la pagina Scorciatoie da tastiera.
Selezionate Comandi rapidi per Notebook (portatile) dal menu corrente in cima alla finestra
di dialogo e cliccate su OK.
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Invece di usare i numeri sul keypad, si possono utilizzare i numeri standard sulla parte superiore della
tastiera principale, corrispondenti agli stessi numeri del Tastierino. Quando questa funzione ¢ in uso
ricorrete a Shift-1 - Shift-9 per inserire gli intervalli al di sopra della nota -1 .2 Comandi rapidi da
tastiera nel Manuale Operativo.

Potreste anche voler acquistare un keypad separato da connettere al vostro computer via USB, in
modo da poter usare i comandi rapidi standard di Sibelius.

Salvare il lavoro!

Prima di entrare nei dettagli su come modificare e immettere note, ci si soffermi un istante per salvare la
partitura. E buona abitudine salvare il lavoro regolarmente e creare copie di backup, possibilmente su
dispositivi rimovibili, quali chiavette USB (note anche come "pen drive") o su CD-R.

Per salvare una partitura per la prima volta, selezionate File » Salva (scorciatoia Ctrl+S o #S), trovate
una posizione adatta (es. la vostra cartella Partiture), date un nome alla partitura, quindi fate clic
su Salva. In Windows la cartella Partiture si trova dentro la cartella My Documents; su Mag, la cartella
Partiture si trova nella cartella Documenti.

In questo caso, visto che stiamo lavorando su una partitura pre-esistente che ha gia un proprio nome,
dovremmo usare File » Salva come (comando rapido Ctrl+Shift+S o0 ©#S) per salvare una copia
della partitura con un nuovo nome. Potreste per esempio chiamarla Scarborough e salvarla sul Desktop.

Sibelius inoltre salva automaticamente una copia della vostra partitura ad intervalli regolari di alcuni
minuti all'interno di una cartella speciale. Nel caso di problemi elettrici o se il vostro computer si blocca,
la volta successiva che aprirete Sibelius vi verra data lopzione di ripristinare il lavoro perduto.

E possibile salvare una versione della vostra partitura in qualsiasi momento, che potrete usare per
salvare e revisionare le bozze, per tener traccia degli arrangiamenti, per salvare una copia intatta
prima di apportare cambi importanti o per esportare un registro che documenti lo sviluppo della
vostra partitura. Selezionate Revisione » Versioni» Nuova Versione .

Inoltre, ogni volta che salvate una partitura utilizzando File» Salva, Sibelius crea una copia numerata e la
mette nella cartella Partiture di Backup all'interno della vostra cartella Partiture. Se per esempio la
vostra partitura viene cancellata per errore, o se viene apportata una modifica significativa che in seguito
non vi soddisfa pit, allinterno della cartella Partiture di Backup potrete cercare un backup recente.

Per ulteriori informazioni su queste utili funzioni, &3 10.3 Versionie £ 1.1 Lavorare con i file
nel Manuale Operativo.

Modifica delle note con il keypad
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Ogni tasto del keypad modifica immediatamente la nota attualmente selezionata. Per cambiare la durata
0 aggiungere una alterazione ad una nota bastera semplicemente cliccare su di essa e scegliere il
corrispondente pulsante del keypad. Si scoprira che, imparando a usare i tasti numerici e impiegando
i tasti cursore per la navigazione, sara possibile lavorare molto piti rapidamente che cliccando sui pulsanti
con il mouse.

Provare:

« Nella partitura Scarborough Fair selezionate la seconda nota della parte vocale alla battuta 11, un
B naturale da un quarto(semiminima).

« Premete 3 (sul keypad) per cambiarla in un ottavo (croma) — notate come Sibelius automaticamente
riempie la battuta con una pausa da un ottavo dopo la nota, per far si che la battuta rimanga della
durata corretta.



1.2 Modifica e inserimento delle note

« Cambiatela di nuovo in una nota da 1/4 e premete 9 (sul keypad) per cambiarla da naturale a bemolle.
Se premete di nuovo 9 Sibelius rimuovera l'alterazione ridondante — ma la nota suonera come un Bb
(c®un Bb in chiave). Per fare una prova premete Esc per deselezionare la nota, quindi fateci clic per
selezionarla di nuovo, dovreste sentire Sibelius suonare un Bb. Premete ancora 7 per rendere di
nuovo naturale la nota.

Se niente di tutto cio sembra produrre i risultati previsti, probabilmente non state usando il primo
layout del keypad, nel cui caso cliccate sulla pagine del primo layout (o premete F7) e provate di nuovo.

E possibile anche usare i tasti cursore della tastiera per cambiare altezza delle note selezionate.
Con il B naturale selezionato premete Vfino a che l'altezza cambia in un D sotto il rigo. Premendo
Ctrl +1/V 0 EMNV potremo spostare laltezza selezionata di unottava in basso; provate a trasporre
la nota D allottava superiore premendo Ctrl+ o M 0 #M.

Dovreste ottenere questo:

E==

Se siete passati a Sibelius da un altro programma di notazione musicale potreste avere familiarita con una
diversa disposizione delle scorciatoie del keypad per la durata delle note, dove 5 corrisponde a un quarto
(semiminima). Se volete, potete cambiare l'aspetto del tastierino di Sibelius per usare quest'arrangiamento,
oppure usare un metodo di inserimento alternativo con l'altezza prima della durata, invece che il contrario,

vedremo come fare pili avanti nel corso del progetto Specificare l'altezza prima della durata
a page 35.

Annulla e Ripeti

Se commettete un errore, o se siete insoddisfatti delle le modifiche apportate,

potete risparmiarvi la fatica di tornare indietro per correggere manualmente la H®5- &
vostra partitura. Per esempio, selezionate la nota da 1/4 (semiminima) D
premete 5 sul keypad per cambiarla in una nota da 1/2 (minima). Si osservi come la nota

successiva nella battuta viene sostituita. Provate a fare clic sul pulsante freccia sinistra di accesso rapido
nella barra delle applicazioni su Windows, indicato qua, oppure selezionate Modifica » Ripeti su Mac
(scorciatoia Ctrl+Z 0 #2Z). In questo modo viene annullata l'ultima operazione e si dovrebbe vedere
riapparire miracolosamente la nota cancellata. Sibelius supporta undo a livelli multipli — provate a
premere Ctrl+Z o #£Z ripetutamente per vedere come la vostra partitura viene riportata allo stato
originale in cui era prima di iniziare a modificarla. Continuare ad annullare finché la nota non torna
di nuovo a essere un B naturale.

Fate clic sul pulsante d'accesso rapido al menu degli strumenti freccia destra oppure selezionate
Modifica » Ripeti su Mac (scorciatoia Ctrl+Y o #Y) per ripetere quello che avete appena fatto.

Sibelius include anche una "Cronologia ripetizioni" che elenca tutte le operazioni eseguite recentemente e
permette di tornare indietro nel tempo a una particolare operazione. Per maggiori dettagli T3 Annulla e
Ripeti nel Manuale Operativo.

Sfortunatamente tutto cio funziona solo per le operazioni eseguite all'interno di Sibelius, per cui non
potra esservi di grande aiuto nel caso versiate il caffé sulla tastiera del computer.
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Inserimento tramite mouse e pannello Tastiera
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Linserimento di note con il mouse all'interno di Sibelius é semplice, ma pud anche essere lento e laborioso,
per cui vi consigliamo di provare a usare le scorciatoie appena analizzate per rendere il processo piti rapido.

Tastiera @
Aute 'J E +

C4

Prima di inserire le note, selezionate Vista » Pannelli» Tastiera per aprire il pannello Tastiera.
Si tratta di una tastiera virtuale su schermo che pud mostrare fino a sette ottave di tasti in tre dimensioni
diverse. Fare clic su un tasto con il mouse per sentire riprodotta la nota:

Proveremo a inserire una sezione del contrappunto dall'inizio del rigo di clarinetto, per complementare
la melodia vocale. Iniziare scegliendo la prima nota dal keypad. Per iniziare assicuratevi che niente
sia selezionato all'interno della partitura premendo Esc (o facendo clic sul pulsante in alto a sinistra del
keypad). Adesso premete 4 (sul keypad) per scegliere una nota da 1/4 (semiminima). Il puntatore del
mouse diventa blu scuro per indicare che sta "portando” una nota. Premere . (sul keypad) per cambiare
la nota in una da 1/4 col punto. Muovendo il puntatore del mouse sulla partitura, appare una nota
sfumata grigia che indica dove sara creata la nota quando si fa clic. Si osservi come vengono create
automaticamente anche le linee aggiuntive sopra o sotto lo spartito, in modo da poter accuratamente
posizionare note alte e basse.

Adesso fate clic con il puntatore del mouse vicino all'inizio del rigo di clarinetto, puntando allo spazio A,
secondo spazio dall’alto:

0 \

Ne

Dy,

Se avete fatto clic nel punto sbagliato potete usare Me\ per modificare I'altezza della nota dopo
averla inserita.

Da notare come la nota appena inserita ¢ di colore blu scuro, a indicare che ¢ selezionata, ed una linea
verticale di color blu scuro - il cursore - si trova alla destra di essa.

|
,I‘)I

Ne

!

[Y)

I cursore indica che Sibelius & pronto per 'immissione di ulteriori note. Provare a pensare al cursore
come alla familiare linea presente in qualsiasi software di scrittura. Il cursore si rivela particolarmente
utile per l'inserimento alfabetico, che si analizzera tra poco, per cui € importante sapere come funziona
esattamente.



1.2 Modifica e inserimento delle note

Premete 3 per selezionare la nota da 1/8 (croma) sul keypad e fate clic con il mouse per aggiungere una G
sulla seconda linea dall’alto, per poi premere 4 per selezionare di nuovo la durata da 1/4 e fate clic per
inserire una nota nello spazio E

Il pulsante Quarto sul Tastierino rimane selezionato, cosicché possiate continuare a creare altre note
facendoci clic con il mouse, non dovrete selezionare nuovamente il pulsante Quarto. Aggiungete altre
tre note da un quarto per riempire la battuta seguente, facendo clic per aggiungere una G, una F e una E:
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La battuta successiva inizia con una pausa da 1/4, per cui premete 0 sul keypad e creerete una pausa
(la nota da 1/4 dovrebbe ancora essere selezionata).

Continuate inserendo un contrappunto attraverso la finestra Tastiera, facendo clic sui tasti e usando il
keypad per cambiare i valori delle note. Iniziate premendo 3 per selezionare note da 1/8 (crome) e
inserite la melodia qui sotto, usando la finestra Tastiera; quando dovrete inserire la nota da 1/4 premete
semplicemente 4 sul keypad, prima di fare clic sul tasto della finestra Tastiera (o fare clic sulla partitura)
per aggiungere la nota. Dovreste ottenere questo:
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E anche possibile usare la tastiera per "suonare" la finestra Tastiera — vedere [ 3.5 Finestra Tastiera
nel Manuale Operativo.

Inserire articolazioni e legature con il keypad

Per terminare il nostro contrappunto inseriremo alcune istruzioni di articolazione a beneficio dei
musicisti — pitt avanti vedrete come Sibelius rispetta queste articolazioni anche durante la riproduzione
della vostra partitura!

Allo stesso modo in cui abbiamo imparato a cambiare la durata o le alterazioni della nota selezionata,
i pulsanti del Tastierino aggiungono o rimuovono immediatamente alterazioni e legature: selezionate
una nota, quindi selezionate un pulsante del Tastierino per aggiungere uno di questi oggetti a una nota o
rimuoverlo nuovamente.

Provare:

« Selezionare una nota D da 1/4 (semiminima) nella terza battuta del rigo di clarinetto.

« Sul keypad premere il tasto corrispondente al . (punto di staccato), situato sulla fila superiore di
pulsanti del keypad. In questo modo si aggiungera un segno di staccato alla nota.

« Ripetete loperazione per la nota D da 1/4 nella battuta successiva.
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Ora spostarsi all'inizio della seconda accollatura per aggiungere una legatura di valore:
« Selezionare la nota A da 1/2 (minima) nella nona battuta del rigo di clarinetto.
« Premere Invio (sul keypad) per creare una legatura dopo la nota:

« Adesso utilizzare i tasti cursore e il keypad per aggiungere articolazioni e legature al resto del
contrappunto di clarinetto.
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1

.3 Selezionare e copiare musica

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 1 e
chela versione 3 Selezionare e copiare musica sia la versione corrente, selezionando Revisione »
Versioni» Modifica versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

Dopo aver visto come modificare note esistenti e usare i comandi rapidi da tastiera per maggiore
rapidita, si ¢ pronti ad analizzare come selezionare e manipolare interi passaggi di musica, copiare o
cancellare note e altri oggetti in massa.

Selezioni e passaggi

24

Quando sono selezionati in una partitura, gli oggetti si colorano per indicare che ¢ possibile agire su
di essi usando il mouse e la tastiera del computer. Quasi ogni operazione per modificare la vostra
partitura eseguita all'interno di Sibelius utilizza le selezioni.

Ci sono tre tipi principali di selezione:

« Selezione singola, in cui ¢ selezionato solo un oggetto.
» Selezione multipla, in cui sono selezionati pit oggetti distinti.

« Ipassaggi selezionati, in cui viene selezionata una frase musicale continua, contornata da un riquadro
di colore blu chiaro ("passaggio sul rigo") o da un riquadro doppio viola ("passaggio di accollatura").

Su tutti i tre tipi di selezione si fanno pitt 0 meno le stesse cose. La differenza principale & in come si
selezionano gli oggetti la prima volta.

Analizzeremo come eseguire e usare i differenti tipi di selezione all'interno della partitura di
Scarborough Fair. La selezione di singoli oggetti ¢ abbastanza semplice e abbiamo gia visto come
selezionare note facendo clic su di esse con il mouse, o premendo il tasto Tab.

Per selezionare oggetti multipli dovrete selezionare un singolo, quindi premere Ctrl+clic o #-clic
(per esempio, tenete premuto Ctrl o e fate clic con il pulsante sinistro del mouse) su uno o pili oggetti
da aggiungere alla selezione. Provate a selezionare la prima nota del rigo di clarinetto nella prima battuta
della partitura di Scarborough Fair. Adesso eseguite con precisione Ctrl+clic o 3-clic sulla nota successiva.
Usando questo sistema potrete selezionare testo e altri tipi di oggetti, per cui provate a eseguire Ctrl+clic o
3-clic sul titolo. Se un oggetto viene selezionato per errore potrete rimuoverlo semplicemente usando di
nuovo Ctrl+clic o -clic sulloggetto in questione. Provate a rimuovere il titolo dalla selezione.

Le selezioni multiple vi permettono di modificare gli oggetti specificati: provate a usare i tasti ™ e ¥
per spostare le note selezionate in basso e in alto. Si tratta di una tecnica utile soprattutto per oggetti
diversi da note, accordi e pause - per selezionare gruppi di articolazioni o frammenti di testo, ad esempio.

Prima di apprendere come realizzare la selezione di un passaggio dovrete deselezionare gli oggetti
correnti premendo Esc (o facendo clic sul pulsante in alto a sinistra del keypad).

Un passaggio ¢ una frase musicale continua, in alcuni casi anche piu lunga di una pagina. Puo
comprendere uno o pit1 righi. Normalmente ¢ opportuno selezionare un passaggio per copiare la musica
da uno strumento allaltro, come quando due strumenti si doppiano l'un I'altro. I passaggi vi permettono
di modificare, copiare o cancellare piti note alla volta.



1.3 Selezionare e copiare musica

Per eseguire una selezione di un passaggio su rigo prima di tutto fate clic sulla prima nota nella prima
battuta del rigo di clarinetto. Adesso eseguite con attenzione uno Maiusc-clic su una qualsiasi parte
vuota del rigo nella quarta battuta del rigo di chitarra acustica. Dovreste poter vedere un box singolo
di color blu chiaro intorno a tutte le note intermedie:
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Notate come ogni oggetto attaccato al rigo € stato selezionato all'interno dell'intervallo del passaggio.

Questo si rivela veramente utile per copiare musica, perché le articolazioni, i segni dinamici, testo e tutti

gli altri oggetti attaccati al rigo vengono copiati a loro volta! Non dimenticate che potete usare i

tasti’™ e Uper muovere le note selezionate verso l'alto o il basso. La selezione sara anche visibile in

miniatura all'interno del Navigator.

Ci sono vari modi per selezionare rapidamente alcuni tipi di passaggi sul rigo:

» Facendo clic nella zona vuota di una battuta la si seleziona su quel rigo (per copiarla, ad esempio).

« Un doppio-clic del mouse nella zona vuota di una battuta seleziona quel rigo per la durata
dell'accollatura.

« Un triplo-clic del mouse nella zona vuota di una battuta seleziona quel rigo in tutta la partitura.

« Dopo un singolo, doppio o triplo clic, eseguendo Maiusc-clic del mouse su un altro rigo si aggiungono
tutti i righi in mezzo alla selezione, oppure si possono aggiungere o rimuovere singoli righi con un
Ctrl+clic 0 #-clic.

Per eseguire una selezione di un passaggio di accollatura, Ctrl+clic 0 #-clic su una parte vuota della

prima battuta del rigo vocale. Dovreste vedere apparire un box doppio viola intorno a tutti i righi

per quella battuta:

« Potete mantenere premuto Ctrl 0 3 mentre effettuate un singolo-, doppio- o triplo-clic per selezionare
rispettivamente i passaggi di accollatura per una battuta, la durata dell'accollatura o I'intera partitura.

« Einoltre possibile selezionare I'intera partitura scegliendo Home » Selezione » Tutto (comando rapido
Ctrl+A o 3A). Cio ¢ molto utile per trasportare I'intera partitura, alterare il formato dell'intera
partitura o selezionare particolari tipi di oggetti lungo la partitura.

Troverete ulteriori dettagli sulle selezioni in £ 2.1 Selezioni e passaggi nel Manuale Operativo.

Cancellare note e altri oggetti

Provate a selezionare vari oggetti e poi a cancellarli con il tasto Cancella:

« Cancellate un pezzo di testo, ad esempio il testo Arranger (dalla cima della prima pagina).

« Cancellate una nota: si convertira in una pausa, per mantenere intatta la ritmica della misura.
Potete cancellare una pausa, che la nasconde, lasciando il resto del ritmo allineato come se la pausa fosse
ancora al suo posto. Quando viene cancellata una pausa, cambiera colore a una sfumatura pit chiara, a
indicare che ¢ stata nascosta; quando viene deselezionata scomparira. Normalmente non si dovrebbero
nascondere le pause, ma in alcuni casi di speciali notazioni puo rivelarsi utile. Anche altri oggetti possono
essere nascosti in casi particolari. Per vedere quali sono gli oggetti nascosti, appariranno in grigio
attivando Visualizza » Invisibili » Oggetti nascosti (comando rapido Ctrl+Alt+H o ~-3H).

Potete anche usare Backspace per cancellare oggetti, o scegliere Modifica.
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Home » Appunti» Taglia (comando rapido Ctrl+X o #X) ¢ simile a Elimina, ma gli oggetti vengono
tagliati negli appunti per poter essere incollati da qualche altra parte tramite Home » Appunti» Incolla
(comando rapido Ctrl+V o0 #V). Dato che non userete spesso questa funzione, non sara necessario
provarla adesso.

Ricordate che & possibile usare Annulla e Ripeti per recuperare qualsiasi cosa abbiate cancellato.

Cancellare battute

Si tratta di una funzione particolarmente importante da apprendere, visto che spesso occorrera
rimuovere una o pil battute — sia vuote che no - dalla partitura. Esistono due modi per cancellare
battute all'interno di Sibelius.

Il modo piu semplice ¢ quello di selezionare un passaggio contenente le battute da rimuovere
(vedere sopra) Selezioni e passaggi ¢ scegliere Home » Battute » Cancella (comando rapido
Ctrl+Backspace o0 #Backspace). Vi verra chiesto se volete davvero continuare: fate clic su Si e notate
come potete attivare la casella Non visualizzare piu questo messaggio in modo che Sibelius la
smetta di essere troppo apprensivo (dopo tutto ce sempre Annulla!). Se dopo aver attivato questopzione
cambiate idea e decidete che preferite essere avvertiti ogni volta, potrete far riapparire di nuovo questo e
altri messaggi di avviso facendo clic su Mostra tutti i messaggi nella pagina Altro di File » Preferenze.

Un altro modo di cancellare battute & fare una selezione di un passaggio di accollatura e quindi
premere Cancella.

Provate a cancellare le ultime tre battute della partitura di Scarborough Fair e poi usare Annulla oppure
selezionate Modifica » Annulla su Mac per ripristinarle.

Copia
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Copiare musica attraverso battute, righi e persino file differenti si rivela molto semplice in Sibelius.
Facciamo una prova; cliccate sulla nota staccato da 1/4 (semiminima) nella quinta battuta del rigo di
clarinetto e quindi eseguite Alt+clic 0 ~-clic in uno spazio della sesta battuta vuota del rigo di chitarra
acustica. La nota viene copiata esattamente, ma appare all’altezza corrispondente alla linea o spazio del
rigo dove avete cliccato con il puntatore del mouse. Notate che anche il punto dello staccato € stato copiato;
in questo modo infatti qualsiasi articolazione della nota viene anchessa copiata.

Questo sistema funziona particolarmente bene per copiare grandi frammenti musicali. Iniziate
selezionando la quinta battuta del rigo di chitarra acustica:
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Adesso eseguite Alt+clic o~ -clic nello spazio all'inizio della battuta prima della nota appena inserita

nella sesta battuta, e vedrete questo:
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Sibelius sostituisce la nota precedentemente inserita con la musica appena copiata. Potete usare
Alt-+clic 0 ~=-clic per copiare qualsiasi combinazione di oggetti in una partitura, eseguendo selezioni

>

singole, multiple o di passaggi.



1.3 Selezionare e copiare musica

In Windows, nel caso disponiate di un terzo pulsante del mouse (il pulsante centrale) o una rotella
cliccabile, potrete usarli per copiare e incollare in un’unica operazione, invece di Alt+clic. Se solo
disponete di un mouse con due pulsanti potrete emulare comunque la funzione del terzo pulsante
con un clic simultaneo dei pulsanti sinistro e destro del mouse.

Sibelius permette di duplicare note o altri oggetti della partitura in modo che una copia esatta appaia
subito dopo Joriginale selezionando Inserimento note» Inserimento note» Ripeti (comando rapido R).
Selezionando le quattro battute della linea di basso appena inserita usando Alt+clic 0 ~:-clic e premendo
R vedrete come le battute vengono ripetute dopo le originali. Nello stesso modo potrete usare questa
funzione per ripetere rapidamente qualsiasi nota, accordo, testo, passaggio musicale o altri oggetti.

Potete usare anche il metodo tradizionale per copiare la musica negli appunti, selezionando Home »
Appunti» Copia (scorciatoia Ctrl+C 0 #C), seguito da Home» Appunti» Incolla (comando rapido
Ctrl+V or #V) per incollarle da un'altra parte. Dato che questo metodo ¢ piti lento del precedente non ¢
particolarmente raccomandato, a parte in quei casi in cui si voglia copiare musica tra partiture differenti
(Alt+clic o~ -clic esegue la copia solo all'interno della stessa partitura).

Copia ¢ Incolla sono presenti nel menu contestuale a cui si accede con un clic destro (Windows) o
Control-clic (Mac) quando uno o pil oggetti vengono selezionati.

Completare le misure mancanti nella parte di chitarra copiando la battuta precedente (o pitt misure)
nella rimanenti battute vuote del rigo di chitarra acustica, usando i vari metodi di copia appena analizzati.
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4 Inserimento Flexi-time™
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Se iniziate da questa sezione del progetto, aprite la partitura d'esempio chiamata Progetto 1 e rendete
la versione 4 Flexi-time input la Versione corrente, selezionando Revisione » Versioni» Modifica
versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

Si ¢ gia analizzato I'immissione delle note facendo clic sul rigo con il mouse e inserendo le note con
la finestra Tastiera. Esistono pero modi molto piti rapidi di inserire note, che vi consigliamo di provare
per trovare quello pili adatto alle vostre esigenze — o per usarne pitl di uno alla volta; non ¢ infatti
necessario dire a Sibelius che state cambiando metodo di inserimento. Analizzeremo adesso il peculiare
sistema di Sibelius di inserimento note in tempo reale chiamato Flexi-time.

Inserimento in "tempo reale” significa semplicemente che & possibile suonare all'interno di un
programma e che questo annotera tutte le altezze e il ritmo della propria esecuzione. In teoria, perlomeno.
In pratica si rivela estremamente difficile per qualsiasi programma capire che ritmo si sta eseguendo,
senza analizzare la musica al termine dellesecuzione o senza notevole aiuto esterno. Normalmente
cio significa che si dovra suonare accompagnati da un metronomo nel modo pili preciso possibile,
e successivamente "quantizzare" la musica cercando di ripulire ogni possibile inaccuratezza ritmica
dallesecuzione.

Sibelius offre pero un approccio unico che vi permette di suonare di forma molto pilt libera ed ottenere
comunque buoni risultati.

Se non avete una tastiera o chitarra MIDI, saltate a 1.5 Inserimento alfabetico e step-time
a pagina 32.



1.4 Inserimento Flexi-time™

Uso di un dispositivo MIDI
Per usare Flexi-time sara necessario avere una tastiera o chitarra MIDI collegata al vostro computer.

Una volta che il vostro dispositivo & stato correttamente installato potrete impostare immissione e
riproduzione all'interno di Sibelius. Per fare cio, selezionate Inserimento note » Impostazioni»

Dispositivi di inserimento:
ez 0 T T

Visualizza Dispositivi ingresso

File

Font equivalenti -

1dee Usa Nome dispositive Tipo Mappa ingresso

Dispositivi ingresso
Scorciatoie da tastiera
Lingua

Mouse

Font musicali
Inserimento nota
Incolla come guida

Playback _
Posizione partitura Test: I
Step-time & Flexi-time -
Tertures 1. Attivate la colonna Usa per gli ingressi dei dispositivi MIDI che volete utilizzare.
I ‘::gz”(‘mmm“ 2. Selezionate la riga nell'elenco in alte e suonate alcune note dal dispositivo; I'indicatore Test i illuminera. fl
s 3.Impostate Tipe su Chitarra se il vostro dispositivo di ingresso & una chitarra MIDI, quindi impostate il numero di corde di seguito
4.5e la vostra tastiera ha cursori e pulsanti extra, selezionzte una Input Map (Mappa d'ingresso] appropriata. |
5.1 MIDI Thru & per i dispositivi di ingresso muti. Disattivatelo se il vostro dispositive di ingresso ha suoni integrati,
Canali chitarra MIDI MIDI Thru |
| Numero di corde: Manda dinamiche predefinite per strumenti con sustain I

& Usa ingresso MIDI a bassa latenza

(Attivate questa opzione se riscontrate problemi durante lingresso Step-time
o Flexi-time)

Canale MIDI della corda con lintonazione pi alta 1
Eco note background

ascia dispositivi MIDI all'uscita
Registra messaggi di sistema esclusivo

(necessario per dispositivi HyperControl. Richiede il riavvio di Sibelius)

I Treva Nuevi Dispositivi di Ingresso

Annulla

Dovreste poter vedere il nome del vostro dispositivo nella tabella in cima alla pagina (per esempio
M-Audio Oxygen 8) e assicurarvi che la casella Usa sia attiva. Se state usando una chitarra MIDI
dovrete cambiare il valore Tipo facendo clic sul menu a tendina e scegliendo Chitarra, invece che
Tastiera.

In questo capitolo, si utilizzera una tastiera MIDI. Per ulteriori informazioni su come impostare immissione
e riproduzione con dispositivi MIDI, consultare [J 3.13 Dispositivi ingresso nel Manuale
Operativo.

Opzioni Flexi-time
La cosa pitt semplice da fare & provare a suonare una linea melodica singola. Proviamo a farlo - dovreste
aver di fronte la partitura Scarborough Fair su cui abbiamo lavorato finora.

Registreremo un verso della parte di clarinetto, per assicurarci di ottenere i migliori risultati, fate
clic sul pulsante che apre il pannello in Inserimento note » Flexi-time, sulla destra (scorciatoia
Ctrl+Maiusc+O or ¢ #0).

Dato che registreremo a tempo con altri strumenti — e registreremo soltanto una linea di musica — dovreste
scegliere Nessuna (non rubato) dalla lista Flessibilita del tempo, e disattivare la casella Registra in
voci multiple.

Fate clic su OK per tornare alla partitura.
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Alla prova

Per la lettura della musica, occorrera la stampa della partitura creata all'inizio di questo progetto.

La finestra Trasporta vi permette di vedere e controllare la riproduzione di Sibelius. Se non potete vedere
il pannello Trasporta, attivatelo selezionando Vista» Pannelli» Trasporta (scorciatoia Ctrl+Alt+Y
o~EY):

Play Avanti veloce Flexi-time
Muovi Li.nea di Registra Live
Rewind Arresta \ riproduzionealla/ .. Tempo Playback

Sposta linea di \ \ fine / Muovi Linea di
riproduzione all’'inizio \ Tw%m \ \ i / / / ,@/ riproduzione all'inizio

M« > m » e W L Ta N Clic(on/off)

ke
Slider Timeline —| si00:00°00.0" ¥ ¥ J-102 * o |
Indicatori MIDI in & out Lettura Slider Tempo Corrente
Timecode Tempo
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Se preferite, molti dei comandi di riproduzione sono inoltre accessibili da Riproduzione » Trasporta.

Inizieremo a riprodurre le note con Flexi-time dalla battuta 43 fino alla fine del verso nella battuta 61:
selezionate la battuta 43 nel rigo del clarinetto per evidenziarlo in azzurro (o selezionate il rettangolino
di misura di pausa stesso); questo dira a Sibelius quando iniziare a registrare.

Ora tenetevi forte, non appena selezionerete Inserimento note » Flexi-time » Inserimento
Flexi-time Input (scorciatoia Ctrl+Maiusc+F or ©3F) oppure farete clic sul pulsante di ==
registrazione circolare nella finestra Trasporta, Sibelius vi dara una battuta di precontaggio, quindi
iniziera a registrare quando suonate. Provare adesso:

« Di default Flexi-time offre un pre-conteggio di una battuta — in questo caso dovreste sentire tre clic come
pre-conteggio. (Se non sentite il click del metronomo, assicuratevi che il vostro dispositivo di
riproduzione sia acceso, 1 3.14 Flexi-time oppure (1 6.1 Lavorare con la riproduzione
nel Manuale Operativo).

« Alla fine del pre-conteggio, provate a suonare alcune battute in modo regolare e omogeneo,
seguendo la velocita del metronomo.

« Continuate a suonare quanto volete, e notate come Sibelius visualizza le note sullo schermo
(normalmente sara alcune note in ritardo rispetto alla vostra esecuzione). Probabilmente risultera pitt
facile non guardare lo schermo durante la registrazione!

« Per terminare la registrazione fate clic sul pulsante quadrato di stop nella finestra Trasporta o
premete Spazio.

Date un'occhiata a quello che ha trascritto Sibelius: se non siete soddisfatti del risultato, selezionate
semplicemente le battute che avete inserito, premete Elimina e selezionate nuovamente la battuta 43.
Fate tutti i tentativi necessari, finché non siete soddisfatti del risultato. Se volete che Sibelius rallenti la
partitura durante la registrazione, consultate Regolare il tempo di registrazione, di seguito.

Nel Progetto 3 di questi tutorial apprenderemo come inserire simultaneamente musica su due righi.
Potete anche cambiare altre opzioni come rubato (la flessibilita del vostro tempo), il suono e il pre-conteggio
del metronomo, e il modo in cui le terzine e altri gruppi irregolari vengono riconosciuti — £ 3.14
Flexi-timenel Manuale Operativo.
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Regolare il tempo di registrazione
Non preoccupatevi troppo se avete qualche difficolta o se la vostra tecnica sulla tastiera si &€ un
po’ arrugginita — Sibelius non pretende che siate un virtuoso! Prima di analizzare come ripulire la
trascrizione, si apprendera come rendere pit facile la registrazione Flexi-time.

Lo slider tempo nel pannello Trasporta consente di accelerare o (come necessario in questo caso)
rallentare la riproduzione della partitura. Cio vale anche per la registrazione Flexi-time — agire sullo
slider sul lato sinistro e il click del metronomo rallentera, consentendo di suonare con maggiore
precisione.

Vi consigliamo di usare lo slider tempo solo per cambiare la velocita di riproduzione dellintera partitura;
per cambi di tempo ¢ consigliabile usare testo tempo e segni di metronomo inseriti direttamente nello
spartito — vedere 1.7 Testo e dinamiche a pagina 41.

Riscrivi esecuzione
Si vi trovate con delle pause indesiderate, note che si sovrappongono o durata delle note sbagliata, potete
fare in modo che Sibelius le renda pit1 leggibili. Selezionate il passaggio e scegliete Inserimento note»
Flexi-time » Riscrivi esecuzione, che aprira un nuovo riquadro. Dato che la musica che abbiamo
registrato non prevede alcuna nota inferiore a 1/8 (croma), impostate il menu a tendina quantizzazione
(durata minima) come Normale: 1/8 (croma) e fate clic su OK. Sibelius analizzera di nuovo la
trascrizione Flexi-time e produrra una versione ritmicamente e visualmente piu semplice.

Se ci sono ancora errori potete usare le tecniche di modifica gia apprese per correggere i valori e le altezze
delle note. Potete anche sperimentare altri plug-in nel menu Inserimento note» Plug-in» Plug-in menu,
soprattutto quelli sotto Semplifica notazione.
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1

.5 Inserimento alfabetico e step-time

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 1 ¢
che la versione 5 Inserimento alfabetico e step-time sia la Versione corrente, selezionando
Revisione » Versioni» Modifica versioni, scegliendo questa versione dalla lista e facendo clic su
Rendi corrente.

Adesso possiamo terminare di inserire le note nel rigo di clarinetto; apprenderemo due ulteriori modi
di creare note all'interno di Sibelius. Per la lettura della musica, occorrera la stampa della partitura
creata all'inizio di questo progetto.

Inserimento alfabetico
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Potete inserire note all'interno di Sibelius specificando direttamente le altezze attraverso i tasti A-G
della tastiera del computer, e creare accordi usando i tasti numerici 1-9 della tastiera principale
(non quelli del keypad). Potete anche comporre accordi selezionando le note con il mouse e scegliendo
Inserimento note » Intervalli » Sopra e Inserimento note » Intervalli » Sotto. Usare la tastiera del
computer ¢ molto pili veloce di usare il mouse una volta che si ¢ fatto un po' pratica.

Provate ad aggiungere la musica alla parte di clarinetto dalla battuta 66 alla 68:

« Fate clic sul piccolo rettangolo di misura di pausa alla battuta 66 del rigo di clarinetto, in modo che
diventi blu scuro - questo indichera a Sibelius da dove iniziare. Da questo momento in poi, si cerchi di
non usare il mouse - si provi a resistere alla tentazione!

+ Premete N (la scorciatoia per Inserimento note» Inserimento note» Inserisci note), che fara
apparire il cursore.

« Premete F7 per consultare il primo layout del keypad (nel caso non sia visibile), e premete 3 sul
tastierino per selezionare una nota da un ottavo (croma). Scegliere un valore di nota ¢ necessario
affinché Sibelius conosca la durata delle note che verranno immesse.

« Premete F. Sibelius inserisce automaticamente le altezze in modo che ci sia il minore intervallo
possibile con le note precedenti, ma in questo caso la F & un'ottava troppo bassa, quindi premete
Ctrl+ o0 & alzate la nota di un ottava.

- Digitate C A e quindi Ctrl+1 0 3/ per trasporre la A un'ottava pitl in alto. Da notare che il cursore
avanza dopo I'immissione di ogni nota, mostrandoci cosi dove verra inserita la nota successiva.

- Digitate F C A (utilizzando Ctrl+1 o &1 per trasporre la C un'ottava pill in alto).

« Premere 5 sul keypad per selezionare una nota da 1/2 (minima).

« Premere D 4 (sul keypad) C A. Cosi facendo inseriremo una nota D da 1/2, e C e A come note da 1/4
« Adesso, per inserire un B naturale, premete 7 (sul keypad) per selezionare il naturale.

- Digitate B G per immettere le note B naturale e G del valore di 1/4.

« Una volta terminata l'immissione bastera premere due volte Esc per interrompere la creazione
delle note e deselezionare l'ultima nota.
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Dovreste ottenere questo:
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Esattamente come con il mouse le note vengono create facendo clic sulla partitura, nel caso di inserimento
alfabetico una nota viene creata soltanto quando vengono premuti i tasti A-G. I tasti del keypad
serviranno semplicemente a preparare quello che accadra quando verranno premuti i tasti A-G o
si fara clic con il mouse. Cosi come con il mouse, prima di premere il tasto corrispondente alla nota,
occorre sempre specificare le alterazioni, le articolazioni o qualsiasi altro segno sul keypad. (Se vi
dimenticate, potete sempre tornare indietro e modificare la nota.) L'unica eccezione é rappresentata
dall'inserimento di legature di valore (premendo Invio) che si fa dopo aver creato una nota (solo perché
viene pili naturale dato che la legatura di valore & dopo la nota).

Una volta abituatisi a cambiare la durata con una mano, usando il keypad, e a inserire le altezze con l'altra,
ricorrendo ai tasti A-G e R, troverete questo metodo di creazione delle note estremamente rapido.

Da ricordare inoltre che sara possibile modificare le articolazioni, le alterazioni o qualsiasi altro
attributo di una nota semplicemente selezionandola e premendo il tasto desiderato sul keypad.
Cambiare l'altezza di una nota ¢ altrettanto semplice: selezionate la nota e scrivete la nuova altezza
utilizzando le lettere A-G. Si & gia visto come cambiare la durata di una nota semplicemente
selezionandola e scegliendo un nuovo valore sul keypad.

Usate I'inserimento alfabetico per aggiungere alla vostra partitura il resto della musica mancante
dalla parte di clarinetto, partendo dalla battuta 69.

Per maggiori dettagli, consultare £ 3.1 Introduzioni allinserimento delle note nel Manuale
Operativo.

Accordi via inserimento alfabetico
Esistono due semplici modi per costruire accordi usando l'inserimento alfabetico. Inserire normalmente
una delle note nellaccordo, e successivamente:

« selezionate Inserimento note » Intervalli » Sopra o Inserimento note » Intervalli » Sotto e
selezionate un intervallo dal menu.

+ su una tastiera normale, usare i tasti 1-9 della tastiera principale (non del keypad) per aggiungere
una nota ad un intervallo superiore, 0 Maiusc-1-9 per aggiungere una nota ad un intervallo inferiore;
per esempio, 1 inserisce una nota unisono, 3 aggiunge una nota una terza sopra, Maiusc-6 aggiunge
una nota una sesta sotto. Questi sono i tasti di scelta rapida per Inserimento note » Intervalli » Sopra
e Inserimento note » Intervalli » Sotto.

« premere Maiusc-A-G per aggiungere una nota dell'altezza specificata sopra la nota corrente.
(Non sono previsti comandi rapidi da tastiera per inserire intervalli inferiori).

E possibile continuare ad aggiungere note ad un accordo nello stesso modo.

su una tastiera di un portatile (vedere Comandi rapidi per Notebook (portatile) a pagina 19),
premere Maiusc-1-9 per aggiungere un intervallo superiore, per esempio Maiusc-4 crea una nota
una terza sopra.

Particolarmente utile la funzione che permette di selezionare interi passaggi di note e aggiungere
simultaneamente nuove note sopra/sotto usando i tasti 1-9 o Maiusc-1-9.
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Inserimento step-time
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Abbiamo gia visto come usare un dispositivo MIDI per inserire musica all'interno di Sibelius, registrando
unlesecuzione in tempo reale. E possibile usare la vostra tastiera MIDI (o chitarra MIDI) per
l'inserimento delle note, in modo molto simile all'inserimento alfabetico.

Se non avete un dispositivo MIDI collegato al vostro computer, completate questa sezione usando
il sistema di inserimento alfabetico appena illustrato - o utilizzate il pannello Tastiera e Tasti come
una tastiera MIDI virtuale! (£3 3.5 Finestra Tastiera nel Manuale Operativo.)

Linserimento step-time ¢ simile all'inserimento alfabetico ma impiega un dispositivo di ingresso MIDI,

e si rivela ancora pit rapido. Tutto quello che dovrete fare sara:

+ Selezionare una pausa da cui iniziare a creare le note, e premere N per far apparire il cursore.

« Scegliere un valore di nota sul keypad (ricordatevi di questo passo, altrimenti Sibelius dovra provare
ad indovinare).

« Iniziare a suonare le note desiderate sulla tastiera MIDI. Come con l'inserimento alfabetico, prima
di creare una nota dovrete scegliere unarticolazione o qualsiasi altro segno usando il keypad. I tasti
del keypad selezionati rimarranno attivi fino ad una nuova selezione.

« Per cambiare il valore della nota sceglierne uno nuovo dal keypad, prima di creare la nota.

« Per inserire una pausa, premere 0 sul tastierino, in modo da creare una pausa del valore selezionato
sul keypad.

Le uniche differenze con I'inserimento alfabetico sono:

« Non ¢ necessario inserire alterazioni, dato che Sibelius puo riconoscere se state suonando un tasto
nero. In base alla tonalita e al contesto musicale Sibelius ¢ in grado di determinare il nome piu
"adeguato” per le note sui tasti neri — per esempio, F§ invece di Gb. Potete comunque chiedere a
Sibelius di "rinominare” una nota dopo averla creata selezionando Inserimento note » Inserimento
note » Rinomina oppure semplicemente con la scorciatoia Invio (sulla tastiera principale).

« Nello stesso modo Sibelius sapra sempre quale ottava vorrete.

» E possibile inserire accordi all'istante semplicemente suonandoli (non sar necessario inserire
una nota alla volta, come nell'inserimento alfabetico).

Queste differenze rendono I'inserimento step-time ulteriormente pili rapido rispetto allinserimento

alfabetico. Provate ad inserire il resto della musica mancante sul rigo di chitarra acustica usando

linserimento step-time, partendo dalla battuta 69:

« Per iniziare, selezionate la pausa di misura della battuta 69 sul rigo di chitarra acustica (diventa
blu scuro).

« Successivamente scegliete note da un ottavo (crome) sul keypad.

« Adesso potete cominciare a suonare le note, cambiando la loro durata sul keypad durante lesecuzione.

Nel caso di errore o che vogliate cambiare qualcosa, potrete sempre tornare indietro usando i tasti cursore.
Come con I'inserimento alfabetico, per correggere una nota o un accordo occorre solo selezionarli
e suonarli di nuovo sulla tastiera MIDI. E in ogni caso c¢€ sempre Annulla!

Usare la tastiera MIDI (o chitarra MIDI) rende molto pili rapida la creazione di accordi rispetto a fare
clic sulle note con il mouse (e leggermente piti veloce che digitarle con la tastiera del computer.)
Per maggiori dettagli, consultare [0 3.1 Introduzioni allinserimento delle note nel Manuale
Operativo.

Da non dimenticare che & possibile usare Alt-clic 0 ~:-clic per copiare la musica, e R per ripetere note o
battute.
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Specificare l'altezza prima della durata
Se siete passati a Sibelius da un altro programma di notazione musicale potreste esservi resi conto
che in Sibelius il metodo di inserimento note di default funziona proprio come Simple Entry.

Se avete familiarita con un altro metodo di inserimento note nel quale specificate la durata della nota
o dell'accordo dopo la nota, invece che prima, potete usare anche questo in Sibelius. Selezionate
File » Preferenze e passate alla pagina Inserimento note. Selezionate Altezza prima della durata
dal menu Inserimento note predefinito in cima al riquadro e premete OK.

Da qui in poi il Tastierino presenta una disposizione dei pulsanti diversa, corrispondente alle scorciatoie
per le note utilizzate in un altro programma di notazione musicale, quindi se volete inserire un quarto
(croma), dovete premere 5, invece che 4. Ora, quando selezionate il punto dove volete iniziare a
inserire le note e premete N, potete riprodurre note o accordi e la nota fantasma vi mostrera cos'¢
attualmente in riproduzione. Sibelius comunque inserisce le note o gli accordi solo dopo che avete
scritto una durata dal Tastierino mentre tenete una nota o un accordo sulla vostra tastiera MIDI.

Potete usare le opzioni della pagina Inserimento note del riquadro Preferenze in qualsiasi
combinazione, in modo che possiate sperimentare con le impostazioni per trovare il metodo di
inserimento delle note che vi € pill congeniale.

Questi tutorial partono dal presupposto che voi usiate il metodo di inserimento note predefinito,
per cui se doveste decidere di usare Altezza prima della durata per completarli dovete ricordarvi
che le scorciatoie da tastiera utilizzate saranno diverse da quelle descritte.

Per ulteriori informazioni sulllnserimento note di Sibelius, consultare [ 3.12 Opzioni
d'inserimento note nel Manuale Operativo.

Trasposizione delle partiture
Per default la vostra partitura verra visualizzata alla sua altezza reale (da concerto). Per passare
all'altezza trasposta e mostrare il rigo del clarinetto all'altezza corretta di lettura per l'esecutore,
selezionate Home » Strumenti» Partitura trasposta (scorciatoia Ctrl+Maiusc+T or & T), provatelo
adesso. Da notare come tutta la musica e le indicazioni di tonalita sul rigo di clarinetto vengono subito
cambiate allaltezza trasposta di clarinetto. Sibelius gestisce automaticamente ogni altra problematica
legata agli strumenti trasposti.

Durante la riproduzione di una partitura Sibelius leggera gli strumenti trasposti in modo da produrre

le altezze corrette. Quando si copia la musica tra strumenti trasposti, Sibelius traspone la musica in

modo che suoni sempre allo stesso modo. (Nel caso di visualizzazione di parti strumentali ad altezza

reale Sibelius trasporra automaticamente gli strumenti trasposti per voi — vedere in seguito.)

Vedrete dubito se la partitura ¢ ad altezza reale o trasposta guardando la barra di stato sul fondo della

finestra, che riportera "Altezza concerto” o "Partitura trasposta” a seconda dei casi.

Il metodo di inserimento note di Sibelius vi permette di inserire le note in una partitura con

Home» Strumenti» Partitura trasposta attivata. Se l'immissione delle note avviene usando i tasti A-G,

le altezze scritte corrispondenti appariranno sul rigo:

« Selezionate Home» Strumenti» Partitura trasposta per passare a una partitura trasposta, se
non l'avete ancora fatto.

« Selezionare le prime due battute del rigo di clarinetto e premere Canc per cancellare le note.

« Premere N per far apparire il cursore e scegliere un valore di nota sul keypad.
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- Digitare A B C D, in modo da inserire le note A, B, C e D sul rigo.

+ Selezionate Home » Strumenti » Partitura trasposta o fate clic sul pulsante della barra degli strumenti
per passare alle altezze reali — notare come le note vengono trasposte automaticamente e diventano
G,A,BbeC.

Tuttavia, quando vengono inserite la note in step-time usando un dispositivo di ingresso MIDI, le
note appariranno sul rigo ad altezza reale:

« Selezionate Home » Strumenti» Partitura trasposta per passare a una partitura trasposta.

« Selezionare le prime due battute del rigo di clarinetto e premere Canc per cancellare le note.

« Premere N per far apparire il cursore e scegliere un valore di nota sul keypad.

« Suonate le note A, B, C e D sul vostro dispositivo MIDI.

Notate come le note B, C¢, D e E appaiano sul rigo. Per ulteriori dettagli, consultare (1 2.4 Strumenti
nel Manuale Operativo.

Annullate i cambiamenti effettuati e ripristinate il contrappunto di clarinetto facendo clic su Annulla o
selezionando Modifica » Annulla su Mac.

Lavorare con le parti
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Oltre a trasporre automaticamente gli strumenti allinterno di una partitura, Sibelius crea un set di parti
strumentali — una per ciascun strumento presente nella partitura. Le parti contengono solo la notazione
specifica per lo strumento e Sibelius gestisce la loro formattazione, trasposizione e configurazione.

Sibelius utilizza un approccio rivoluzionario, per cui ogni modifica eseguita nella partitura ¢ applicata
automaticamente alla parte, e viceversa. Queste creature magiche sono meglio conosciute come
parti dinamiche™.

E possibile modificare le parti dinamiche nello stesso modo in cui si modifica una partitura. E possibile
spostare, inserire e cancellare note, aggiungere legature di portamento, segni despressione, ecc.,
seguendo le procedure standard. Ma ogni volta che si cambia qualcosa nella partitura le parti vengono
aggiornate automaticamente, e viceversa. Non € necessario estrarre le parti dinamiche, visto che vengono
conservate nello stesso file della partitura completa - quindi € anche piti facile organizzarle.

Potete vedere velocemente qualsiasi parte - e altre visualizzazioni del documento, come le versioni
salvate - utilizzando le schede dei documenti, sotto il nastro. Queste vi permettono di aprire diverse
parti della stessa partitura dentro una singola finestra.

Non sara necessaria alcuna operazione specifica, dato che le parti vengono create automaticamente
quando viene creata una partitura. Diamo unocchiata alle parti per gli strumenti presenti nella
partitura Scarborough Fair:

+ Fate clic sul pulsante Open new tab sul lato desto della barra delle schede dei documenti oppure
fate clic con il tasto destro (Ctrl-clic su Mac) ovunque sulla barra delle schede dei documenti per
mostrare le parti disponibili.

+ Scegliere Clarinetto in Bb dall'elenco - la visualizzazione cambiera per mostrare uno strumento
singolo, distribuito su carta color crema in modo da differenziare la partitura dalla parte.
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Questa parte & pronta per essere passata al musicista; ha lo stesso titolo e le stesse note della partitura
(scritte secondo la trasposizione corretta) — infatti contiene tutto quello di cui un musicista ha bisogno
per eseguire la propria parte, e niente di pit!

Provate a selezionare una battuta e a trasporla un'ottava sopra premendo Ctrl+1 o0 #1, —
quindi tornate alla scheda del documento con l'intera partitura oppure fate clic sul pulsante LI
Cambia schede sulla destra e selezionate Partitura completa dal menu (scorciatoia W).

Sibelius ha trasposto di unottava lo stesso passaggio anche nella partitura completa. Premete
CtriV+ 0 &V, per riportare il passaggio alla sua ottava originale.

Negli altri progetti di questa Guida apprenderemo altri modi per lavorare con le parti dinamiche -
per ulteriori dettagli, consultare L3 9.1 Lavorare con le parti nel Manuale Operativo.
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1

.6 Riproduzione

Se volete iniziare da questa sezione del progetto, dovete aprire la partitura d'esempio chiamata
Progetto 1 e rendere Riproduzione 6 la versione corrente, selezionando Revisione » Versioni»
Modifica Versioni, selezionando questa versione dell'elenco e facendo clic su Rendi corrente.

Una delle pit1 potenti funzioni di Sibelius — che ancora non abbiamo visto — & la sua abilita di riprodurre
la vostra partitura.

Controlli di riproduzione

Fate clic sul pulsante Riproduci nel pannello Trasporta, o premete Spazio per far partire la musica,
che dovrebbe iniziare a suonare (in caso contrario vedere in seguito). Potete anche trovare questa
funzione selezionando Riproduzione » Trasporta » Riproduci.

Sibelius nasconde automaticamente il Tastierino ed effettua lo zoom per mostrarvi una pagina di
musica completa. Vedrete una linea verticale color verde (chiamata linea di riproduzione) scorrere
attraverso la musica a indicare la posizione mentre suona, e la partitura che si muove seguendo la musica.

Perché non ascoltare tutto l'arrangiamento di Scarborough Fair? Quando volete interrompere la
riproduzione fate clic sul pulsante Stop nel pannello Trasporta, o premete di nuovo Spazio.

Potete eseguire rewind e fast-forward sulla partitura usando i pulsanti dedicati presenti nella finestra
Playback o attraverso i comandi rapidi da tastiera [ (rewind) e ] (fast-forward).riavvolgimento rapido

Cliccando il pulsante Riproduzione o premendo Spazio diremo a Sibelius di riprodurre di nuovo
dal punto in cui abbiamo precedentemente interrotto, mentre per far suonare un brano dall'inizio
dovremo tornare all’inizio della partitura — per un rewind o fast-forward rapidi all'inizio o alla fine
della partitura usate Ctrl+[/] o #[/].

Per riprodurre da un particolare punto potrete anche usare il mouse, facendo clic su una nota per
selezionarla e premendo P. Un modo ancora piti rapido per riprodurre dall'inizio della partitura &
premere Esc, in modo da deselezionare tutto, e quindi premere P per iniziare la riproduzione.

Se incontrate problemi con la riproduzione, vedere Non riesco a sentire nulla! Non posso
sentire niente! in seguito.

Il pannello Mixer
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Durante la riproduzione di Scarborough Fair potreste aver notato come gli strumenti suonassero da
diverse posizioni nel campo stereo - si tratta della funzione SoundStage™ di Sibelius al lavoro, in grado
di posizionare gli strumenti in uno spazio tridimensionale come se si trovassero su un palco da concerto.

Potrete regolare la posizione e il volume (oltre ad applicare riverbero e altri effetti) di ogni strumento
attraverso il pannello Mixer di Sibelius. Per mostrare il mixer, selezionate Riproduzione » Impostazioni»
Mixer, oppure premete la scorciatoia M.

Il Mixer ¢ diviso in strisce contraddistinte da colori diversi. Nella figura qui sopra dovreste poter vedere
come ogni rigo della partitura disponga della propria striscia rigo di color blu chiaro. Individuate la
striscia rigo relativa alla chitarra acustica e cliccando muovete verso destra il fader volume, in modo
che la chitarra abbia piti volume durante la riproduzione. Muovete il fader del volume fino a 118.
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Mixer 00

Ora cambiate la posizione stereo delle percussioni, per fare cio dovrete poter vedere tutti i comandi
del mixer, quindi ridimensionatelo all'altezza massima (come nell'immagine sotto) facendo clic sul
pulsante ridimensiona (i):

Mixer @ °

| B [0 (53} Y

Vedrete cosi molti altri comandi, tra cui gli slider Riverbero e Chorus. Cercate la striscia rigo Drum Set
e trovate la manopola in mezzo. Premete Spazio e durante la riproduzione della partitura fate clic e
trascinate questo slider allestrema sinistra. Si nota come la batteria sembra essersi "spostata” a sinistra?

Diamo unocchiata a come usare il Mixer per aggiungere agli strumenti di una partitura effetti come
riverbero e chorus:

« Trovate la striscia rigo della chitarra.
« Fate clic sullo slider Riverbero.

« Ruotate la manopola trascinando con il mouse e regolate la quantita di effetto applicata alla chitarra —
ascoltate come cambia il suono. La partitura di Scarborough Fair impiega il potente Sibelius Player
interno e la libreria di suoni Sibelius 7 Sounds per ricreare suoni estremamente realistici. Mentre
aggiungete piti riverbero al suono di chitarra non iniziate ad avere I'impressione che il chitarrista
stia suonando in una grande sala da concerto?
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Qualsiasi cambio di volume, effetti, posizione stereo (pan), ecc. effettuato sul Mixer viene salvato
al momento in cui salvate la partitura (o salvate una versione della partitura), in modo che la volta
successiva che la aprirete ritroverete tutto esattamente come lo avevate lasciato.

Per maggiori informazioni sulla riproduzione e il Mixer di Sibelius, consultare £J 6. Scheda
Riproduci nel Manuale Operativo.

Non riesco a sentire nulla!
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Se si preme Riproduci e non si sente alcun suono, provare con i seguenti suggerimenti prima di
darsi per vinti.

Anzitutto, controllare che gli altoparlanti del computer, la tastiera MIDI o qualsiasi altro dispositivo
di riproduzione siano alimentati, accesi e con il volume alzato. Successivamente controllate che
il vostro sistema operativo sia configurato per riprodurre I'audio generato da Sibelius. Cercare il
proprio sistema operativo nellelenco sottostante e seguire le istruzioni.

Windows:

« Aprite il menu Start e scegliete Pannello di Controllo, quindi Hardware e Suono.
« Selezionate il collegamento Regola volume sistema subito sotto il titolo Suono.

« Assicuratevi che il volume di Sibelius (sotto Applicazioni) e il volume principale Dispositivo
non siano in mute o con volume a zero.

Mac OS X:

+ Aprire il menu Apple e scegliere Preferenze di Sistema.
« Selezionare Suono e fare clic sulla pagina Output.

« Assicuratevi che il volume Output non sia a zero e che Mute non sia selezionato.

Se ancora non potete sentire niente durante la riproduzione assicuratevi che Sibelius sia configurato
correttamente:

« Fate clic sul pulsante in Riproduzione » Impostazioni, mostrato sulla destra, che apre il
riquadro Dispositivi di riproduzione.

« Selezionare Sibelius Sounds dal menu a tendina Configurazione.

« Selezionare Sibelius Player nella colonna a destra, quindi fare clic sul pulsante Test.

« Seancora non potete sentire alcun suono fate clic su Opzioni Motore Audio in basso nel riquadro

« Controllate che la vostra interfaccia sia selezionata (in Windows, scegliere ASIO se disponibile;
altrimenti scegliere Primary Sound Driver) e fare clic su Chiudi.

« Selezionare Sibelius Player nella colonna a destra, quindi fare di nuovo clic sul pulsante Test.

Se ancora non siete in grado di sentire Sibelius riprodurre la vostra partitura vi preghiamo di contattare
lassistenza tecnica.

Vedere (1 6.2 Dispositivi Playback nel Manuale Operativo per ulteriori informazioni.
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1.7 Testo e dinamiche

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 1 e che
la versione 7 Testo e dinamiche sia la Versione corrente, selezionando revisione » Versioni»
Modifica versioni, selezionando questa versione dalla lista e facendo clic su rendi corrente.

Oltre alle note, molte delle istruzioni per i musicisti che eseguono la partitura appaiono sotto forma
di testo. Gran parte del testo in una partitura di Sibelius ¢ interamente automatico, cosi che non
dovrete preoccuparvi di aggiungerlo voi stessi; per esempio i numeri di pagina, numeri di battuta e
nomi degli strumenti. E opportuno perd aggiungere personalmente altro tipo di testo, come dinamiche
e parole, segni di metronomo e indicazioni di tempo. Gran parte delle istruzioni di testo vengono
riprodotte, in modo che quando create segni dinamici o di tempo Sibelius li elabora e riproduce
correttamente.

Due parole sul testo

Ogni tipo di testo che potete creare in Sibelius dispone del proprio stile di testo, che ne specifica il font,

la dimensione, la posizione ed altre caratteristiche. Gli stili di testo usano nomi facilmente riconoscibili,

come Titolo, Parole e Tempo. Sebbene sia possibile cambiare il font o la dimensione modificando porzioni

di testo individualmente, & consigliabile farlo agendo sullo stile di testo, visto che cio modifichera

immediatamente tutto il testo simile lungo l'intera partitura - £J 5.6 Modifica stili di testo nel

Manuale Operativo.

Esistono alcune cose da ricordare durante la modifica del testo:

+ Sesi desidera cambiare le caratteristiche di una piccola porzione di testo ¢ meglio usare le opzioni nel
pannello Testo »Formato nel nastro.

« Per cambiare tutto il testo della partitura in un particolare stile di testo, bisogna modificare invece
lo stile di testo stesso (I3 5.6 Modifica stili di testo nel Manuale Operativo), perché questa
operazione cambia automaticamente tutto il testo e anche il nuovo testo che si crea in seguito con
quello stile. Per cambiare il tipo di carattere dei versi, ad esempio, modificare lo stile di testo
piuttosto che cambiare manualmente tutte le parole.

Aggiungere parole
Il rigo vocale della partitura di Scarborough Fair non contiene parole, che ovviamente non ¢ di grande
aiuto per un cantante desideroso di eseguire il nostro arrangiamento!
Si aggiungano le parole:
« Fare clic sulla battuta 5 del rigo vocale per selezionarla.
« Fate clic sulla parte superiore del pulsante Testo » Versi» Versi (comando rapido Ctrl+L o 3L).
« Un cursore lampeggiante appare sotto la prima nota.
« A questo punto inserire la prima linea di parole.

Per aggiungere un'interruzione tra sillabe premete — (trattino) e Sibelius muovera automaticamente il
cursore di testo alla nota successiva. Se la sillaba ha una durata maggiore di una singola nota, premere il
trattino ripetutamente (una volta per ogni nota) fino a quando il cursore appare sotto la nota dove volete
inserire la sillaba successiva. Per aggiungere un'interruzione tra parole, premere Spazio. Se l'ultima
sillaba della parola inserita ha una durata maggiore di una singola, premere ripetutamente Spazio fino
a quando il cursore appare sotto la nota dove volete che inizi la parola successiva. Sibelius indichera che la
parola continua melismaticamente visualizzando una linea fino al punto in cui la sillaba termina.
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A questo punto dovreste poter vedere:
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Are you go - ing to Scar - bo-rough Fair?

Importare le parole da un file di testo

Inserire manualmente le parole puo rivelarsi un compito particolarmente laborioso - specialmente se
dovete anche occuparvi della loro sillabazione. Sibelius permette di importare un file di testo contenente
le parole della vostra canzone e sillabarlo automaticamente per voi. Un file di testo contenente le parole
di Scarborough Fair ¢ incluso nella cartella File Progetto delle partiture di esempio.

Proviamo ad importare le parole:
« Fate triplo clic sul rigo vocale per creare una selezione di passaggio intorno all'intero rigo.
« Selezionate Testo» Versi» Da file di testo.

+ Cliccare Sfoglia per accedere alla finestra di dialogo standard Apri. In Windows dovreste trovarvi
in una cartella chiamata Partiture, che conterra un collegamento alla cartella chiamata Partiture
Esempio di Sibelius. Fate doppio clic su di essa e spostatevi all'interno della cartella File Progetto,
selezionate il file di testo Testi Progetto 1 e cliccate su Apri.

Cliccate su OK per importare le parole (sostituiranno automaticamente la prima linea di parole
che avete appena inserito).

Potete anche copiare le parole da altri programmi (programmi di testo, per esempio), creare piti strofe di
parole e controllare ogni aspetto del loro aspetto e formattazione — (3 5.7 Versi nel Manuale Operativo.

Dinamiche
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I termine dinamiche indica sia le istruzioni testuali come mp e forcine (linee cresc./dim. a forma di
cuneo), che Sibelius terra in considerazione durante la riproduzione della vostra partitura — esattamente
come farebbe un musicista. Il testo delle dinamiche usa uno stile di testo chiamato Expression.

Gli stili di testo disponibili sono elencati per categorie nella categoria Testo» Stili» galleria Stili. Questa

galleria ¢ integrata direttamente nel nastro, permettendovi di vedere i primi elementi della galleria

senza aprirla. Le gallerie del nastro vi permettono di scorrere in verticale la lista usando le frecce di

scorrimento sulla destra o di aprire la galleria, che appare come un menu a tendina.

Si provi a creare una dinamica di testo all'inizio del brano:

« Selezionare la prima nota del rigo di clarinetto.

« Aprite la galleria Testo » Stili» Stile.

« Selezionate Espressione dalla categoria Comuni (scorciatoia Ctrl+E o #E). La prima categoria,
In utilizzo, mostra gli stili testuali che sono utilizzati nella partitura corrente. La prima e la pit1
importante categoria ¢ Comuni, che contiene una selezione predefinita di stili di testo usati
maggiormente.

Un cursore lampeggiante appare sotto la prima nota.

Mantenere premuto Ctrl 0 e premere F — la pressione di Ctrl 03 fa si che Sibelius scriva le lettere
usando i caratteri speciali in grassetto normalmente impiegati per le dinamiche - potreste invece
ricorrere a un clic destro (Windows) o Control-clic (Mac) per vedere apparire un menu di parole
utili. Questo menu, molto appropriatamente, si chiama menu contestuale.

Premere Esc per interrompere la creazione di testo.



1.7 Testo e dinamiche

A questo punto dovreste poter vedere:
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Adesso aggiungete il resto del testo mancante delle dinamiche ai righi di voce, clarinetto e chitarra acustica,

facendo riferimento alla stampa di Scarborough Fair creata all'inizio di questo progetto. Potrete scrivere
tutte le dinamiche di questo arrangiamento sia mantenendo premuto Ctrl o #durante la digitazione,
in modo da dire a Sibelius di usare i caratteri speciali in grassetto, o ricorrendo al menu contestuale.

Testo Tempo

Il testo tempo viene usato all'inizio di una partitura e nelle sezioni dove il tempo della musica cambia
considerevolmente. Sibelius segue il testo tempo durante la riproduzione, cambiando la velocita di
conseguenza. Durante la riproduzione effettuata nel capitolo precedente potreste aver notato come
la musica suonasse un po’ troppo lenta. Se non lo avete notato premete Spazio adesso per ascoltare
di nuovo la partitura!

Si provi a cambiare il tempo inserendo il testo Tempo:
« Premere Ctrl+Home o0 &R per tornare indietro all'inizio della partitura e selezionare la prima
battuta (questo dice a Sibelius dove inserire il segno di tempo).

« Selezionate Tempo dalla categoria Comuni di Testo » Stili» Stile (comando rapido da tastiera
Ctrl+AIt+T 0 ~3T).

« Un cursore lampeggiante appare sopra la battuta — Sibelius sa che questo tipo di testo deve apparire
sopra il rigo, per cui lo inserisce li automaticamente.

» Adesso con un clic destro (Windows) o Control-clic (Mac) visualizzeremo il menu contestuale
per i segni di tempo.

« Dal menu scegliete Allegro e cliccateci sopra. Il menu scompare e la parola Allegro appare
sulla partitura.

« Premere Esc per interrompere la creazione di testo.

A questo punto dovreste poter vedere:
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Adesso tornate all'inizio della partitura e premete Spazio per riprodurre la partitura (assicuratevi
che lo slider tempo nella finestra Playback sia nella sua posizione centrale cosi da ascoltare il tutto alla
velocita corretta).

Potete sperimentare con diversi suggerimenti di tempo disponibili nel menu contestuale eliminando
l'indicazione Allegro e selezionando Tempo dalla categoria Comuni nella galleria, provate a sentire
come suonerebbe la partitura utilizzando Prestissimo o Maestoso.

Potreste essere interessati a sapere che potete utilizzare gli stili di tempo per alterare il feeling ritmico di
una partitura o di determinati passaggi musicali, digitando Swing o Convenzionale.
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Testo Technique

Nei casi in cui si desideri comunicare al musicista di cambiare il suono dello strumento, o di impiegare
una particolare tecnica o dispositivo, si utilizza il testo Technique. Sibelius riconosce anche le vostre
istruzioni e le rispettera durante la riproduzione (in base al dispositivo di playback usato), cosi che
potrete usare mute, pizzicato, tremolo, distorsione e altri effetti all'interno della vostra partitura.

I testo Technique € come il testo Expression ma viene visualizzato sopra il rigo e per impostazione
predefinita non-corsivo. Per creare un'indicazione technique, selezionate Technique dalla categoria
Comuni della galleria Testo » Stili» Stile (comando rapido da tastiera Ctrl+T 0 ¥T).

Per ulteriori informazioni su testo Expression, Tempo, Technique e altri comuni stili di testo,
1 5.2 Stili di testo comuni nel Manuale Operativo.

Modifica di testi esistenti

Per modificare un testo gia presente nella partitura potete fare doppio clic su di esso o selezionarlo e
premere Invio (sulla tastiera principale). Proviamo a cambiare il nome di uno strumento in questo modo:
« selezionare il nome strumento Set di batteria all'inizio della prima accollatura.

« fare doppio clic sul testo per modificarlo.

« cancellare il testo esistente e digitare Batteria.

+ premere una prima volta Esc per interrompere la modifica del testo, una seconda volta per
deselezionarlo.

E possibile eseguire questa operazione su qualsiasi parte di testo nella partitura, modificando con
facilita titoli, parole, dinamiche e altre istruzioni.

Layout magnetico
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Mentre si stavano apportando modifiche, si potrebbe aver notato che il testo e altri oggetti nella partitura
si muovono insieme alle note. O potreste aver notato come alcuni oggetti, quando vengono selezionati,
mostrano una specie di ombra sotto di essi.

Quello che avete osservato sono gli effetti del Layout Magnetico, la rivoluzionaria funzione di Sibelius
dedicata a evitare e individuare possibili collisioni. Nessun altro software di notazione offre la funzione
di organizzare automaticamente la partitura, con magnifici risultati, mentre si crea e modifica la musica!
Il Layout Magnetico regola costantemente la posizione degli oggetti sui righi in modo che non si
sovrappongano o coprano le note.

Analizzeremo in dettaglio come funziona nel Progetto 2, 0 1 7.5 Layout magnetico nel Manuale
Operativo.



2. Progetto 2



Progetto 2
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2.1 Creare una nuova partitura

In questo progetto apprenderete a creare una nuova partitura da zero, a eseguire una scansione di
musica all'interno di Sibelius e a come far si che il vostro spartito si presenti nella forma piti chiara
e gradevole per il beneficio dei musicisti.

Il primo capitolo di questo progetto mostra come creare una partitura per un quartetto d’archi pronta
per inserirvi le note; apprenderete come impostare rapidamente un "foglio manoscritto” contenente
tutto quello di cui avrete bisogno per iniziare a scrivere musica.

Stampa
Prima di iniziare a creare la partitura per quartetto d’archi, occorrera una stampa della partitura finale
della musica su cui si lavorera, come riferimento per completare il resto di questo progetto. Selezionate
File» Apri (comando rapido Ctrl+O 0 #0) e trovate la partitura d'esempio chiamata Progetto 2
nella cartella File progetto all'interno della cartella delle partiture d'esempio. Aprite questa partitura
e fate clic sul pulsante Apri nuova scheda sulla destra della barra delle schede documento e selezionate
1 Creare una nuova partitura dall'elenco a tendina delle versioni sulla barra degli strumenti.

Si dovrebbe ora vedere un arrangiamento completo per quartetto d’archi di un estratto del Quartetto
d’Archi in Mi Minore, Op.83, III di Edward Elgar. Finale: Allegro molto.

Selezionate File » Stampa (comando rapido Ctrl+P o #P) e fate clic sul pulsante Stampa per
stampare la vostra partitura. Nel giro di pochi secondi una stampa dello spartito del Quartetto d'Archi in
Mi Minore dovrebbe uscire dalla vostra stampante. Conservare questa stampa perché sara necessaria
per leggere la musica quando a breve si modifichera I'arrangiamento.

Iniziare un nuovo spartito
Per iniziare una nuova partitura selezionate File » Nuovo (comando rapido Ctrl+N o #N). Apparira
Awvio rapido, aprite la scheda Nuova Partitura per guidarvi attraverso la creazione del vostro spartito
in cinque semplici passi.
Innanzitutto scegliete dallelenco di "fogli manoscritti” predefiniti o create la vostra strumentazione.
Dopodiché vedrete le impostazioni che vi permettono di personalizzare diversi aspetti della partitura,
come segue:

+ Decidete le dimensioni, l'orientamento e laspetto della partitura, se utilizzare, ad esempio, un
aspetto tradizionale o scritto a mano.

« Impostare il tempo in chiave e il tempo iniziali.

« Impostare l'indicazione di tonalita iniziale.

« Infine, assegnare un titolo alla partitura, inserire il nome del compositore, ecc. e creare una pagina

di titolo, se lo desidera.

L'anteprima vi mostra come ogni cambiamento influenzi la partitura. Potete fare clic su Crea dopo
qualsiasi passo, in modo da non dover decidere tutti questi dettagli sin dall'inizio, se non lo desiderate.

Il processo ¢ molto semplice, probabilmente non avrete bisogno di alcun aiuto per orientarvi, ma
poiché si desidera creare un tipo specifico di partitura, questa verra analizzata di seguito.
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Foglio manoscritto
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La scheda Nuova partitura del riquadro Avvio rapido elenca diversi tipi di strumentazione,
organizzati in categorie: Banda, Gruppi da camera, Corale e canzone, ¢ cosi via.

Avvio Rapida
-

Apprendimento

W Recenti Importa Novita

Nessuna Categoria

igo di ligo d

Banda

B

Banda e perc i

Banda 1 Banda 2 Fanfara militare

B [¥] Mostra Awio rapido quando parte Sibelius T = N .
Aprialtro... Zoorm U Esci da Sibelius 7 Chiudi
[¥] Mastra nuovamente Swio rapido dopo aver chiuso I'ultirma partitura i

= — J

Se scrivete per un complesso standard puo essere una buona idea usare uno dei foglimanoscritti
interni di Sibelius, invece che definirne uno proprio, visto che contengono numerose e utili impostazioni di
default, come speciali formati di nome strumento, dimensioni di rigo adeguate, ecc., gia preparate per voi.
(Pit avanti apprenderete come creare i vostri propri fogli manoscritti).

Per iniziare una partitura per quartetto d’archi (il nostro compito) il modo piti rapido & usare il
foglio manoscritto Quartetto d’archi nella categoria Gruppi da camera, anche se per il momento
sceglieremo Vuoto (come si evince dal nome, un foglio manoscritto completamente vuoto) da Nessuna
categoria in modo da imparare a creare strumenti.

Quando fate clic sull'anteprima, vi apparira un'anteprima della partitura ed ulteriori impostazioni
per personalizzarla.



2.1 Creare una nuova partitura

Creazione degli strumenti

Sebbene sia possibile creare nuovi strumenti in qualsiasi momento — non & necessario decidere tutto sin
dall'inizio — dovreste perlomeno scegliere uno strumento iniziale in modo da poter cominciare
a scrivere musica!

Fate clic sul pulsante Cambia strumenti sulla destra per aprire il riquadro Aggiungi o rimuovi
strumenti:

P P — B .
iy
Aggiungi Strurnenta Righi nellz partitura:
Trovar | Aagiungi alls partitura
Scegli da [Strumenti Comuni -] Elirnina dalla partitura
Leani
Ottoni
Percussion ¢ Batterie Sposts
Percussione Intonata =
Chitarre
Cantanti Gt
4 Tostiere Rigo addizionale
Celesta
Piano Sopra
Tastiera
Sott
Clavicermbalo e
Organa [manwali]
Organ (Great)
Organ (Swell)
Ped. [pedsli argana]
Fisarmanica
Brchi
Al
Riga piccala
Visualizza nomi strumenti in inglese Annulla

Dato che Sibelius contiene moltissimi strumenti (oltre 650), lelenco Scegli da in alto a sinistra della
finestra di dialogo mostra utili selezioni dallintero set. Per default Sibelius visualizza gli Strumenti
comuni, circa 90; nel caso non possiate resistere alla tentazione di scrivere per strumenti meno comuni
come Fagotto in quinta, Ondes Martenot o Hurdy-Gurdy, cliccate su Tutti gli strumenti per visualizzare
il set completo. Se state scrivendo specificamente per banda, jazz o complessi orchestrali, scegliete
lopzione appropriata dallelenco cosi da ottenere gli strumenti standard usati in questo tipo di formazioni.
Non preoccupatevi se non riuscite a trovare un particolare strumento poco comune - Sibelius vi permettera
anche di creare i vostri propri strumenti (£ 2.6 Modifica Strumenti nel Manuale Operativo).

Gli strumenti vengono elencati nellordine standard secondo cui appaiono nella partitura, ma anche
questo dettaglio ¢ modificabile, se necessario.

Visto che si lavorera su un estratto del Quartetto d’Archi in Mi Minore di Elgar, si dovranno inserire
due violini, una viola e un violoncello. Espandete il gruppo Archi nell'elenco delle famiglie di strumenti
facendo clic sulla freccia sulla sinistra, quindi selezionate Violino (solo) e fate clic due volte su
Aggiungi a partitura per aggiungere due righi di violino solo nell'elenco pit1 a destra Righi nella
partitura. Aggiungere nello stesso modo Viola (solo) e Violoncello (solo) e cliccare su OK. I nomi
strumento per i violini non sono corretti, ma sara comunque possibile correggerli piti avanti.

Potete rivedere questo riquadro in qualsiasi momento selezionando Home » Strumenti» Aggiungi o
rimuovi, oppure digitando il comando rapido I. Unopzione molto utile perché, non solo consente
di inserire e rimuovere strumenti dalla partitura, ma anche di cambiarne ordine in qualsiasi momento).
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Impostazioni Documento
Ora siete ritornati alla pagina dell'anteprima, che vi permette di selezionare diverse forme e dimensioni
del foglio oppure di impostare I'house style della partitura che state per creare.

Pensate allhouse style come al "look" o I'aspetto della vostra partitura; ogni editore usa house style diversi,
e Sibelius vi permette di modificare l'aspetto della vostra partitura in qualsiasi modo immaginabile,
dai font usati alla dimensione di righi e note, fino ai dettagli piu specifici, come lo spessore delle
doppie stanghette finali!

@ Avio Rapido = e =2

Impostazion] documento

Dimensioni Pagina: [Ad -

© Werticale

Orizzontale

House style (nvariate) =

Carnbia strumenti...

PR

Impostazioni indicazione metrica

Indicazione metrica

==
e
FFE

32,2

»
w

33,33

Altro...

Misurs parziale introduttiva

Indietro Crea
7] Mostra Awia rapido quando pate Sibelius T

Zoom Esci da Sibelius 7
V] Mastra nuovaments Swio rapida dopo aver chiuso |ultima partiturs

Visto che non dobbiamo occuparci di questi dettagli adesso potremo lasciare selezionata lopzione
(Invariato) nellelenco. Se lo si desidera, & possibile dare unocchiata allaspetto degli house style predefiniti
mostrati sullo schermo; cliccandoci sopra nellelenco, si aggiornera la visualizzazione di anteprima
della partitura. I nomi indicano il font musicale (I'aspetto delle note e degli altri simboli) usati
nell’house style, come Opus, e il font testo principale, come Times. (Potreste voler sperimentare con
diversi house style in futuro. Quelli che usano i font musicali Reprise e Inkpen2 sembrano scritti a
mano - particolarmente adatti per il jazz. E il tipo di carattere musicale Helsinki ha un aspetto
inciso tradizionale).

Impostazioni indicazione metrica
La terza pagina della finestra di dialogo vi permette di scegliere il tempo in chiave ed il tempo della
vostra partitura.

Fate clic su 4/4 nell'elenco per scegliere questo tempo in chiave e, visto che vorremo una battuta
d’attacco (upbeat), attivate Inizio con battuta di durata. La battuta d’attacco ha una durata di 1/16
(semicroma), quindi quella sara la scelta dal menu. Ovviamente, & possibile cambiare il tempo in chiave
(come qualsiasi altra cosa) in ogni momento del lavoro sulla partitura, quindi questo sara solo il
tempo in chiave iniziale.
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2.1 Creare una nuova partitura

Dobbiamo inserire un segno di tempo, quindi per cio che riguarda il testo Tempo digitate Allegro molto
e attivate il segno Metronomo per inserire un tempo specifico. Il nostro tempo ¢ 132 note da 1/4
(semiminima) per minuto, quindi scegliete dal menu la nota da 1/4 e digitate 132.

Impostazione tonalita
Potete anche scegliere una tonalita. Dal menu a tendine selezionate Tonalita minori diesis e
selezionate E minore dall'elenco.

Imposta informazioni partitura
La quinta e ultima pagina della finestra di dialogo permette di inserire testo, come il titolo della partitura,
il nome del compositore/paroliere e le informazioni di copyright. Il testo viene automaticamente inserito
nella prima pagina di musica, e se viene attivata [opzione Crea pagina titolo, Sibelius inserira anche
il titolo e il nome del compositore in una ulteriore pagina titolo creata per voi — per il momento lasciate
questopzione disattivata, visto che apprenderemo a creare una pagina titolo pili avanti.

Per il momento usate Quartetto per Archi come Titolo, Edward Elgar, Op.83 come Compositor ¢
quindi cliccate su Crea. (Come si diceva prima, potete fare clic su Crea in un qualsiasi punto precedente,
non dovete decidere tutto ora!)

In meno di un attimo Sibelius ha creato la vostra partitura, gia pronta per 'inserimento delle note:

:
Home  InserimentoNots  Notazioni  Testo  Riproduci  Layout  Aspetto  Pai  Revisione  Vista Trova sul nastr )
E 4 Teglia P l.¢//_ ﬁ Rgoosh | =g =7 2 Dividi Y V/ Avanzato = Battute m e MiTrovs - @ Y
@ copia v ESopra 5 Unisci o Tutto  EEPassaggio Accollatura P raia~
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Un dettaglio di cui occuparsi: fate doppio clic sul nome strumento "Violino" sul primo rigo di violino e
modificatelo in "Violino I", quindi fate lo stesso con il secondo rigo di violino, cambiandolo in “Violino II".
Fatto!

Salvare la partitura
A questo punto non dimenticare di salvare la partitura! Dovremo importarci della musica scansionata
nel prossimo capitolo, quindi selezionate File » Salva (comando rapido Ctrl+S o #S), trovate una
posizione adatta (esempio la vostra cartella Partiture o il desktop), date alla vostra partitura un nome
(come Elgar) e fate clic su Salva. In Windows la cartella Partiture si trova dentro la cartella Documenti;
su un Mag, la cartella Partiture si trova nella cartella Documenti dell'utente.
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2.2 Scansione

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Project 2 e che la
versione 2 Scansione sia la Versione corrente, selezionando Revisione » Versioni » Modifica
Versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Sibelius include PhotoScore Lite, un programma gratuito di scansione in grado di digitalizzare e
leggere musica stampata. Se disponete di spartiti di musica stampata, o file PDE potrete digitalizzare e
leggere la musica direttamente all'interno di Sibelius, per poi modificarla o trasporla, riprodurla,
creare parti e stamparla — esattamente come se I'aveste immessa voi stessi.

Questo capitolo illustrera come trasformare la nuova partitura appena creata in una partitura completa
per il direttore, partendo da un set di parti per quartetto d’archi. (Se non avete uno scanner collegato al
vostro computer potrete comunque completare il capitolo, visto che digitalizzeremo file PDF.)

Scansione con PhotoScore Lite
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Prima di procedere, assicuratevi di aver installato PhotoScore Lite dal DVD-ROM di Sibelius .

Dopo aver installato PhotoScore, da Sibelius selezionate File » Nuovo per aprire Avvio rapido. Ora attivate
la scheda Importa e attivate PhotoScore.

Quando PhotoScore ¢ aperto fare clic sul pulsante Apri PDF della toolbar.
=% Dpen PDF:

Apparira una finestra di dialogo standard Apri. Individuate la cartella File Progetto all'interno della
cartella partiture di esempio, quindi selezionate il file Quartetto d’archi - Violino l.pdf e fate clic su Apri.

Prima di iniziare la scansione e lelaborazione del file PDF, PhotoScore consentira di scegliere la
risoluzione (in dpi) della scansione. Risoluzioni maggiori garantiscono scansioni piu dettagliate,
ma richiedono piti tempo per essere elaborate. Impostate la risoluzione digitando 600 nel campo
di testo e quindi fate clic su OK.

A questo punto PhotoScore Lite elabora il file e "legge" automaticamente le pagine digitalizzate per
riconoscere le note e gli altri segni musicali.



2.2 Scansione

Modificare la musica digitalizzata

Una volta che la musica ¢ stata letta da PhotoScore Lite, la sua interpretazione della prima pagina della
parte di violino apparira nella finestra principale. Qui si possono correggere gli errori eventualmente
commessi da PhotoScore Lite.

€ Neuratron PhotoScor Lite 5 - {Output - gar Quartetfor Sr-at 100% ]
@) Fie eat reate Play Window Help
> OpenPDFs | O €| @

[ page [Ttz

) 11 bR Fulldetailview__[5]

Eiga patpdr
* Bgar Guaret for Srpg2pc

Networks > < = @ ® > 0¥ ¢ 1600

La parte alta della finestra (con lo sfondo colorato opaco) mostra la pagina originale. La finestra Vista
dettagliata nell'angolo in alto a destra visualizza un'area ingrandita della pagina originale (in base a dove
si punta il mouse).

La zona grande in basso nella finestra (con lo sfondo grigio chiaro) mostra l'interpretazione di
PhotoScore Lite della prima scansione - ciog, quello che PhotoScore Lite ritiene sia scritto sulla prima
pagina delloriginale. E in questa zona della finestra quindi che ci possono essere gli errori commessi da
PhotoScore Lite.

PhotoScore Lite ha un tastierino nell'angolo in basso a destra che ha funzioni simili a quello di Sibelius,
dal quale pero sono state omesse le funzioni non disponibili in PhotoScore.

Si correggano alcuni degli errori confrontando la parte inferiore della finestra con la scansione originale
nella parte superiore.

La battuta d’attacco (upbeat) allinizio della parte mostra linee puntate di color rosso sopra e sotto
il rigo, seguite da una serie di note blu sopra la stanghetta, ad indicare il numero di movimenti extra
o mancanti. Questo perché PhotoScore Lite ha interpretato il tempo in chiave come 4/4 e non capisce
perché la battuta ha una durata di solo 1/16 (semicroma).

Selezionate il tempo in chiave nella finestra Output (in modo che diventi azzurra) e selezionate
Crea» Tempo in chiave (comando rapido T) per selezionare un tempo in chiave differente. Cliccate su
Altro e scegliete 1/16 dagli elenchi a tendina. Assicuratevi di attivare Invisibile (per battute d’attacco
e irregolari) in modo che PhotoScore non mostri I'indicazione metrica.
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Si osservi come il resto delle battute del brano diventano di color rosso e mostrano note color blu
sopra le stanghette. Per correggere cio, aggiungete una seconda indicazione metrica all'inizio della
prima battuta completa della parte:

+ Premete di nuovo T per creare un'indicazione metrica e scegliete 4/4, assicurandovi che Invisibile
(per battute d’attacco e irregolari) sia disattivato, quindi fate clic su OK.
« Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.

« Cliccare all'inizio della prima battuta completa per inserire li 'indicazione metrica; le linee puntate
di color rosso scompariranno.

Sebbene errori come laltezza delle note possano essere corretti in Sibelius, € molto piti semplice
correggere errori relativi a tonalita e tempi in chiave in PhotoScore Lite, quindi vi consigliamo di
farlo qui, prima di passare la partitura a Sibelius.

Per ulteriori dettagli su come modificare il risultato ottenuto da PhotoScore, consultare
[J 1.7 PhotoScore Lite nel Manuale Operativo.

Invio a Sibelius
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Una volta corrette, le pagine della partitura possono essere inviate a Sibelius. Scegliere File » Invia a»
Sibelius (comando rapido Ctrl+D o0 #D) o fare clic sulla piccola icona di Sibelius ( (& )accanto al
pulsante Salva partitura in cima alla finestra di uscita.

Il riquadro Apri file PhotoScore o AudioScore apparira in Sibelius — non preoccupatevi per le
opzioni qui presenti e semplicemente fate clic su OK in modo che Sibelius possa aprire il file. La parte di
violino appare in una nuova partitura di Sibelius. A questo punto verra trasferita alla partitura preparata
nel primo capitolo di questo progetto:

« Fare triplo-clic nella prima battuta della parte di violino appena importata da PhotoScore Lite,
in modo da selezionare tutta la musica sul rigo.

« Selezionate Home » Appunti» Copia (comando rapido Ctrl+C o #C) per copiare la musica negli
appunti.

» passate alla partitura che abbiamo preparato precedentemente selezionandola dal menu Visualizza »
finestra » Cambia finestra.

« selezionare la pausa da 1/16 (semicroma) nella battuta d’attacco (upbeat) del rigo Violino I.

« selezionate Home » Appunti» Incolla (comando rapido Ctrl+V o #V) per incollare la musica
dalla partitura importata nella partitura preparata precedentemente.

La vostra partitura si riempira istantaneamente di musica magnificamente scritta, incluse tutte le
alterazioni appropriate, legature di portamento e di valore; notate come Sibelius aggiunga automa-
ticamente alla vostra partitura le battute necessarie per accomodare la musica copiata. Si potrebbe
aver inoltre notato che PhotoScore ha accorciato alcune legature di portamento sopra le note -
non ¢ importante per il momento, sara corretto in seguito.
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Aggiungere la musica restante
Ora usate PhotoScore Lite per scansionare, leggere e inviare a Sibelius le seguenti parti d'archi rimanenti:
Quartetto d'archi- Violino Il.pdf, Quartetto d'archi - Viola.pdf e Quartetto d'archi - Violoncello.pdf.
I file PDF per ciascuna parte si trovano all'interno della stessa cartella usata per la parte appena digitalizzata.

Una volta inviate le parti a Sibelius, dovrete copiarle e incollarle sul rigo appropriato della partitura
che abbiamo creato, esattamente come appena visto per la musica sul rigo Violino L.

Salvare una versione
A questo punto, selezionate Revisione » Versioni» Nuova versione. Sibelius vi chiedera di dare un nome
alla vostra versione e offrira inoltre la possibilita di aggiungere un commento per facilitarne la successiva

identificazione. Date a questa versione un nome facile da ricordare, per esempio Versione 1 - immissione
scansionata, quindi fate clic su OK.

Useremo in seguito questa versione per mostrarvi come effettuare rapidi confronti tra partiture o versioni.
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2.3 Chiavi, indicazioni di tonalita e
gruppi irregolari

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto2 e che la
versione 3 Chiavi, tonalita e gruppi irregolari sia la versione corrente, selezionando Revisione»
Versioni» Modifica versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

La partitura appena assemblata ¢ ora pronta a essere trasformata in un arrangiamento. Abbiamo
gia visto come usare la finestra di dialogo Nuova partitura per impostare una partitura in Sibelius, ma
¢ possibile aggiungere lo stesso tipo di informazione dopo aver inserito la musica nello partitura e
cosi cambiarla retroattivamente. Questo capitolo vi mostrera come aggiungere cambi di chiave,
tonalita e gruppi irregolari (terzine, in questo caso) a una partitura esistente.

Cambi di chiave
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Quando usiamo Sibelius per creare una partitura, le chiavi vengono automaticamente inserite all'inizio
di ogni accollatura, evitandovi il lavoro. In alcuni casi perd puo essere necessario inserire un cambio
di chiave su un rigo. Nel caso in cui la musica si estenda molto al di sopra o al di sotto della normale
chiave, questo sistema potra rendere la lettura molto pit semplice per lesecutore. In alcuni casi i cambi
di chiave riguardano solo un breve passaggio, di una battuta o meno; in altri potrebbe essere necessario
un cambio di chiave che si applichi permanentemente da un punto specifico in avanti.

Nella misura 15 la parte di violoncello contiene improvvisamente due note molto alte, due ottavi (crome)
di Ab e G nella seconda meta della battuta. Si provi a inserire un cambio di chiave prima delle note
in modo da rendere la lettura pitt semplice per il violoncellista:

« Selezionare la nota da 1/8 (croma) Ab

« Maiusc-clic sulla nota da 1/8 (croma) G successiva per effettuare una selezione di passaggio.

« Aprite la galleria Notazioni» Comuni» Chiave (comando rapido Q. per "chiave").

« Fate clic sulla chiave di tenore nella prima fila dell'elenco.

« Sibelius inserira una piccola chiave di tenore e ripristinera automaticamente la chiave al termine
del passaggio che avete selezionato. Da notare la maggiore spaziatura delle note per lasciare spazio
alle chiavi.

Ora si aggiunga un altro cambio di chiave di tenore per il violoncellista, alla battuta 26; questa volta
con il mouse:

« Premere Esc per assicurarsi di non aver niente selezionato.

« Aprite la galleria Chiave.

« Selezionate la chiave di tenore.

« Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.

« Fare clic nello spazio vuoto all'inizio della battuta 26 nel rigo Violoncello.

« Come visto in precedenza, Sibelius inserisce una piccola chiave di tenore — questa volta pero ¢
stata inserita alla fine della battuta 25 del sistema precedente. Si osservi come la chiave normale
all'inizio di ogni accollatura & cambiata in una chiave di tenore.
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Fate diventare il rigo nuovamente in chiave di basso dopo il primo quarto (semiminima) nella battuta
28 allo stesso modo. Ora aggiungete i rimanenti cambi di chiave ai righi di Viola e Violoncello nelle
battute 43-44, facendo riferimento alla stampata dell'arrangiamento completo che abbiamo fatto.

Per maggiori informazioni, consultare (1 4.1 Chiavi nel Manuale Operativo.

Indicazioni di tonalita
Forse avete gia notato che alla fine di questo estratto la musica cambia tonalita, modulando in A maggiore;
fate caso al maggior numero di diesis sulle note. Ora si inserisca un cambio di tonalita alla battuta 53,
per evidenziare il passaggio alla nuova tonalita.

« Premere Esc per assicurarsi di non aver niente selezionato.

« Aprite la galleria Notazioni» Comuni» Tonalita (comando rapido K).

+ Selezionate A maggiore dall'elenco.

« Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.
« Fare clic all'inizio della battuta 53.

« Sibelius crea una doppia stanghetta finale e una tonalita con tre diesis. Grazie alla nuova tonalita i diesis
presenti nelle battute successive non sono pitt necessari e quindi vengono rimossi automaticamente.

I cambi di chiave e tonalitd possono essere selezionati, copiati, cancellati e spostati. Se trascinate
un cambio di chiave o tonalita vedrete come Sibelius riorganizza automaticamente la musica verso
l'alto o il basso, rimuovendo o aggiungendo alterazioni di conseguenza, in modo che le note continuino
suonando uguale.

Per maggiori informazioni, consultare (1 4.2 Indicazioni di tonalita nel Manuale Operativo.

Terzine e altri gruppi irregolari
I "tuplet", o gruppi irregolari, sono ritmi suonati a una certa frazione della loro velocita normale - i pit
comuni sono le terzine. Si creeranno ora alcune terzine nella battuta 30 del rigo Violino II, che non
erano presenti nella parte scansionata:

« Selezionare la battuta di pausa e premere 3 (sul keypad) per scegliere una nota da 1/8 (croma).

« Premere 8 G Maiusc-6 (usare 6 sulla tastiera principale, non sul keypad). Cosi facendo inseriremo
prima una G# da 1/8 e poi una nota una sesta sotto, creando cosi un accordo di due note. (Sarebbe
stato anche possibile inserire un B sotto il rigo, premere 8 (sul keypad) G per scegliere il diesis e
aggiungere il G sopra il B.)

« Fate clic sulla parte superiore del pulsante Inserimento note » Inserimento note» Gruppi irregolari
(comando rapido Ctrl+3 0 #3); appariranno una parentesi di una terzina e un numero.

—3—

)™ L2 J

- VA
K 4

+ Inserite due ulteriori note per completare la terzina (un E alto, nello spazio in cima al rigo, e un altro G#).
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Notate come la parentesi scompaia automaticamente, secondo la notazione convenzionale in casi
come questo:

3
!

D

L.

K4

Come potete immaginare, i gruppi irregolari in Sibelius sono intelligenti: le parentesi sono automaticamente
nascoste se le note del gruppo irregolare vengono unite da un tratto d'unione, e le parentesi del gruppo
(quando sono visibili) sono "magnetiche”, rimanendo attaccate sulle note anche quando cambiano altezza.

Terminare inserendo il resto delle note all'interno di questa battuta. Per creare altri tipi di gruppi irregolari
potete sia fare clic sulla parte inferiore del pulsante Inserimento note » Inserimento note » Terzine
e selezionare dall'elenco oppure premere Ctrl 0 & con qualsiasi numero, es. 5 per una quintina o 6 per
una sestina.

Per gruppi irregolari pitt complessi come 73:51 dovete fare clic sulla parte inferiore del pulsante
Inserimento note» Inserimento note» Terzine ¢ selezionare Inserimento note» Inserimento
note» Terzine» Altro per aprire il riquadro Gruppi irregolari. Per maggiori informazioni,
consultare (1 3.10 Terzine e altri gruppi irregolari nel Manuale Operativo.
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2.4 Contrassegnare una partitura

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 2 e che
la versione 4 Contrassegnare una partitura sia la Versione corrente, selezionando Revisione »
Versioni» Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Fino a questo, si ¢ lavorato su un estratto di Elgar, Quartetto d’Archi in E minore, Op.83, I1I. Finale:
Allegro molto creando una partitura vuota, scansionando le singole parti dai file PDF e copiandole
nella partitura. Adesso invece si aggiungera un po’ di colore e vita allo spartito, contrassegnando la
musica con dinamiche, testo Technique, segni di tempo, legature di portamento e articolazioni.

In questo capitolo vi mostreremo come inserire i vari tipi di segni e analizzeremo come questi
interagiscono con il rivoluzionario sistema per evitare collisioni di Sibelius, chiamato Layout Magnetico.

Testo Expression
Nel primo di questi progetti tutorial si & appreso ad aggiungere segni di dinamiche, technique e tempo.
Ora si aggiungeranno i segni mancanti di testo di dinamiche, usando come riferimento la stampa
della partitura creata in precedenza. Come visto in precedenza, ricordate i seguenti passi:

« Selezionate Espressione (comando rapido Ctrl+E o #E) dalla categoria Comuni della galleria
Testo» Stile» Stile per aggiungere testo di dinamiche.

+ Durante la digitazione mantenere premuto Ctrl 0 & in modo da creare testi di dinamiche in grassetto,
come f; p, sf’0 rfz — mantenendo premuto Ctrl 0 3 faremo si che Sibelius scriva le lettere usando
gli speciali caratteri in grassetto normalmente usati per le dinamiche.

« Fare clic con il pulsante destro (Windows) o Control-clic (Mac) per veder apparire un menu
contestuale con utili termini di dinamica (qui troverete espress., dolce, poco, cresc. e dim.).

- Digitate direttamente in Sibelius qualsiasi termine che non appare nel menu scritte (per esempio,
risoluto, rubato, brillante e appassionato) per far si che appaia come normale testo corsivo.

Vi accorgerete che copiare il testo delle dinamiche da un rigo a un altro rende il processo di
contrassegnare una partitura molto piti rapido — potete usare qualsiasi metodo di copia analizzato
nel primo progetto. Il modo piti rapido ¢ selezionare il testo da copiare, quindi Alt+clic 0 ~:-clic nel
punto in cui volete appaia. Se desiderate copiare loggetto testo alla sua posizione di default (dove
appare quando viene creato con una nota selezionata) invece che nel punto dove si trova il puntatore
del mouse, usate Maiusc+Alt-clic 0 &~c-clic.
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Copia multipla di un oggetto

Nel caso tutti i righi del vostro spartito presentino gli stessi segni di dinamica (per esempio, ff alla misura 43,

o sf alla misura 53) potrete risparmiare tempo effettuando una copia multipla delle dinamiche attraverso

tutti i righi:

« Create il segno di dinamica sul rigo Violino I usando il testo Expression (come visto sopra).

« Selezionare un singolo oggetto e scegliecre Home» Cartella Appunti» Copia (comando rapido
Ctrl+C o0 #C) per copiarlo negli Appunti.

« Premere Esc per annullare la selezione.

« Eseguire una selezione di passaggio intorno alla stessa misura nei tre righi rimanenti.

« Selezionate Home» Clipboard » Incolla (comando rapido Ctrl+V o V) per copiare lelemento
all'inizio del passaggio, una copia su ogni rigo.

E possibile usare la copia multipla anche con vari oggetti e incollarli verticalmente lungo qualsiasi

numero di righi - cosi facendo si risparmia molto tempo mentre si contrassegnano le partiture.

Testo Technique

Ora che sono stati inseriti tutti i testi di dinamiche mancanti, si provi ad aggiungere le istruzioni tecniche

che appaiono sulla stampa:

+ Selezionate Technique (comando rapido Ctrl+T o #T) dalla categoria Comuni nella galleria
Testo» Stili» Stile per aggiungere istruzioni technique.

« Con un clic destro (Windows) o Control-clic (Mac) appare un menu contestuale con una serie di
utili termini tecnici (qui troverete senza sord.).

- Digitate direttamente in Sibelius qualsiasi termine che non appare nel menu contestuale (e.g. colla
parte e ten.) per far si che appaia come normale testo corsivo.

Testo Tempo
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Dopo aver inserito tutti i termini di tecnica mancanti potremo passare ad aggiungere i segni di tempo.

Prima di farlo, pero, ¢ importante soffermarsi sulla differenza esistente tra testo di rigo e testo di

accollatura.

Gli stili di testo Expression e Technique sono entrambi esempi di testo di rigo. Cio significa che vengono

applicati solo ad un singolo rigo, e che devono essere duplicati su un altro rigo se si desidera che lo stesso

effetto venga applicato a qualsiasi altro strumento della partitura.

I testo di sistema viene invece applicato a tutti i righi della partitura. I segni di tempo sono esempi

di questo tipo di testo: se si aggiunge un testo Tempo alla partitura, questo apparira una volta sopra

laccollatura (nelle partiture contenenti molti strumenti potrebbe apparire anche piu avanti nella

partitura), ma appare anche in ogni parte strumentale.

Siinseriscano ora i segni di tempo mancanti. Iniziamo con il segno A tempo alla misura 7:

« Selezionare la settima misura del rigo Violino I.

« Selezionate Tempo (comando rapido Ctrl+Alt+T o~#T dalla categoria Comuni nella galleria
Testo » Stili» Stile per aggiungere segni di tempo.

« Con un clic destro (Windows) o Control-clic (Mac) appare un menu contestuale con una serie di
utili termini di tempo.

« Fare clic su A tempo per aggiungerlo alla partitura.

« Premere Esc due volte per interrompere loperazione e deselezionare il testo.

Inserite allo stesso modo i segni A tempo alle misure 20, 56 e 60.
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Forcine e altri tipi di linee

Sulla stampa appaiono ulteriori segni di dinamica e istruzioni di tempo che non sono ancora stati
aggiunti alla partitura. Ci sono diversi tipi di linee: forcine (segni di crescendo e diminuendo),
legature e ritardando.

Per aggiungere linee, selezionate semplicemente la nota o qualsiasi altro oggetto della vostra partitura in
modo che Sibelius sappia dove volete far iniziare la linea, quindi premete L per aprire la galleria
Notazioni» Linee » Linea.

Nellestratto su cui stiamo lavorando dovremo creare forcine e legature di portamento, che dispongono
dei propri comandi rapidi :H per una forcina di crescendo, Maiusc-H per una forcina di diminuendo e
S per una legatura di portamento.

Si inizi inserendo la forcina di crescendo al rigo Violino I, nella seconda misura completa dellestratto:
» Selezionate la seconda nota del rigo Violino I nella seconda misura dopo la misura d’attacco.
« Premere H per aggiungere una forcina di crescendo sotto la nota.

+ Premete Spazio quattro volte per estendere la forcina una nota alla volta finché non arrivate al
centro della misura, una E della durata di un sedicesimo (semicroma). Se andate troppo oltre,
digitate Maiusc-Space per arretrare nuovamente.

« Adesso selezionate la nona nota all'interno della stessa misura — un altro E da 1/16 (semicroma) - e fate
Maiusc-clic sullultima nota della misura, per estendere la selezione fino alla fine della misura.

- Digitate Maiusc-H per aggiungere un diminuendo: si osservi che viene creato automaticamente
alla stessa lunghezza della selezione appena eseguita. Un altro modo per risparmiare tempo.

Ora ¢ possibile terminare di inserire tutte le forcine mancanti alla partitura - & possibile eseguire copie
multiple delle forcine su pit righi, nello stesso modo gia visto per il testo delle dinamiche.

Inseriamo adesso le linee di tempo mancanti:
» Selezionate la misura 19 del rigo Violino I facendo clic su una parte vuota della misura.
« Premete L per aprire la galleria Linea.

» Selezionate poco rit. (solo testo) dalla categoria Rit. e accel. (questa linea non presenta una
linea tratteggiata di durata dopo il testo).

Aggiungete un identico poco rit. Nello stesso modo aggiungere un’identica linea poco rit. alla misura 59,
ma questa volta selezionate la nota da 1/8 (croma) alla meta della misura e premete L.

Infine, aggiungete una linea rit. all'ultima battuta dell'estratto, selezionate nuovamente rit. (solo testo)
dalla categoria Rit. e accel. in modo che non venga mostrata una linea tratteggiata di durata dopo
il testo.

Per maggiori informazioni sulle linee, (0 4.6 Linee nel Manuale Operativo.
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Legature di portamento

Legature di portamento e segni di frase rappresentano un tipo speciale di linea e, come le forcine,
sono cosi comunemente usati che dispongono di un proprio comando rapido, facile da ricordare: S.
Sibelius li tratta tutti allo stesso modo, chiamandoli tutti "legature di portamento”, visto che i segni
di frase sono anchessi delle grandi legature.

Quando sono stati scansionati i file PDF delle parti del quartetto d’archi, PhotoScore Lite non ha
riconosciuto le legature di portamento sulla parte (la versione completa PhotoScore Ultimate ¢ in
grado di farlo), per cui occorre inserirle manualmente.

Per aggiungere una legatura di portamento, selezionate la nota da cui volete che inizi e premete S.
Se create una legatura di portamento nel punto sbagliato, semplicemente selezionatela e premete
Cancella, quindi selezionate la nota o pausa da cui volete che inizi la legatura di portamentoe premete S.
Cosi come per estendere le forcine, usate Spazio per estendere di una nota alla volta la legatura di
portamento e Maiusc-Spazio per tornare indietro, nel caso andiate troppo oltre.

Si provi a selezionare una nota a una delle estremita di una legatura di portamento e spostarla
verso l'alto e il basso - si noti come la legatura sia magnetica e rimanga attaccata alle note nel modo
pitt chiaro possibile su entrambi i lati. Notate come, quando selezionate una legatura di portamento,
un lieve profilo con sei box appare intorno ad essa. Questi box si chiamano maniglie, e offrono un
ampio grado di controllo sulla forma della legatura di portamento. Facendo clic e trascinando uno
di questi punti potremo cambiare la forma in una particolare direzione.

Fare attenzione a differenziare nelle partiture le legature di portamento e le legature di valore tra
note - le legature di valore si aggiungono dal tastierino numerico (vedere in seguito) e sono molto
diverse dalle legature di portamento.

Per maggiori informazioni sulle legature, 1 4.8 Legature di portamento nel Manuale
Operativo.

Articolazioni

62

Nel primo progetto di questa Guida abbiamo appreso ad aggiungere articolazioni alle note usando
il tastierino numerico, tra cui i segni di staccato e tenuto, accenti e legature. Premete F10 (o fate clic
sulla pagina Articolazioni del tastierino numerico) per accedere ad ulteriori segni di articolazione
nel quarto layout del tastierino numerico. Qui potrete inserire cunei, segni d’archetto, segni di marcato,
staccatissimo e fermata di diverse durate.

Sara possibile aggiungere articolazioni alle note usando selezioni multiple o di passaggio, in modo
da rendere il processo considerevolmente piti rapido. Per esempio, ogni nota della terza misura dei
righi Violino I e Violino II & suonata staccato:

« Fare clic su una parte vuota della terza misura del rigo Violino I e premere Maiusc-clic sulla terza
misura del rigo Violino II per creare una selezione di passaggio.
« Assicuratevi che sia visualizzato il primo layout del tastierino numerico premendo F7.

« Sul tastierino numerico premere il tasto corrispondente al . (punto di staccato), situato sulla fila
superiore di pulsanti del tastierino numerico. In questo modo aggiungeremo un segno di staccato
ad ogni nota della misura su entrambi i righi.



2.4 Contrassegnare una partitura

Adesso completate il lavoro inserendo le articolazioni mancanti facendo riferimento alla stampa
precedentemente creata. Ci si dovrebbe accorgere che, sebbene la gran parte delle articolazioni di
cui si ha bisogno sono nel primo layout del tastierino numerico, si deve ricorrere al quarto layout
per i segni seguenti:

+ Segni di marcato nelle misure 8 e 38 del rigo Violino I;

« Segni di marcato nelle misure 20, 22, 29 e 40 del rigo Violino IJ;

« Segni di marcato nelle misure 9, 10, 21, 23, 40 e 49-52 del rigo Viola;

« Segni di marcato nelle misure 49-52 del rigo Violoncello;

Segni di Staccatissimo nella misura 48 su tutti i righi;

« Un segno di Staccatissimo nella misura 49 del rigo Violino I1.#

Per maggiori informazioni sulle articolazioni, [ 4.22 Articolazioni nel Manuale Operativo.

Confronto delle versioni

Che siate un compositore, un arrangiatore o un trascrittore, una volta aggiunti tutti i dettagli allo spartito,
potreste aver bisogno di confrontare la versione appena contrassegnata con una precedente, in modo da
evidenziarne qualsiasi differenza. La finestra Confronta di Sibelius permette di confrontare due
partiture diverse — o due versioni della stessa partitura — e creare un riassunto delle differenze riscontrate;
se preferite, potrete anche creare un confronto molto dettagliato di ogni differenza — molto utile per
verifiche o per documentare levoluzione di un brano musicale.

Per vedere la finestra Confronta, selezionate Revisione » Confronta » Confronta.

In cima alla finestra Confronta appaiono due menu a tendina, dai quali sara possibile selezionare
qualsiasi partitura che avete aperta e le versioni che contiene. Proviamo a confrontare la partitura
nella sua forma corrente con la versione salvata precedentemente:

« selezionare il titolo della partitura, per esempio Elgar (o qualsiasi altro nome abbiate usato al momento
di salvarla), dal primo menu a tendina (questo confronta la versione corrente della partitura).

- selezionare — Versione 1 — immissione scansione (o qualsiasi altro nome abbiate usato per salvare
la versione) dal secondo menu a tendina:

ﬂ Confronta | =RACE X
Confronta: |Elgar v| ol
5
Con: |- Wersione 1, scanned input - | —
Muowe misure  Misure precede Righi Differenze

(Se avete saltato i capitoli precedenti e avete aperto il file di progetto solo a questo punto dovreste
scegliere la versione 3 Chiavi, tonalita e gruppi irregolari nel secondo elenco.).
« Fare clic sul pulsante Confronta (5!) che trovate accanto ai menu a tendina.

« Sibelius analizzera le versioni e mostrera una finestra di dialogo contenente un breve riassunto
delle differenze tra le due partiture.

« Fate clic su Chiudi per vedere in dettaglio le differenze nella finestra Confronta.
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Un doppio-clic nella finestra Confronta sopra una delle differenze individuate spostera la vista sulla
specifica differenza in entrambe le finestre. Sibelius inoltre aggiungera un fondo colorato a indicare
gli oggetti che sono stati aggiunti (verde), rimossi (rosso) o modificati (arancio).

Provate a confrontare alcune delle altre versioni nelle partiture del progetto per rendervi conto della
completezza del confronto.

Grazie a questo potente strumento sara anche possibile creare un rapporto dettagliato di tutte le
differenze incontrate da Sibelius — completo con schermate delle partiture — per aprirlo all'interno
del vostro software di scrittura. Per ulteriori informazioni su versioni e sul confronto tra partiture,
3 10.3 Versioninel Manuale Operativo.



2.5 Layout e formattazione

2.5 Layout e formattazione

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 2 e che
la versione 5 Layout e formattazione sia la Versione corrente, selezionando Revisione» Versioni»
Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Terminata I'immissione delle note e dei segni nella partitura, & opportuno accertarsi che la musica
appaia nel miglior modo possibile. Dato che Sibelius aggiusta il layout della partitura mentre aggiungete
altra musica, strumenti, testo e altri oggetti, & consigliabile aspettare fino a quando la partitura &
pilt 0 meno completa. Altrimenti le vostre modifiche potrebbero essere annullate.

Si e gia visto alcuni degli effetti del Layout Magnetico, la funzione di Sibelius pensata per individuare
ed evitare possibili collisioni, che riorganizza la partitura al tempo stesso in cui si crea e modifica la
musica. Sibelius dispone di una vasta scelta di strumenti e funzioni per aiutarvi con la formattazione
della vostra musica (formattazione ¢ il processo di organizzare il tutto in pagine).

In questo capitolo si apprendera a creare interruzioni, a manipolare [orientamento della pagina e le
dimensioni del rigo, a cambiare la spaziatura del rigo e a creare pagine di titolo, il tutto con il fine di
produrre una magnifica ed elegante partitura.

Layout magnetico
Prima di tutto daremo un'occhiata al Layout Magnetico in azione e vedremo come Sibelius & in
grado di ricalcolare le posizioni degli oggetti sul rigo in modo da prevenire accavallamenti o che le
note vengano coperte. Si osservi come funziona:

« Selezionate la nota F# da 1/16 (semicroma), la penultima nota alla fine della prima battuta intera
del rigo Violoncello.

« Usate V per abbassare l'altezza.

« Mentre muovete altezza verso il basso le dinamiche sotto il rigo si spostano a loro volta verso il
basso, in modo da evitare la nota.

Notate come Sibelius muove intelligentemente l'intera linea di dinamiche in gruppo sotto il sistema,
preservando le loro relative posizioni orizzontali. Adesso, se provate a cliccare su uno dei segni dinamici
(la forcella di dinamica, per esempio) per selezionarlo, vedrete una linea tratteggiata blu chiaro a
indicare che le dinamiche sono raggruppate, e che Sibelius le muovera insieme nel caso che una di
esse debba essere spostata per evitare una collisione. Noterete anche un set di segni dinamici ombreggiati
in grigio che appaiono lungo il sistema, al posto di dove le dinamiche dovrebbero normalmente essere.
(Potete effettuare lo zoom per vederli chiaramente).

Questo sistema funziona per tutti gli oggetti di testo, simboli, linee e altri oggetti (simboli di accordo,
per esempio).

Potrete trascinare gli oggetti sul rigo e Sibelius usera lo spazio disponibile per assicurare che non si
sovrappongano o coprano a vicenda. Tutto questo viene eseguito intelligentemente, in modo che gli
oggetti meno importanti (come testo, linee e simboli) vengano spostati per lasciare spazio a oggetti
pili importanti (come note, alterazioni, pause, articolazioni, ecc.) che devono invece rimanere su
posizioni fisse, generalmente pit vicino al rigo.
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Potete anche attivare o disattivare il Layout Magnetico per oggetti singoli, cosi da prevenirne spostamenti
e "congelarne” le posizioni nella partitura, una volta soddisfatti con il layout e per evitare che gli oggetti si
spostino magneticamente. Per apprendere come, consultare L3 7.5 Layout magnetico nel Manuale
Operativo.

Adesso daremo unocchiata ai vari controlli di formattazione disponibili in Sibelius.

Interruzioni
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Sia che si stia componendo, arrangiando o semplicemente copiando musica, si vorra sempre tornare
indietro e apportare modifiche, come l'aggiunta di battute nel mezzo del brano che & stato gia scritto. In
questi casi Sibelius deve reagire di conseguenza, riformattando la musica che segue - e lo fa
istantaneamente.

Uno dei vantaggi di questa riformattazione istantanea ¢ che non richiede un comando specifico per
aggiungere un nuovo sistema o pagina - avviene automaticamente se necessario.

In alcuni casi perod necessiterete che un sistema o una pagina finiscano in un punto specifico - per
esempio, nellestratto del Quartetto d’Archi di Elgar, il segno A tempo nella battuta 7 indica
I'inizio di un nuovo sistema, perché li é stato inserito un’interruzione di accollatura.

Per aggiungere un'interruzione di accollatura, selezionate una stanghetta e quindi Layout» Interruzioni»
Interruzione di accollatura, oppure utilizzate il comando rapido Invio (sulla tastiera principale).
Vi consigliamo di usare questa funzione per ampliare lo spazio disponibile, nel caso la musica su
una sola accollatura vi appaia troppo densa, o al contrario, nel caso in cui un'accollatura vi sembri
troppo spazioso rispetto all'accollatura superiore (in questo caso potete aggiungere ur’interruzione
di accollatura all'accollatura precedente per spostare una delle sue battute nel sistema successivo).
Si provi ad aggiungere interruzioni di accollatura alla partitura su cui si sta lavorando.

Sibelius vi permette inoltre di inserire interruzioni di pagina, normalmente usati solo alla fine di sezioni,
per esempio in un pezzo composto da vari movimenti, o quando la sezione successiva ha un nuovo
titolo al suo inizio. Per saperne di pili, e per apprendere a "bloccare” interi passaggi di musica per
evitare che vengano riformattati, (0 7.9 Layout e formattazione nel Manuale Operativo. In
parte, Sibelius puo anche inserire automaticamente interruzioni in posizioni utili - €3 7.6 Interruzioni
nel Manuale Operativo.



2.5 Layout e formattazione

Impostazioni Documento

Un altro vantaggio della riformattazione istantanea di Sibelius ¢ che potrete apportare qualsiasi tipo
di modifica alla musica inserita — come cambiare la forma della pagina - e il layout dellintera partitura
verra istantaneamente aggiornato di conseguenza.

Per mostrarvi un esempio estremo di questo tipo di formattazione proviamo a cambiare lorientamento
del foglio su cui la partitura & scritta, dal formato ritratto (pit alto che largo) al formato paesaggio
(pit largo che alto). Selezionate Layout» Impostazioni del documento» Orientazione»
Orizzontale. La partitura adesso appare cosi:

Q= " Progetto 2 - Sibelius 7 =&
Home  Inserimento Nota Testo  Riproduci  Layout  Aspetto  Parti  Revisione  Vista ova sul nastro N
O Margini - Dimensione rigo 5 spazitra Nascondi Righi Vuoti € Layout Magnetico|  Collisioni .
- =, 9 a
< 63mm [ = Righi 750 2 =Mostra Righi Vuoti Bloc 5 Trova Successivo = =
Pagina  Ottimizza = I r
Titolo. Accollature 9,25 T & Evidenzia Righi Selezionati |~ Object: 7L Trova Precedente | Intemuzioni | Formato
& Spaziatura Rigo & Righi Nascosti Magnetico n . .
B
QUARTETFOR STRINGS 2 QUARTET
0
il Edward Elgar 0 4 2 - L
Allegro molto J= 132 — : i
[ e EEeeE=eoe—n= ¢
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violin 11 [{(6" 45 = T ‘j
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Provate a diminuire Layout» Impostazioni del documento» Dimensioni rigo a 4mm o 0,16 pollici,
secondo necessita, e vedete come la musica diminuisca le dimensioni per occupare un numero minore
di pagine.

Potete scegliere tra diverse dimensioni di pagina e margini dal gruppo Layout» Impostazioni
del documento del nastro; se volete impostare le vostre dimensioni e margini di pagina, fate
clic sul pulsante sulla destra di Layout» Impostazioni del documento, che apre il riquadro
Impostazioni del documento

Per tutti i dettagli su queste impostazioni, [J 7.1 Impostazioni documento nel Manuale
Operativo.

Spaziatura rigo

Pill musica si aggiunge alla partitura, pili rapidamente la pagina si riempira e di conseguenza si
dovranno allontanare maggiormente i righi per lasciare alle note e agli altri oggetti lo spazio necessario
per spostarsi. Ci sono diversi modi per farlo: provate a sperimentarli sulle vostre partiture.

Le distanze predefinite tra i righi e i sistemi sono controllati dalle impostazioni Spazi tra nel gruppo
Layout» Spaziatura rigo, che vi permette di cambiare l'aspetto di queste caratteristiche delle vostre
partiture in una singola operazione. Dovreste provare a regolare questi valori prima di effettuare
una regolazione individuale direttamente sulla partitura.
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In alcuni casi pero si rivela utile poter aumentare la distanza tra i righi contenuti in un singolo sistema
cosl da evitare collisioni tra note molto alte o molto basse. Potete chiedere a Sibelius di utilizzare al meglio
lo spazio che avete scelto tra righi e sistema ricorrendo a Layout» Spaziatura righi» Ottimizza.
Sibelius adesso calcolera la distanza minima per spostare i righi in modo che gli oggetti su un rigo non
collidano pit1 con quelli sull’altro rigo. Proviamolo con la prima pagina della nostra partitura:

+ Fate clic sulla battuta d’attacco del rigo Violino I per selezionarla

« Maiusc-clic sul rigo di Violoncello nell'ultima battuta del sistema in basso alla prima pagina

« Selezionate Layout» Spaziatura rigo » Ottimizza

« Sibelius cerchera il modo migliore per evitare che la musica su un rigo collida con quella su altri righi.

Come ultima opzione potreste dover ricorrere alla modifica manuale per evitare la collisione su un
singolo sistema, semplicemente trascinando i righi con il mouse. Provate a selezionare una battuta
sul rigo Violino II facendo clic su un punto vuoto del rigo e trascinandolo verso Talto e il basso — o usate
i comandi rapidi A+ 0~ V(tenere premuto Ctrl 0 #per incrementi maggiori). Notate come
Sibelius riformatta la musica mentre muovete il rigo.

In questo modo potrete cambiare la spaziatura tra righi lungo l'intera partitura, per un singolo sistema, o
per qualsiasi altro passaggio vogliate selezionare. Se commettete un errore, potete usare le opzioni
Layout» Spaziatura rigo» Ripristina spazio sopra/sotto per reimpostare la partitura predefinita.

Se volete avere un controllo maggiore su come Sibelius gestisce la spaziatura dei righi, fate
clic sul pulsante sulla destra di Layout» Spaziatura rigo, che apre la pagina Righi del riquadro
Regole tipografia.

Per maggiori dettagli in merito, £ 7.3 Spaziatura rigo nel Manuale Operativo.

Creare pagine di titolo

Per creare una pagina di titolo quando si crea la partitura per la prima volta (come gia visto nel primo
capitolo di questo progetto) attivare lopzione Crea pagina titolo nelle impostazioni della scheda
Nuova partitura di Avvio rapido.

In ogni caso, & possibile creare una pagina titolo in qualsiasi momento, come si fara ora. Selezionate
Layout» Impostazioni del documento» Pagina titolo per accedere al riquadro con le opzioni
per decidere quante pagine vuote inserire all'inizio della vostra partitura e altri dettagli che potreste
voler aggiungere. (Poiché sono stati aggiunti titolo e riconoscimenti del compositore nelle impostazioni
della nuova partitura, Sibelius li aggiungera automaticamente qui, pronti per essere aggiunti alla
pagina del titolo.)

Attivate lopzione Includi nome parte per visualizzare "Partitura Completa” in cima alla pagina,
quindi fate clic su OK per creare un'unica pagina di titolo con titolo e compositore inclusi.

Cancellare pagine di titolo
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n Quando create una pagina del titolo, sia che scegliate Layout» Impostazioni del
documento» Pagina titolo che ne aggiungiate una dalle impostazioni relative alla nuova
partitura - apparira un segno speciale di layout all'inizio della partitura (mostrata sulla
sinistra). Se non potete vederlo, controllate che Visualizza» Invisibili» Segni di layout

sia attivato.



2.5 Layout e formattazione

Per cancellare la pagina titolo appena creata fate clic semplicemente su questo segno di layout in modo
da selezionarlo, e quindi premete Cancella. (Cosi facendo rimuoverete tutte le pagine vuote dall'inizio
della vostra partitura, quindi se desiderate rimuovere solo una tra le varie pagine vuote dovreste far
riferimento a (3 7.7 Interruzioni nel Manuale Operativo.

Come con tutte le altre funzioni di modifica di Sibelius, sara possibile annullare qualsiasi cambio apportato
alle pagine titolo, fate clic su Annulla oppure selezionate Modifica» Annulla su Mac per ripristinare la
pagina del titolo appena eliminata.
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.6 Parti Dinamiche™

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 2 e che
la versione 6 Parti Dinamiche sia la versione corrente, selezionando Revisione » Versioni»
Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Nel primo progetto abbiamo analizzato le parti dinamiche - il set di parti strumentali che Sibelius
crea per ogni partitura, che mostrano la rispettiva notazione per ogni strumento e che vengono
automaticamente aggiornate in corrispondenza con l'intera partitura. Da ricordare che se qualsiasi
oggetto viene modificato o spostato all'interno dellintero spartito, i cambi saranno riflessi anche
nella parte. Tuttavia, se muovete un oggetto che non sia una nota o un accordo all'interno di un
parte, non verra spostato nella partitura; e diventera color arancio, a indicare la differenza tra parte
e partitura. In questo modo sara possibile modificare la posizione dei segni all'interno delle parti
senza influenzare lorganizzazione della partitura.

Questo capitolo mostra come creare acciaccature, modificare lorganizzazione delle parti, creare nuove
parti strumentali e produrre una semplice riduzione per piano dell'arrangiamento per quartetto d’archi.

La scheda Parti

70

La scheda Parti del nastro permette di apportare modifiche alle vostre parti individualmente,
globalmente o a una selezione specifica di parti. Potete stampare parti multiple, regolare lorganizzazione
automatica delle parti, creare nuove parti, rimuovere o aggiungere righi da parti esistenti, e cosi via,
il tutto dalla finestra Parti.

Potete vedere qualsiasi parte utilizzando il pulsante Apri nuova scheda sul lato destro della EI
barra schede documento, che apre un menu che elenca tutte le parti dinamiche e le altri ~—
visualizzazioni disponibili della partitura corrente. Potete anche accedere a questo menu
facendo clic con il tasto destro (Ctrl-click su Mac) in un qualsiasi punto della barra schede
documento.

Partitura Carmpleta

Parti
Flutes 1 = 2
Oboes1 + 2, Cor Anglais
ClarimetsnBb1 + 2
Bassoons 1+ 2
Homsl + 2
Homs 3 = 4
Trurnpets 1 + 2
Trombones 1 + 2
Blass Trombone
Tirmpani
Vialin I
Yialin [
Viola
Yioloncello
Deuble bass

Mugyva finestra
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In circostanze normali, probabilmente non vi servira utilizzare la scheda Parti finché non avete quasi
finito di lavorare a una partitura. Tuttavia si rivela utile per modificare lorganizzazione automatica delle
parti o per quelle situazioni in cui una parte deve contenere piti di uno strumento (per esempio,
raddoppio strumentale o musica corale). Per tutti i dettagli, consultare 13 9. Scheda Parti nel
Manuale Operativo.

Acciaccature
Le note acciaccate sono rappresentate da piccole note guida che aiutano lesecutore a sapere dove si
trova, e non devono essere suonate. I passaggi d’acciaccature possono anche indicare musica facoltativa
(ad esempio, un solo di armonica potrebbe diventare una parte di clarinetto con I'indicazione:
"suonare se non c¢ 'armonica").

Sibelius rende l'inserimento di acciaccature alle vostre parti molto semplice; proviamo ad aggiungere
un’acciaccatura:

« Assicuratevi di star vedendo la partitura completa.

« Selezionate la battuta 8 del rigo Violino I cliccando su uno spazio vuoto del rigo.

« Selezionate Home » Appunti» Copia (comando rapido Ctrl+C o #C) per copiare la musica negli
appunti.

Adesso selezionate la corrispondente battuta vuota del rigo Violino II.

Fate clic sulla parte inferiore del pulsante Home » Appunti» Incolla e selezionate Incolla come guida
(comando rapido Ctrl+Maiusc+Alt+V o ©~3V) per creare una guida.

Premete W con lacciaccatura selezionata per vedere la parte Violino II; premete Esc per deselezionare
lacciaccatura e notate come Sibelius ha creato una serie di piccole note e altri segni, aggiungendo
una battuta di pausa in una voce separata (ma, come vedrete, ha nascosto 'acciaccatura nella partitura
completa) e indicando lo strumento con I'acciaccatura sopra il rigo. Se necessario Sibelius aggiunge
anche cambi automatici di chiave o trasporti dottava, cambi del tipo di rigo (in una tablatura per
chitarra, per esempio) e copia delle parole.

Premete di nuovo W per tornare alla partitura completa; la stessa battuta sul rigo Violino IT adesso
sembra vuota, ma lacciaccatura ¢ solo nascosta.

Organizzazione delle parti
In generale, il metodo di lavoro ideale consiste nell'inserire prima la musica nella partitura completa,
invece che nelle parti; si modifichera poi posizione e aspetto degli elementi nelle parti nel corso
delle modifiche finali.

Si noti, pero, che nelle parti ¢ possibile eseguire piuttosto liberamente modifiche di layout, come
spostare righi, regolare interruzioni di accollatura e pagina, cambiare la spaziatura nota — cio non equivale
a spostare gli oggetti, perché non importa se partitura e parte hanno layout leggermente diversi.

Sibelius gestira intelligentemente lorganizzazione delle parti in modo che banali compiti come creare
adeguati cambi pagina per i musicisti, inserire break di sistema a cambi di tempo e sezione, e la
giustificazione generale (la distribuzione sia orizzontale che verticale della musica per riempire la
pagina fino ai margini) delle vostre parti siano tutti eseguiti automaticamente. Il tutto ¢ ottenibile
tramite la funzione Layout Interruzioni» Interruzioni automatiche. Avrete il pieno controllo di
ogni aspetto automatizzato che viene applicato allorganizzazione delle vostre parti, e se lo desiderate
potrete disattivarlo completamente.

Per maggiori informazioni, consultare 1 7.6 Interruzioni nel Manuale Operativo.
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Creare una nuova parte
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In quelle situazioni in cui dovete riarrangiare un brano musicale per includere strumenti differenti, la
possibilita di creare una nuova parte da musica pre-esistente si rivela estremamente utile. Creeremo una
parte alternativa di fagotto partendo dal rigo di violoncello:

« Innanzitutto, aprite la parte Violoncello esistente in una nuova scheda documento.

« Selezionate Parti Impostazioni»Copia e cambia strumento.

« Apparira un riquadro che vi permettera di scegliere quali righi dovranno essere contenuti nella
nuova parte.

« Scrivete "fagotto” nella casella di testo Trova e premete Invio per selezionarlo dall'elenco, quindi
premete OK.

La parte viene cambiata automaticamente in una parte per fagotto, notate come il nome strumento
che appare nell'angolo in alto a sinistra della pagina viene aggiornato, cosi come il nome della
parte nell'elenco Apri nuova scheda.

In alternativa, potra capitarvi di trovarvi in situazioni nelle quali volete creare un‘altra parte contenente
piti di uno strumento.
« Selezionate Parti iImpostazioni»Nuova parte.

« Apparira una finestra di dialogo che vi permettera di scegliere quali righi dovranno essere contenuti
nella nuova parte.

« Selezionate Viola dallelenco sulla sinistra e cliccate su Aggiungi alla Parte.

« Selezionate Violoncello dallelenco sulla sinistra e cliccate su Aggiungi alla Parte, quindi cliccate
su OK.

Dovreste vedere una seconda parte chiamata Viola, Violoncello in una nuova scheda documento.

Potete sempre cambiare gli strumenti nella partitura aggiungendo un cambio strumento; i cambi
strumento possono essere aggiunti a una parte di una partitura (per raddoppio strumentale) o
possono sostituire uno strumento con un altro, mantenendo la musica esistente:

» Dopo aver aperto questa parte appena creata, selezionate Home» Strumenti» Cambia
(comando rapido Ctrl+Maiusc+Alt+l 0 &~31).

« Scrivete "fagotto” nella casella di testo Trova e premete Invio per selezionarlo dall'elenco, quindi
premete OK.

Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.

Fate clic alla sinistra della stanghetta iniziale, prima dell'inizio della prima accollatura di musica
allinterno della parte.

I rigo viene cambiato automaticamente in una parte per fagotto, notate come il nome strumento che
appare nell’angolo in alto a sinistra della pagina viene aggiornato, cosi come il nome della parte
nell'elenco Apri nuova scheda.



2.6 Parti Dinamiche™

Creare una riduzione per piano

Ora vedremo come creare una semplice riduzione per piano dellestratto di Elgar:

« Premere W per vedere la partitura completa.

« Selezionate Home» Strumenti» Aggiungi o rimuovi (comando rapido I), e aggiungete uno
strumento Piano nella partitura.

« Fate triplo clic sul rigo Violino I per eseguire una selezione di passaggio intorno all'intero rigo,
quindi Maiusc-clic sul rigo Violino II per selezionare tutte le battute su entrambi i righi.

« Selezionate Inserimento nota» Arrange » Riduci.

+ Nella finestra di dialogo che apparira scegliete Usa rigo esistente come destinazione, e scegliete
Piano dallelenco a tendina.

+ Cliccate su OK e il plug-in Riduci condensera la musica dei due righi per violino nel rigo di piano
per la mano destra.

« Fate triplo clic sul rigo Viola per eseguire una selezione di passaggio intorno allintero rigo, quindi
Maiusc-clic sul rigo Violoncello per selezionare tutte le battute su entrambi i righi.

« Selezionate nuovamente Inserimento nota» Arrange » Riduci.

« Questa volta, nella finestra di dialogo, scegliete Piano~(2) dallelenco a tendina.

« Cliccate su OK e il plug-in Riduci condensera la musica dei righi Viola e Violoncello nel rigo di
piano per la mano sinistra.

Se volete, potete riordinare la parte di piano mettendo in pratica quello che avete imparato fin'ora,
oppure usate Inserimento nota» Flexi-time» Ritrascrivi esecuzione per semplificare i passaggi
disordinati.

Se scorrete l'elenco Apri nuova scheda noterete che Sibelius ha gia creato una nuova parte di Piano
che include la musica di entrambi i righi di piano.

Inserimento nota» Arrange» Riduci ¢ uno dei piti di 100 utili plug-in, funzioni extra scritte usando
ManuScript, il linguaggio di programmazione interno di Sibelius ,pensati per rendere piti rapidi certi
lavori ripetitivi eseguendo automaticamente determinate operazioni, altrimenti estremamente lunghe e
laboriose.

La maggior parte delle schede del nastro presenta un gruppo Plug-in nel quale troverete i plug-in
relativi alle operazioni di quella scheda, che vi permetteranno di automatizzare tutti i tipi di procedure,
come aggiungere simboli accordo, armonizzare un brano, impostare i cambi pedale arpa o verificare la
vostra musica. E se vi sentite in grado, potrete anche scrivere i vostri propri plug-in.

73

¢ onaboid



Progetto 2

2.7 Esportazione

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 2 e rendere
la versione 7 Esportazione la Versione corrente, selezionando Revisione » Versioni » Modifica
versioni, selezionando questa versione nell'elenco e facendo clic su Rendi corrente.

In Sibelius ¢ possibile esportare file, pagine o brevi sezioni del vostro spartito in altri programmi,
sia come file PDF che come file grafici in vari formati diversi. Potete condividere la vostra partitura
come file MusicXML per aprirlo con altri programmi di notazione musicale. Potete anche copiare e
incollare elementi grafici direttamente da Sibelius. Inoltre Sibelius vi assiste nella pubblicazione di
musica su Internet, in modo che altri possano vederla, riprodurla, modificarne tonalita e strumenti,
e stamparla, usando Scorch, il plug-in gratuito di Sibelius.

Questo capitolo mostra come copiare unimmagine da Sibelius in un altro programma (per esempio,
Microsoft Word) e come esportare un file MusicXML da aprire con altri programmi di notazione
musicale.

Copiare elementi grafici in altri programmi

Ora si apprendera come esportare frammenti di musica come elementi grafici, usando semplicemente

la funzione copia e incolla.

« Eseguire una selezione di passaggio intorno all'intera prima accollatura di musica.

« Selezionate Home » Appunti» Seleziona immagine (comando rapido Alt+G o #G): attorno
alla musica apparira un riquadro tratteggiato con delle maniglie.

« Se necessario, spostare le maniglie ai bordi del riquadro per regolarne le dimensioni, semplicemente
cliccando e trascinando.

« Selezionate Home » Appunti» Copia (comando rapido Ctrl+C o #C) per copiare i contenuti
dal riquadro agli appunti.

+ Premere Esc per annullare la selezione.

« Aprire 'applicazione in cui si desidera incollare lelemento grafico (ad esempio Microsoft Word)

« Scegliere Home» Appunti» Incolla (comando rapido Ctrl+V o #V).

E voila! Se riscontrate che la grafica risultante non ¢ abbastanza dettagliata, regolate Punti per pollice

nella pagina Altro di File » Preferenze e ripetete il processo precedente.

Sibelius vi permettera inoltre di esportare elementi grafici come file nei formati EPS, SVG, PNG,

TIFF e BMP. Per ulteriori dettagli, &3 1.12 Esportare le immagini nel Manuale Operativo.

Esportare in formato MusicXML in altri programmi
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Se collaborate con persone che usano ancora un altro programma di notazione, potete esportare la
vostra partitura come file MusicXML per condividerlo con loro.

Fate clic sulla scheda File , quindi scegliete Esporta e quindi MusicXML

« Ora scegliete se esportare file MusicXML Compressi o Non compressi.

« Fate clic sul pulsante Esporta per salvare come file MusicXML

« Apparira un riquadro standard Salva; scegliete il nome del file e fate clic su Salva.

La maggior parte dei programmi di notazione ¢ in grado di aprire file MusicXML compressi, di dimensioni
minori e piti facili da inviare via e-mail rispetto ai file MusicXML non compressi. Sibelius puo, ovviamente,
importare e esportare file MusicXML compressi e non compressi.
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3.1 Comporre per tastiera

In questo progetto imparerete a usare alcune delle funzionalita pitt importanti per produrre musica
jazz e commerciale: inserire musica complessa per tastiera e comporre per chitarra, memorizzare e
riutilizzare frammenti di musica utilizzando il pannello Idee; come creare simboli accordo utilizzando
inserimento testuale e MIDI input; utilizzare strutture ripetute e creare arrangiamenti per corni;
nonché rendere le partiture pit realistiche per la registrazione audio.

Il primo capitolo di questo progetto impiega i metodi di immissione delle note appresi nel primo
progettodel tutorial, e vi mostra come immettere musica pitt complessa per tastiera usando una
tastiera MIDI e attraverso I'immissione Flexi-time di Sibelius.

Stampa
Innanzitutto selezionate File » Apri (comando rapido Ctrl+O o #0) e individuate la partitura d'esempio
chiamata Progetto 3 nella cartella File Progetto nella cartella delle partiture d'esempio. Aprite questa
partitura. Dovreste adesso essere in grado di vedere un arrangiamento completo del brano funk
Urbane Filigree.

Dato che dovremo fare riferimento a una stampa di questo arrangiamento nel corso del progetto,
selezionate File » Stampa (comando rapido Ctrl+P o #P) e fate clic sul pulsante Stampa per stampare
la partitura.

Nel giro di pochi secondi una stampa di Urbane Filigree dovrebbe uscire dalla vostra stampante.
Conservare questa stampa perché sara necessaria per leggere la musica quando in breve si modifichera
larrangiamento.

Ora, per continuare questo progetto, selezionate Revisione» Versioni» Modifica versioni, quindi
selezionate la versione 1 Comporre per tastiera dall'elenco e fate clic su Rendi corrente. Fare clic su
Si per renderla la versione corrente e quindi fare clic su Chiudi. Dovreste poter vedere un arrangiamento
con parti mancanti di Piano Elettrico Palco e Chitarra Elettrica.

Utilizzo di una tastiera MIDI
Per usare Flexi-time dovrete avere un dispositivo MIDI collegato al vostro computer. Per impostare
l'immissione e la riproduzione in Sibelius, selezionate File » Preferenze e andate alla pagina Dispositivi
d'immissione.
In questo capitolo, si utilizzera una tastiera MIDI. Per ulteriori informazioni su come impostare
immissione e riproduzione con dispositivi MIDI, 3 3.13 Dispositivi ingresso nel Manuale
Operativo.
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Opzioni Flexi-time

Apprenderemo a suonare musica particolarmente complessa all'interno di Sibelius, usando una
tastiera MIDI e I'immissione Flexi-time. Se preferite evitare di registrare la musica all'interno di
Sibelius in tempo reale, potrete comunque inserire la musica mancante usando il metodo di immissione
step-time analizzato nel primo progetto di questo tutorial. Se non avete una tastiera MIDI, saltate a
3.2 Comporre per chitarra su pagina 77.

Ora registreremo la parte Piano Elettrico Palco mancante, quindi per essere sicuri di avere i
risultati migliori, fate clic sul pulsante sulla destra di Immissione nota» Flexi-time sulla destra
(scorciatoia Ctrl+Maiusc+0 o &30) per aprire il riquadro opzioni Flexi-time.

Scegliete Nessuna (non rubato) dallelenco a tendina Flessibilita del tempo e disattivate la
casella Registra in voci multiple. Fate clic su OK per tornare alla partitura. Se volete rallentare il tempo
per facilitare la registrazione, semplicemente muovete lo slider tempo della finestra Trasporto verso
il lato sinistro.

Inserimento Flexi-time a due mani
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Sistemate la stampa in modo che possiate leggere chiaramente la musica dei righi di Piano Elettrico
Palco (o se preferite, improvvisate la parte seguendo i simboli accordo sopra i righi della partitura).
Selezionate la prima battuta dei due righi Piano Elettrico Palco adiacenti nella partitura: fate clic sul
rigo superiore, quindi fate Maiusc-clic sul rigo inferiore in modo che entrambi vengano selezionati;
cosi Sibelius sapra da dove iniziare e quale strumento volete registrare. Ora:

« Fate clic sul pulsante Registra sul pannello Trasporto, oppure selezionate Immissione nota»
Flexi-time » Registra (scorciatoia Ctrl+Maiusc+F o o &F).

« Per impostazione predefinita, Flexi-time offre un preconteggio di almeno un’intera battuta - in
questo caso si dovrebbe sentire un preconteggio di una battuta e tre battiti alla battuta d’attacco.

« Alla fine del preconteggio tentate di suonare le battute successive in modo regolare e omogeneo,
seguendo la velocita del metronomo Mano a mano che suonate, la musica che state suonando
apparira in notazione sullo schermo.

+ Una volta raggiunta la musica presente nel rigo superiore alla battuta 9, smettete di suonare con
la mano destra.

+ Alla battuta 17 ricominciate a suonare la parte di Piano Elettrico Palco con la mano destra.

« Per interrompere la registrazione fate clic sul pulsante quadrato di stop nel pannello Trasporto o
premete Spazio o Esc.

Per maggiori informazioni sulla registrazione usando l'inserimento Flexi-time, L1 3.14 Flexi-time
nel Manuale Operativo.



3.1 Comporre per tastiera

Plug-in Semplifica notazione
Se trovate che la notazione creata da Flexi-time risulta troppo complessa, esistono due plug-in che
desidererete provare:

« Note Input» Flexi-time » Ritrascrivi esecuzione vi permette di sistemare pause non desiderate,
note sovrapposto o durate di nota non corrette. Come gia visto nel Progetto 1, selezionando un
passaggio su entrambi i righi e lanciando il plug-in, faremo si che Sibelius ricalcoli di nuovo la
trascrizione Flexi-time e produca una versione ritmicamente e visualmente piti semplice.

+ Note Input» Plug-in» Plug-in» Semplifica Notazione» Cambia punto divisione vi permette
di cambiare il punto in cui le note sono divise tra il rigo destro e il rigo sinistro di uno strumento
a tastiera. Se nella parte appena registrate esistono passaggi in cui le note potrebbero essere meglio
posizionate su un rigo differente, selezionate semplicemente la musica su entrambi i righi e lanciate
il plug-in.

Se ci sono ancora errori potete usare le tecniche di modifica gia apprese per correggere i valori e le
altezze delle note. Potete anche sperimentare con gli altri plug-on nel menu Plug-in in fondo alla
scheda Inserimento nota.

Per maggiori informazioni sui plug-in, £J 1.22 Lavorare con i plug-in nel Manuale Operativo.
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3.2 Comporre per chitarra

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e
chela versione 2 Comporre per chitarra sia la Versione corrente, selezionando Revisione » Versioni »
Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Sibelius offre svariati strumenti e funzioni pensati specificamente per rendere piti semplice la
composizione per la chitarra. Tra questi la capacita di scrivere musica usando la tablatura per chitarra.
Sibelius include informazioni relative a qualsiasi tipo di strumento a corda in grado di usare il sistema di
"tablatura”, in modo da visualizzare il numero correttodi corde e l'accordatura appropriata, sia che
vogliate comporre per chitarra standard, basso a quattro, cinque o sei corde, liuto, o la comunissima
balalaica bassa! Potrete copiare la musica dai righi di notazione alla tablatura per chitarra - e vice
versa; sara anche possibile cambiare dal rigo in notazione standard ad una tablatura a meta di un sistema.

In questo capitolo apprenderemo a registrare musica all'interno di Sibelius prima come notazione
standard e a successivamente trasformarla in tablatura, e come inserire direttamente una tablatura
per chitarra.

(Se disponete di una chitarra MIDI vi consigliamo di usarla durante tutto questo capitolo per inserire
note all'interno di Sibelius. Altrimenti potrete usare una tastiera MIDI o il metodo di immissione
alfabetica delle note gia visto nel Progetto 1.)

Uso di una chitarra MIDI

Se disponete di una chitarra MIDI (o una chitarra con pick-up esafonico e un’interfaccia MIDI per
chitarra) colle collegatela al vostro computer che desiderate usare durante questo capitolo, prima di tutto
dovrete impostarne limmissione e la riproduzione allinterno di Sibelius. Per farlo, selezionate File»
Preferenze e andate alla pagina Dispositivi di ingresso.

Dovreste poter vedere il nome del vostro dispositivo nella tabella in cima alla pagina e assicuratevi
che il riquadro Usa sia attivato. Sara necessario cambiare il valore Tipo cliccando sul menu a tendina e
scegliendo Chitarra, invece che Tastiera; quindi selezionate il numero di corde.

Per ulteriori informazioni su come impostare input e playback con una chitarra MIDI, consultare
3 3.13 Dispositivi ingresso nel Manuale Operativo.

Inserire la parte di chitarra
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Fare riferimento alla stampa creata in precedenza per leggere la musica da inserire.

Se disponete di un dispositivo MIDI collegato al computer registrate la parte di chitarra fino alla battuta
20 usando 'inserimento Flexi-time, selezionando la prima battuta del rigo e scegliendo Inserimento
nota» Flexi-time » Registra oppure fate clic sul pulsante rosso Registra nel pannello Trasporto.

Altrimenti, usate una combinazione dei vostri metodi di inserimento note preferiti per inserire la
musica fino alla battuta 20: inserimento tramite mouse, inserimento alfabetico, inserimento step-time
e pannell Tastiera/Tastiera chitarra. Non si tratta di "modalita” di scrittura musicale alternative da
attivare o disattivare — & possibile passare da un metodo di inserimento allaltro in qualsiasi momento
lo si desideri.



3.2 Comporre per chitarra

Una volta inserita la parte di chitarra, si notera che occorre cambiare alcune note e accordi in modo che
usino una testa nota tacitata (a croce). Per farlo, selezionare la nota o accordo (suggerimento: fate doppio
clic su un accordo per selezionarne tutte le note) e fate clic sulla parte superiore del pulsante Notazioni »
Teste delle note» Digita per cambiare la testa di nota in una a croce. Analizzeremo in dettaglio come
cambiare le teste di nota pill avanti in questo progetto; inoltre (J 4.12 Teste di nota nel
Manuale Operativo.

Convertire a tablatura
Sibelius puo trasformare istantaneamente la notazione standard in una tablatura, usando un cambio di
strumento:
« Selezionate Home » Strumenti» Cambia (comando rapido Ctrl+Maiusc+Alt+l 0 -~31).
« Trovate Chitarra elettrica, accordatura standard [tablatura] e fate clic su OK.
« Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.

« Cliccate sul rigo Chitarra Elettrica all'inizio del primo sistema di musica, alla sinistra della relativa
stanghetta iniziale.

Il rigo di notazione viene cambiato automaticamente in una tablatura per sei corde — notate come
tutta la musica viene anchessa convertita in tablatura. Potrete sempre copiare la musica da e su questa
tablatura usando Alt+clic o~ -clic - Sibelius trasformera la musica copiata nella notazione appropriata
per il tipo di rigo scelto.

Scrivere in una tablatura
Adesso che abbiamo visto come Sibelius ¢ in grado di passare da notazione standard a tablatura
proveremo ad inserire musica da zero:
+ Selezionare la battuta di pausa alla battuta 21 del rigo di chitarra.

« Premete N per iniziare l'immissione delle note, assicuratevi che sia visibile il primo layout del keypad
(premete F7 per essere sicuri).

« Premete 3 0 (sul keypad) per inserire una pausa da 1/8 (croma).
« Premete/ una volta per spostarvi sulla quarta corda e digitate 4 (questa volta sulla tastiera principale).
« Aggiungere un’articolazione staccato dal keypad.

- Avanzate alla posizione successiva premendo-> , quindi digitate 4 (sul keypad) per cambiare ad
una nota da 1/4 (semiminima).

« Premete M due volte per spostarvi sulla seconda corda e digitate 1 (sulla tastiera principale).

« Spostatevi sulla prima corda e premete di nuovo 1.
Dovreste poter vedere questo:

b o

|
|
f 1
1
1

Adesso inserite il resto delle ultime quattro battute nella tablatura, come mostrato qui sotto:

Y > N = [ h 1 5 | o R

T T T
t t t 1-1 t t i ix t t 1-1 t t C
T T T

Proviamo a trasformare di nuovo il rigo di chitarra in notazione standard , usate un cambio strumento
per riportare il rigo a Chitarra elettrica [notazione].
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3.3 Idee e notazione di batteria

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e che
la versione 3 Idee e notazione di batteria sia la Versione corrente,selezionando Revisioni »
Versioni» Modifica Versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

In questo capitolo esploreremo uno dei piti potenti strumenti creativi offerti da Sibelius, il pannello Idee,
grazie al quale potrete salvare frammenti musicali di qualsiasi durata, chiamati idee, per un uso successivo.
Sara possibile aggiungere tag (o parole chiave) ad ogni idea, facilitandone successivamente l'identificazione.

Non solo Sibelius vi permette di catturare rapidamente i frutti della vostra creativita, ma include
anche oltre 1500 idee in unampia gamma di generi musicali e strumenti differenti, in modo che
quando avrete bisogno di un pizzico d’ispirazione o semplicemente di un buon inizio durante il
processo creativo, qui troverete uno spunto appropriato nel giro di pochi secondi.

Visto che abbiamo gia analizzato in precedenza i metodi di scrittura per tastiera e chitarra, in questo
capitolo apprenderemo a creare notazione di batteria. Come vedrete, I'uso del pannello Idee per
facilitare la scrittura per percussioni puo farvi risparmiare molto tempo.

Aggiungere un rigo di batteria alla partitura

Visto che la partitura su cui si ¢ lavorato finora non contiene rigo di batteria, se ne aggiunge uno ora:
« Selezionate Home » Strumenti» Aggiungi o rimuovi, o premete la scorciatoia I.
« Trovate Drum Set (Rock) e fate clic su Aggiungi a partitura.

+ Drum Set (Rock) apparira nella lista Righi nella Partitura; cliccateci sopra per selezionarlo.

Usate il pulsante Giu per riordinare Drum Set (Rock) in modo che appaia tra Basso 5-corde
e Sintetizzatore (a).

« Fate clic su OK per tornare alla partitura.

A questo punto dovreste poter vedere che un rigo di percussioni ¢ stato aggiunto alla vostra partitura,
pronto per permettervi di scrivere una parte di batteria.

Ascolto delle idee di batteria
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Richiamate il pannello Idee, se non € gia visualizzato, da Vista» Pannelli» Idee (scorciatoia Ctri+Alt+]
o ~31). Il pannello Idee ha due visualizzazioni, compatta e dettagliata. Di default si apre la veduta
compatta, che appare cosi:

Urbiar| -
| () Partitra oy Libreria  Tufto |




3.3 Idee e notazione di batteria

Provate a passare da Libreria a Partitura e Tutto. Quando il pulsante Libreria ¢ attivo avrete accesso ad
oltre 2000 idee interne. Provate a scorrere la lista verso I'alto o il basso.

Ogni idea elencata visualizza una piccola anteprima di musica o oggetti in essa contenuti; in generale,
si vedranno due o tre battute di un rigo (anche se un'idea puo contenere qualsiasi numero di battute o
strumenti). Le etichette importanti appaiono ai quattro angoli intorno alla notazione in anteprima:
in alto a sinistra & presente il nome dell'idea; in alto a destra viene visualizzata la lettera L se I'idea
si trova nella libreria invece che nella partitura corrente; in basso a sinistra ¢ disponibile il tempo
in chiave dell'idea e in basso a destra il tempo dell'idea.

Per sentire come suona un'idea, fateci clic sopra e tenete premuto il pulsante del mouse.

Potrete cercare idee che corrispondono a stili o generi specifici inserendo differenti tag nella parte
superiore del pannello. In questo modo sara possibile ridurre la lista soltanto alle idee pili appropriate.

Provate ad inserire qualche tag per verificare l'impressionante numero di idee differenti offerto da
Sibelius in vari stili e generi: motown, funk, happy, melody, slow. Adesso useremo alcune idee
appropriate per la partitura appena creata; cancellate le tag inserite dalla parte superiore del pannello
cliccate sul pulsante Partitura. In prossimita dellinizio dellelenco vedrete Urbane Funky Drum Loop 1.

Incollare un’idea
Proviamo ad impiegare quest’idea nel nostro progetto. Prima di tutto selezionate Urbane Funky
Drum Loop 1 nel pannello Idee; notate come un bordo appare intorno allidea, ad indicare che ¢ stata
selezionata. Adesso copiatela negli appunti, premendo Ctrl+C o0 #C, o semplicemente cliccando
sul pulsante Copia nella parte inferiore del pannello.

Incollare un'idea in una partitura prevede l'utilizzo dello stesso procedimento di cui ci si serve per
altri elementi: selezionare il punto della partitura in cui si desidera che l'idea venga visualizzata,
quindi selezionare Home » Cartella Appunti» Incolla (comando rapido Ctrl+V o #V); altrimenti,
assicurandosi che nulla sia selezionato, selezionare Home » Cartella appunti» Incolla e fare clic
nella partitura nel punto in cui si desidera visualizzare l'idea. E inoltre possibile fare clic sul pulsante
Incolla nella parte inferiore del pannello Idee. Selezionate la prima battuta completa del rigo Drum
Set nella partitura e quindi premete Ctrl+V 0 #V per incollarlo.

Dovreste poter notare come l'idea appena incollata corrisponde con le prime quattro misure di
notazione di batteria successive alla battuta d’attacco (upbeat) come appare sulla stampa.

Potrete inserire la battuta successiva di musica incollando I'idea Urbane Funky Drums 2 nella battuta 5,
ripetendo lo stesso procedimento.

Inserire notazione di batteria
Per l'inserimento nei righi di percussioni & possibile usare uno qualsiasi dei metodi di immissione note
gia analizzati, ma per la notazione di batteria - che usa tipi di teste nota diversi - ¢ pit facile e rapido
usare I'inserimento step-time o Flexi-time.

Se disponete di una tastiera MIDI collegata al computer potrete semplicemente suonare l'altezza
corrispondentealla linea o allo spazio del rigo (come se fosse un rigo di chiave di violino) e Sibelius
scegliera automaticamente la corretta testa nota. (Se non avete una tastiera MIDI collegata, inserite le
note usando I'inserimento alfabetico e consultate Cambiare le teste nota in seguito per come
cambiarle manualmente).
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Proviamo ad inserire un pattern di batteria nella battuta 6:

« Selezionate la battuta di pausa nella battuta 6 e premete N per iniziare I'inserimento delle note.
« Premete 3 sul keypad per scegliere una nota da 1/8 (croma).
« Suonate il G sopra il rigo sulla vostra tastiera MIDI; questa nota corrisponde ad un charleston chiuso.

 Notate come Sibelius cambia la testa nota in una croce:

.
| Y I

—%‘1—}———

« Inserire altri tre charleston da 1/8.
« Premete 2 sul keypad per scegliere una nota da 1/16 (semicroma).

« Suonate due volte il G sulla vostra tastiera MIDI per inserire due colpi di charleston da 1/16.

Seguendo lo stesso procedimento continuate ad inserire le note di charleston per il resto della battuta;
per aggiungere il simbolo rotondo della nota di charleston aperto premete semplicemente F10 in modo
da scegliere il quarto layout del keypad, quindi premete . (sul keypad), che corrisponde al pulsante
Armonica/Aperta. Ora premete. Di nuovo per rimuovere il simbolo rotondo, se necessario;
assicuratevi di premere F7 per tornare al primo layout del keypad per continuare ad inserire note.

Sibelius puo scrivere su uno stesso rigo fino a quattro voci indipendenti, o linee di note e accordi.
Le voci sono suddivise per colore: voce 1 (quella utilizzata finora) in blu scuro, voce 2 in verde, voce 3
in arancio e voce 4 in rosa. Raramente ci si trovera a usare pill di due voci alla volta.

Si usera la voce due per aggiungere il pattern di cassa e rullante, in modo che i relativi gambi siano
rivolti verso il basso, a differenza delle note di charleston, i cui gambi puntano verso l'alto:
« Prima di tutto premere Esc per assicurarsi di non aver niente selezionato.

« Oraselezionate Inserimento note » Voci» Voce » 2 (scorciatoia Alt+2 0 ~2) per invertire le voci,
o premete 2 sulla fila di bottoni in fondo al Tastierino.

Scegliete una nota da 1/16 premendo 2 sul keypad.

Il puntatore del mouse diventa verde, a indicare che sta "portando” un oggetto che verra inserito
nella voce 2.

Adesso cliccate con il puntatore del mouse vicino all'inizio della sesta battuta, puntando allo spazio E
quello pitt in basso sul rigo:

0

LA TR

7

pre———

Completate il tutto inserendo il pattern di cassa e rullante nella battuta 6 usando la tastiera MIDI,

come gia visto precedentemente.

Per maggiori informazioni sulle voci, consultaretd 3.15 Voci nel Manuale Operativo.



3.3 Idee e notazione di batteria

Cambiare le teste nota
Considerato che quando vengono inserite note in un rigo di percussioni usando I'inserimento alfabetico
Sibelius non cambiera automaticamente le teste di nota per noi, apprenderemo come effettuare
loperazione manualmente inserendo lo stesso pattern nella battuta 7, questa volta pero usando la
tastiera del computer:
« Selezionate la battuta di pausa nella battuta 7 e premete N per iniziare I'inserimento delle note.
« Premete 3 sul keypad per scegliere una nota da 1/8 (croma).
« Premete G sulla tastiera del vostro computer; assicuratevi venga collocato sopra il rigo.
« Inserite altre tre note da 1/8 premendo R.
« Premete 2 sul keypad per scegliere una nota da 1/16 (semicroma).
« Premete due volte G sulla tastiera del vostro computer per inserire due note da 1/16.

Adesso che avete inserito le note di charleston continuate con il pattern di cassa e rullante nella voce 2:

[

Sibelius permette di filtrare una selezione, che significa poter selezionare una serie di oggetti con
particolari caratteristiche comuni. Lo si provi ora:

« Selezionate la battuta 7 in modo che l'intera battuta sia evidenziata in blu.

+ Selezionate Home» Seleziona» Filtri e trovate la Voce 1 nella categoria Voci (scorciatoia
Ctrl+Maiusc+Alt+1 0 o~31).

« Sibelius effettua una selezione multipla delle sole note che usano la voce 1, ovvero le note di charleston.

In questo modo qualsiasi modifica apportata verra applicata solo alle note selezionate nella voce 1.
Quindi cambiamo la testa della nota:

- Cambiate la testa della nota facendo clic sulla parte superiore del pulsante Notazioni » Teste
delle note » Tipo (scorciatoia Maiusc+Alt+1 0 ¢~1).

« Tutte le note adesso cambieranno in modo da visualizzare una testa di nota a croce:

0

Se volete usare un tipo di testa della nota differente potete aprire la galleria Teste delle note facendo
clic sulla parte inferiore del pulsante Notazioni » Teste delle note » Tipo .

Per maggiori informazioni sulle teste nota, LJ 4.12 Teste di nota nel Manuale Operativo.

Catturare un’idea
Proviamo adesso a creare una nuova idea. Il processo di inserimento di un’idea allinterno del pannello
Idee viene chiamato catturare un’idea:

« selezionare la battuta 7, in modo che si circondi di un box blu.

« Selezionate Home » Appunti» Cattura idea (scorciatoia Maiusc-1), oppure fate clic sul pulsante
Cattura idea (X" ) in fondo al pannello Idee.

La musica selezionata apparira immediatamente in cima allelenco nel pannello Idee, in modo che
possiate usarla di nuovo in seguito.
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Modificare un’idea

Si pud modificare sia la musica sia le etichette di un’idea.

Per una prova di come modificare le tag, selezionate I'idea appena catturata nel pannello Idee, quindi
cliccate sul pulsante Modifica info idea ( @ ) nella parte inferiore del pannello (o clic destro (Windows)
o Control-clic (Mac) su ur’idea nellelenco e scegliere Modifica info idea dal menu contestuale).
Viene visualizzata una semplice finestra di dialogo:

« Date qui un nuovo Nome alla vostra idea; digitate Urbane Funky Drums 1.

+ Potete anche inserire dei tag nella casella Tag: non ci sono limiti a quello che potete scrivere, quindi
usate tutte le parole che vi servono per aiutarvi a ritrovare la vostra idea in un secondo momento.

« Fate clic su Colore per mostrare una tavolozza da cui scegliere un nuovo colore di fondo per la
vostra idea. Inoltre potrete usare il colore per organizzare le vostre idee e rendere pil semplice la
loro individuazione in seguito.

« Una volta soddisfatti cliccare su OK per chiudere il riquadro Modifica info idea.

Per modificare la musica in un’idea, selezionarla nel pannello Idee e quindi cliccare sul pulsante
Modifica Idea () nella parte inferiore del pannello (o scegliere Modifica Idea dal menu contestuale).
Apparira una nuova scheda documento. Potrete modificarla come qualsiasi altra partitura, ad esempio
aggiungendo o cancellando note e battute, inserendo testo, linee e altri segni, e cosi via. Quando avete
finito di modificare la vostra idea, salvatela selezionando File» Salva (scorciatoia Ctrl+S o0 #S),
quindi selezionate la scheda facendo clic sulla croce a destra del nome della scheda oppure scrivete
Ctrl+W o W) per tornare alla partitura originale.

Per ignorare tutte le modifiche non salvate nell'idea, chiudete la scheda e fate clic su No quando
Sibelius chiede se si desidera salvare le modifiche eseguite.

Se aprite una delle idee della libreria per modificarle, si aprira una nuova finestra di Sibelius, invece di
aprirsi nuove schede documento nel pannello esistente. Questo perché Sibelius tiene insieme diverse
visualizzazioni della stessa partitura come schede (versioni salvate, parti dinamiche e idee della partitura)
e usa finestre diverse per partiture diverse: in questo caso, idee della libreria.

Abbiamo appena fatto un accenno a quello che ¢ possibile fare con le idee. Non dimenticate quindi -
3 2.3 Idee nel Manuale Operativo.

Battute di ripetizione
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Spesso le parti di batteria e percussioni sono composte da pattern di una o due battute che si ripetono
lungo il brano. Invece che copiare la stessa battuta numerose volte gli arrangiatori spesso inseriscono un
simbolo battuta di ripetizione. Cio avverte il musicista di suonare esattamente lo stesso pattern
della battuta precedente. Sibelius ¢ in grado di interpretare e riprodurre le battute di ripetizione come
farebbe un musicista reale.

Proviamo ad aggiungere una parte di tamburello alla partitura, in modo da apprendere come funzionano
le battute di ripetizione:

+ Selezionate Home » Strumenti» Aggiungi o rimuovi, o premete la scorciatoia I.

« Trovate Tamburello nella famiglia Percussioni e batteria family.

« Fate clic su Aggiungi alla partitura.



3.3 Idee e notazione di batteria

« Selezionate Tamburello dallelenco Righi nella partitura e usate il pulsante Gili per riordinarlo,
in modo che appaia tra Drum Set (Rock) e Sintetizzatore (a).

« Fate clic su OK per tornare alla partitura.

A questo punto Sibelius vi proporra di cambiare le dimensioni della musica per adattarla meglio alla
pagina (ora che ci sono pil strumenti). Fate clic su No, dopotutto un tamburello non occupa tanto
spazio!

A questo punto dovreste poter vedere che un rigo di percussioni ¢é stato aggiunto alla vostra partitura,
pronto per permettervi di scrivere una parte di batteria. Successivamente cliccate sul pulsante
Partitura nel pannello Idee e individuate 'idea Urbane Tambourine 1 nellelenco. Copiate e incollate
questa idea nella battuta 9.

Per aggiungere un simbolo di battuta di ripetizione selezionate la battuta 10 del rigo di tamburello e
premete F11 per visualizzare il quinto layout del keypad. Adesso premete 1 (sul keypad) per aggiungere
una battuta di ripetizione singola. Continuate a premere 1 fino ad arrivare alla battuta 16.

Da notare che & possibile anche inserire battute di ripetizione di 2 o0 4 battute, sempre accedendo al
quinto layout del keypad. Sibelius riprodurra tutti questi differenti tipi di ripetizione.

Per maggiori informazioni sulle battute di ripetizione, [0 4.25 Battute di ripetizione nel Manuale
Operativo.

Terminare le parti di percussione

Inserire il resto della musica nelle parti Drum Set e Tamburello, facendo riferimento alla stampa
creata precedentemente. Usate il pannello Idee, le battute di ripetizione e voci multiple per aiutarvi
a terminare I'inserimento delle parti di percussione.
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3.4 Simboli accordo

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e
che la versione 4 Simboli accordo sia la Versione corrente, selezionando Revisione » Versioni »
Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

In Sibelius, un simbolo accordo ¢ costituito da due parti che descrivono I'armonia a quel punto specifico
della musica: testo accordo e diagramma accordo. I diagrammi accordo mostrano al musicista la
posizione delle dita sui tasti sulle corde della chitarra; vengono anche chiamati riquadri accordo,
riquadri tastiera chitarra, riquadri chitarra e cosi via.

Potete inserire i simboli accordo in due modi: digitandoli direttamente nella partitura, oppure suonando le
note che descrivono tramite un dispositivo MIDI. Potrete poi scegliere se mostrare solo una o entrambe
le parti del simbolo accordo.

In questo capitolo apprenderemo ad inserire e modificare i simboli accordo digitandoli, a suonare
e modificare 'inserimento dei simboli accordo via MIDI e a impiegare alcuni plug-in dedicati ai
simboli accordo. Per maggiori informazioni sui simboli accordo, 0J 5.8 Simboli accordo nel
Manuale Operativo.

Creazione di simboli accordo tramite digitazione
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Sibelius vi permette di inserire facilmente simboli accordo nella vostra partitura tramite digitazione.

« Cliccare sulla nota o accordo sopra cui si desidera inserire il simbolo accordo — ad esempio,
selezionare la prima battuta completa del rigo Piano Elettrico Palco.

« Selezionate Testo » Simboli accordo » Simbolo accordo (comando rapido Ctrl+K o #K).

« Un cursore lampeggiante appare sopra la nota selezionata.

- Digitare la versione inglese normale dellaccordo desidera; Sibelius creera automaticamente qualsiasi
simbolo speciale necessario per una chiara e corretta visualizzazione dei simboli accordo. Provate a
digitare Ab13 (#11).

« Premete Spazio per avanzare alla nota o0 movimento successivo, o Tab per spostarsi all'inizio della

battuta successiva.

Sibelius crea il simbolo accordo appropriato, usando speciali diesis e bemolle cosi come altri caratteri
speciali; in questo caso dovreste poter vedere API3 (1D,

Detto questo, il modo pili rapido per inserire simboli di accordo ¢ suonarli su un dispositivo MIDI
e lasciare che Sibelius li riconosca per noi.



3.4 Simboli accordo

Creazione di simboli accordo tramite esecuzione

Sibelius ¢ in grado di riconoscere oltre 750 tipi di accordo attraverso le note che li compongono,
per cui potrete usare la vostra tastiera MIDI (o chitarra) per inserire rapidamente simboli accordo
in una partitura.

(Dovrete avere un dispositivo MIDI collegato al vostro computer in modo da poter suonare gli accordi
all'interno di Sibelius. Se non si dispone di un dispositivo MIDI collegato, digitare semplicemente i
simboli accordo nella partitura, come visto in precedenza).

Si provi a farlo:

« Selezionate la terza battuta completa del rigo Piano Elettrico Palco.
« Selezionate Testo » Simboli accordo » Simbolo accordo.

« Un cursore lampeggiante appare sopra la prima nota.

« Suonate un accordo di C maggiore sulla vostra tastiera MIDL.

« Sibelius inserisce un simbolo accordo C e avanza al movimento successivo.

Potrete suonare un'ampia gamma di accordi — da semplici triadi a accordi estesi estremamente complessi —
Sibelius li trascrivera in modo intelligente usando i piti adeguati simboli accordo. Si provi a suonare varie
combinazioni di note sulla tastiera MIDI per vedere come vengono trascritte.

Per impostazione predefinita, Sibelius usa le voci dell'accordo suonato per determinare non solo il tipo
di accordo, ma anche il modo specifico in cui viene trascritto; ad esempio, se si suona I'accordo in
uno dei suoi rivolti, Sibelius produrra un simbolo dell'accordo con una nota di basso alterata, ad esempio,
D/F#. Per ulteriori dettagli su come personalizzare il riconoscimento accordi di Sibelius, consultare
[J 5.9 Modifica simboli accordo nel Manuale Operativo.
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Mantenendo premuto Ctrl 0 38, selezionate i simboli accordo appena creati e cancellateli, o usate Annulla
per rimuoverli dalla partitura. Adesso proveremo ad inserire i simboli accordo per gli accordi impiegati

in Urbane Filigree. Visto che si tratta di accordi particolarmente complessi, queste sono le note che

dovrete suonare per ottenere i simboli accordo corrispondenti:
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Terminate aggiungendo i simboli accordo alla partitura, facendo riferimento alla stampa creata
precedentemente. Potrete suonarli sulla vostra tastiera MIDI o digitare i nomi degli accordi, in

base alle vostre preferenze.



3.4 Simboli accordo

Creare simboli accordo da altezze esistenti
Allo stesso modo, Sibelius riconosce I'armonia delle note e degli accordi esistenti analizzandoli. Ogni
volta che fate una selezione che contiene note, la barra di stato in fondo alla finestra mostra le altezze
delle note selezionate (o la prima nota o accordo di un passaggio se avete selezionato un range di musica).
Mostra inoltre 'armonia dell'accordo composto dalle note selezionate all'inizio della selezione,
disposta su pili righi se necessario, mostrata come simbolo accordo.

Provatelo ora:

« Selezionate la prima nota nella battuta 9 nel rigo Chitarra basso a 5 corde.

« Tenete premuto Maiusc e selezionate il primo accordo della battuta nella parte Chitarra elettrica
(viene selezionato anche tutto cio che ¢ presente nel rigo Piano Elettrico).

« Tl valore Armonia nella barra di stato in fondo alla finestra dovrebbe essere BPm.

Potete utilizzare la stessa analisi per aggiungere simboli accordo alla vostra partitura selezionando
un passaggio e scegliendo Testo» Simboli accordo» Aggiungi da note, che apre un riquadro
che vi permette di scegliere diverse opzioni relative alla frequenza e la posizione dei simboli accordo
calcolate dalle note della selezione.

Testo accordo equivalente
Sebbene Sibelius scelga automaticamente il miglior simbolo accordo per un determinato gruppo
di altezze, puo accadere che vogliate usare un tipo di accordo diverso. Per vedere altre possibilita
relative allo stesso pattern di intervalli, selezionate il simbolo (o i simboli) accordo del quale volete
cambiare il tipo di accordo, quindi selezionate Testo » Simboli accordo » Testo accordo equivalente
(comando rapido Ctrl+Maiusc+K o ©#K), oppure fate clic con il tasto destro (Windows) o Control-clic
(Mac) e selezionate Testo accordo equivalente dal sottomenu Simbolo accordo.

Per esempio, per cambiare G#7in AP, vedere Rinominare un simbolo accordo, in seguito.
Facciamo una prova:

« Selezionare Paccordo AP13(¥1D nella prima battuta del rigo Piano Elettrico Palco.

- Digitare Ctrl+Maiusc+K o & 3K per passare al testo accordo equivalente successivo.
» Iltipo di accordo diventa D7(E§)/ GH.

- Digitare Ctrl+Maiusc+K o & 3K per passare al simbolo accordo successivo.

« Iltipo di accordo diventa Ab7(#11add13),

« Continuate a cambiare il testo accordo nello stesso modo fino a tornare nuovamente al AP13(41),

Cosi facendo potrete cambiare rapidamente testo accordo di un simbolo accordo, nel caso che Sibelius
non abbia scelto il testo desiderato, o se le voci che avevate suonato suggerivano un tipo di accordo
differente.

Adesso controllate che tutti gli accordi inseriti siano stati trascritti correttamente; se ce ne fosse bisogno
cambiateli digitando Ctrl+Maiusc+K o K. Per modificare un simbolo accordo esistente dovrete
semplicemente fare doppio clic su di esso, o selezionare il simbolo da cambiare e premere Invio
(sulla tastiera principale) per modificarlo. A questo punto suonatelo di nuovo sul vostro dispositivo
MIDI e digitatene il testo corretto in normale inglese.
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Rinominare un simbolo accordo

Sibelius effettua lo "spelling” di un accordo in base alla tonalita dominante, ma vi ritroverete in situazioni
in cui vorrete cambiare la tonica di un simbolo accordo per il suo equivalente enarmonico senza
cambiare il tipo di accordo. Si osservi come funziona:

« Selezionare il simbolo accordo da rinominare.

« Selezionate Testo »Simboli accordo » Rinomina testo accordo.

« La tonica del simbolo accordo (e qualsiasi nota di basso alternativa, nel caso di accordo barra)
verra rinominata usando lequivalente enarmonico.

Copiare simboli accordo

Abbiamo visto come i simboli accordo appaiono sul rigo di tastiera, ma quando copiamo un simbolo
accordo ad altri strumenti, Sibelius determinera se mostrare un diagramma accordo o meno, e li
aggiornera automaticamente per mostrare la corretta trasposizione sulla partitura trasportata.

Si provi a copiare i simboli accordo appena inseriti:

+ Fare triplo clic sul rigo superiore del Piano Elettrico Palco in modo da selezionarlo per Iintera partitura.

+ Selezionate Home» Seleziona » Filtri e trovate Simboli accordo nella categoria Testo per selezionare
unicamente i simboli accordo.

« Copiare i simboli accordo al rigo di chitarra usando Alt+click o ~=-clic allinizio della prima battuta
completa del rigo di Chitarra Elettrica.

« Copiare i simboli accordo al rigo di basso usando Alt+click o~ -clic all'inizio della prima battuta
completa del rigo di Basso Elettrico 4-corde.

Da notare che ¢ possibile effettuare copia multipla dei simboli accordo su qualsiasi numero di righi;
semplicemente copiate negli appunti i simboli accordo da duplicare usando Ctrl+C o #C, quindi
selezionate i righi su cui li volete copiare e premete Ctrl+V o V.

Riassegnazione delle voci dei diagrammi accordo
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Sibelius assegna automaticamente un diagramma accordo a ogni simbolo accordo che appare sul
rigo di chitarra. Si tratta di diagrammi provenienti dalla selezione interna per chitarra a sei corde in
accordatura standard — scelti in base alla facilita di esecuzione — o calcolati automaticamente secondo le
note che compongono l'accordo. Cio significa che anche se usate accordature speciali, Sibelius vi offrira
comunque urampia selezione di possibili diteggiature per quel particolare tipo di accordo.

Potete inoltre cambiare il diagramma accordo che Sibelius sceglie di default - esattamente come ¢
possibile cambiare il simbolo accordo di default che Sibelius sceglie quando suonate un dispositivo MIDL
Per farlo, selezionate il simbolo (o i simboli) accordo del quale volete cambiare il diagramma e
selezionate Testo »Simboli» Riassegnazione delle voci del diagramma accordo (comando
rapido Ctrl+Maiusc+Alt+K o &~3K), oppure fate clic con il tasto destro (Windows) o Control-
click (Mac) e selezionate Riassegnazione delle voci del diagramma accordo dal sottomenu
Simbolo accordo.



3.4 Simboli accordo

Facciamo una prova:

« selezionare accordo AP3(#1D nella prima battuta del rigo Chitarra Elettrica.

« premere Ctri+Maiusc+Alt+K o o~3K per riassegnare le voci del diagramma accordo visualizzato —
provatelo varie volte per vedere le combinazioni di voci che Sibelius ¢ in grado di generare.

Per maggiori dettagli su come determinare il tipo di accordo o diagramma accordo che Sibelius dovrebbe
mostrare di default e su come cambiare laspetto dei simboli accordo, consultare £J 5.8 Simboli
accordo e (1 5.9 Modifica simboli accordo nel Manuale Operativo.

Plug-in simboli accordo

Sibelius dispone di alcuni plug-in molto utili per aiutarvi a lavorare con i simboli accordo. Potete trovarli
nella categoria Simboli accordo della galleria Plug-in in fondo alla scheda Testo del nastro.

Per aggiungere semplici accompagnamenti da simboli accordo esistenti provate con Plug-in»
Simboli accordo » Svolgi simboli accordo. Questo plug-in usa i simboli accordo della vostra
partitura per creare un accompagnamento di piano o chitarra secondo diversi stili di accompagnamento.
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3.5 Ripetizioni e coda

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e che
la versione 5 Strutture ripetute e coda sia la Versione corrente, selezionando Revisione » Versioni »
Modifica versioni, selezionando questa versione nell'elenco e facendo clic su Rendi corrente.

Questo capitolo vi mostrera come cambiare la forma della vostra musica usando stanghette di ripetizione,
1° e 2° finale e coda. Durante la riproduzione delle vostre partiture Sibelius sara in grado di interpretare
tutte queste comuni strutture di ripetizione - esattamente come farebbe un musicista.

Stanghette di ripetizione

Si ripeteranno le prime quattro battute del pezzo, usando stanghette di ripetizione. Si iniziera aggiungendo
una stanghetta di ripetizione alla fine della sezione ripetuta:

Fate clic sulla stanghetta alla fine della battuta 4; diventera viola ad indicare che ¢ stata selezionata.

Aprite la galleria Notazioni» Comuni» Stanghette.
« Selezionate Fine ripetizione dall'elenco.

« La stanghetta cambia immediatamente in una stanghetta di ripetizione, ad indicare la fine di una
sezione ripetuta.

In questo contesto la stanghetta di ripetizione indica al musicista di tornare allinizio della partitura e
ripetere da li, includendo anche la battuta d’attacco (upbeat). Per contrassegnare I'inizio di una
sezione ripetuta dovremo creare un’altra stanghetta di ripetizione:

« Selezionate Inizio riproduzione dalla galleria Notazioni» Comuni» Stanghetta.

Il puntatore del mouse diventa blu scuro, per indicare che sta "portando” un oggetto.

Fate clic sulla stanghetta all'inizio della prima battuta completa per inserire li la stanghetta di
inizio ripetizione.
+ Premete Esc per deselezionare tutto, quindi P per avviare la riproduzione dall'inizio della partitura.

Sibelius adesso riprodurra fino alla battuta 4, quindi tornera di nuovo alla battuta 1 per poi continuare
lungo il resto della partitura.

Linee di 1° e 2° finale
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Per sezioni ripetute pitt complesse compositori e arrangiatori usano linee di 1° e 2° finale, riprodotte
soltanto al primo o secondo passaggio nella sezione ripetuta. In Sibelius le linee di 1° e 2° finale sono
linee di sistema — funzionano nello stesso modo delle linee di tempo che abbiamo gia usato nel
Progetto 2.

Si provi a creare una ripetizione con linee di 1° e 2° finale; si dovra inserire una battuta che funzionera
come finale per il primo passaggio attraverso la sezione di ripetizione.

« Cominciamo selezionando la stanghetta di fine ripetizione aggiunta in precedenza e premendo
Cancella cosi da rimuoverla.

e Ctrl+clic 0 #-clic sulla battuta 4 su qualsiasi rigo eseguira una selezione di sistema — apparira
un doppio box color porpora intorno a tutti i righi.

« Digitate Ctrl+C o0 #C per copiare la musica per tutti gli strumenti di quella battuta.
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« Selezionare la battuta 8 del rigo Trombe in Bb, che useremo come finale per il secondo passaggio
della nostra struttura di ripetizione.

Incolla (comando rapido Ctrl+V o V) per incollare nella partitura la battuta copiata. La nuova
battuta viene inserita tra le misure esistenti, diventando di conseguenza la battuta 8.

Con questa battuta ancora selezionata premete L per aprire la galleria Notazioni» Linee» Linea .

« Selezionate la linea di 1° finale dalla categoria Comuni per aggiungere la linea alla battuta 8:

i~

1

R
R~
Y
N
N
f

La linea viene aggiunta in cima alla partitura, essendo una linea di accollatura, ma apparira sopra
la battuta 8 in ogni parte individuale. Ora si aggiunga la linea di fine ripetizione e la linea di 2° finale
per completare la struttura di ripetizione:

« Fate clic sulla stanghetta alla fine della battuta 8; diventera color porpora ad indicare che ¢ stata
selezionata.

+ Selezionate Fine riproduzione dalla galleria Notazioni» Comuni» Stanghetta.

« Lastanghetta cambia immediatamente in una stanghetta di ripetizione.

+ Selezionare la battuta 9 del rigo Trombe in Bb

« Premete L per aprire la galleria Notazioni» Linee » Linea.

« Selezionate la linea 2° finale dalla categoria Comuni per aggiungere la linea alla battuta 8.

Potreste voler accorciare le linee in modo che non si sovrappongano, per far cio ¢ possibile fare clic
su uno dei punti di fine e trascinarli con il mouse, o usando i tasti ¢ e > (non dimenticate che ¢ anche
possibile usare Ctrl 03 per spostamenti pit1 ampi):

-3
I 12 -.n.b"'n. >
< CEoE e e hF £
: - ] A I I LI
= e o ot Y —
S ba: o —
hﬁ—bﬁ ep't o g o >
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Ripetizioni coda e dal segno (D.S.)
Ora si crei una semplice ripetizione coda e "dal segno” (D.S.); si cambieranno le battute 22-25 in una
sezione coda:

Selezionare la stanghetta all'inizio della battuta 22.

Selezionate Doppia dalla galleria Notazioni» Comuni» Stanghetta per aggiungere una doppia
stanghetta che indica la fine di una sezione.

Selezionate Layout» Interruzioni» Dividi accollatura per creare un vuoto dopo la doppia stanghetta.
Notate come Sibelius ripete automaticamente le chiavi, tonalita e le parentesi quadre.

Selezionare la pausa all'inizio della battuta 22 del rigo Trombe in Bb.

Selezionate Tempo dalla categoria Comuni della galleria Testo » Stili » Stile.

Con un clic destro (Windows) o Control-clic (Mac) visualizzeremo il menu contestuale.
Selezionare il primo dei due segni coda () dalla lista di parole e simboli suggeriti.

Immettere la parola Coda e premere Esc.

Ora si aggiunga la ripetizione dal segno. Faremo in modo che quando il musicista raggiunga la fine della

misura 21 dovra tornare alla battuta 1:

Selezionare la doppia stanghetta alla fine della battuta 21.

Selezionate Ripeti testo (D.C./D.S./A Coda) dalla categoria Comuni di Testo » Stili» Stile.
Con un clic destro (Windows) o Control-clic (Mac) visualizzeremo il menu contestuale
Selezionare D.S. al Coda dalla lista di parole e simboli suggeriti.

Premere Esc per annullare la selezione.

Ctrl+clic 0 #-clic su qualsiasi rigo alla battuta 1 eseguira una selezione di sistema — apparira un
doppio box color porpora intorno a tutti i righi.

Premete Z per aprire la galleria Notazioni» Simboli» Simbolo.
Selezionate Segno (%) dalla categoria Comune per creare un simbolo nella partitura.

Trascinate il simbolo sopra il rigo ad una posizione appropriata alla fine della battuta. (La differenza
traisimboli e altri oggetti & che i primi possono essere collocati ovunque si desideri, permettendovi di
ignorare le regole di posizionamento di Sibelius).

Infine aggiungiamo l'istruzione "Al Coda". Faremo in modo che quando il musicista raggiunga la fine

della battuta 4 dovra tornare alla battuta 1:

Selezionate la stanghetta all'inizio della battuta 4.

Selezionate Ripeti testo (D.C./D.S./A Coda) dalla categoria Comuni di Testo » Stili» Stile.
Con un clic destro (Windows) o Control-clic (Mac) visualizzeremo il menu contestuale
Selezionare D.S. al Coda dalla lista di parole e simboli suggeriti.

Premere Esc per annullare la selezione.

Se adesso riprodurrete la partitura, Sibelius rispettera le ripetizioni appena inserite. Per maggiori

informazioni sulle strutture di ripetizione, consultare [ 6.9 Ripetizioni nel Manuale Operativo.
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3.6 Arrangiamento e riproduzione

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e che
la versione 6 Arrangiamento e riproduzione sia la Versione corrente, selezionando Revisione »
Versioni» Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

In questo capitolo tratteremo uno degli strumenti di arrangiamento piu utili di Sibelius: la funzione
Arrange, che potete usare automaticamente per riarrangiare la musica per diversi strumenti. Vedremo
inoltre come cambiare i suoni che Sibelius usa per la riproduzione, come aggiungere effetti e come
creare un file audio della vostra partitura.

Aggiungere un accompagnamento d’archi
Useremo la parte di Sintetizzatore della partitura Urbane Filigree per creare un semplice accompagnamento
d’archi.
« Aggiungete una parte d'archi alla partitura selezionando Home» Strumenti» Aggiungi o rimuovi
(comando rapido I).

« Cliccate su Violino 1 nella categoria Archi per selezionarlo, quindi tenete premuto Ctrl 03 per
selezionare Violino 2, Viola e Violoncello.

« Cliccate su Aggiungi alla partitura per inserire tutti gli strumenti selezionati nella partitura.
* Cliccare su OK per tornare alla partitura.

« A questo punto Sibelius vi chiedera se volete cambiare le dimensioni della musica per riempire meglio
la pagina (ora che ci sono piu strumenti); fate clic su No perché presto elimineremo i righi di
Sintetizzatore.

La funzione Arrange di Sibelius ¢ pensata come un aiuto extra durante il lavoro di arrangiamento e
orchestrazione, e puo farvi risparmiare molto tempo. Ne apprezzerete subito le potenzialita durante
la scrittura di qualsiasi tipo di musica:

« Cliccate su uno spazio vuoto nella battuta 10 del rigo superiore di Sintetizzatore, in modo da selezionarlo.

« Adesso fate Maiusc-clic sull'ultima battuta dell'altro rigo di Sintetizzatore, cosi che entrambi i righi
di Sintetizzatore vengano racchiusi in un singolo riquadro di color azzurro chiaro.

- Digitate Ctrl+C 03 C per copiare la musica negli appunti.
« Selezionate la battuta 10 del rigo Violino 1 facendo clic su uno spazio vuoto del rigo.

+ Maiusc-clic sulla battuta 10 del rigo Violoncello per selezionare contemporaneamente tutti i righi
di archi.

« Fate clic sulla parte superiore del pulsante Inserimento nota» Arrange » Arrange (comando rapido
Ctrl+Maiusc+V 0 ¢ V).

« Dalla finestra di dialogo che appare selezionare Arrangiamento Standard e fare clic su OK.
Sibelius arrangia la musica sui righi di archi, dividendola intelligentemente tra gli strumenti.

Arrange copia in modo intelligente la musica da un qualsiasi numero di righi a un qualsiasi altro
numero di righi. Si puo impiegare per riduzioni di piano e per "distribuire” gli accordi su piu righi.
Lazione piti importante di questa sofisticata funzione, tuttavia, ¢ aiutare l'utente ad arrangiare e
orchestrare un'ampia gamma di stili e complessi musicali.

Per maggiori dettagli, consultare (1 3.16 Arrange nel Manuale Operativo.
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Mixare la partitura

98

Come gia visto nel Progetto 1, il pannello Mixer ¢ un potente strumento per controllare il modo
in cui Sibelius riproduce le vostre partiture. Qui potrete cambiare i suoni usati per riprodurre ciascuno
strumento della partitura, aggiungere effetti come riverbero e chorus, modificare parametri specifici per
regolare il suono di ciascuno strumento e bilanciare il mix generale.

Prima di tutto useremo il Mixer per silenziare i righi di Sintetizzatore, visto che non sono pit1 necessari
in virtl del nuovo arrangiamento con sezione d’archi.

* Premere M per aprire la finestra Mixer, nel caso che non sia gia visibile.

« Trovate le strisce rigo Sintetizzatore (a) e Sintetizzatore (b).

» Fate clic sul pulsante Tacita (I ) a meta di ogni striscia per tacitare parzialmente i righi (se non vedete
il pulsante Tacita, assicuratevi che il pannello mixer sia a dimensioni intere).

« Fateci clic nuovamente per tacitarli del tutto.

1 H [0 [0 =

Si provi ora a riprodurre la partitura. Dovreste poter sentire che le parti di archi hanno sostituito il suono
di Sintetizzatore.

Regolate il volume delle strisce rigo per bilanciare le parti degli archi. Se desiderate cambiare il volume
dellintera sezione d’archi attivate le strisce gruppo a destra del pannello Mixer. Verranno mostrate
le strisce gruppo per ciascuna famiglia di strumenti presenti nella vostra partitura. Attraverso di esse
potrete cambiare il volume e pan relativi dellintera famiglia.

Se non vedete le strisce gruppo, attivatele facendo clic sul pulsante Mostra/nascondi gruppi (&)
sulla sinistra del pannello mixer.
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Modifica dei suoni degli strumenti
Potete scegliere quali tra i suoni disponibili sul vostro computer Sibelius dovra usare per riprodurre
ciascuno strumento. Si provi a cambiare i suoni degli archi in modo da usarli come strumenti solisti,
invece che all'interno di un complesso; si conferira cosi alla partitura un tocco pitt intimo e raccolto:

« Assicuratevi che il pannello mixer sia a dimensioni intere.
« Trovate la striscia rigo Violino 1.

« Assicuratevi che il valore centrale verso la cima della striscia sia (S. Play), il dispositivo di riproduzione
Sibelius Player.

+ Cliccate sulla freccia accanto al campo che al momento mostra (Violini).
« Appare un menu, con i dispositivi di riproduzione che Sibelius puo usare; useremo Sibelius 7 Sounds.
« Selezionate Sibelius 7 Sounds» Archi» Violino» Violino 1 Solo per passare a un suono di violino solo:

| | s o viunns narmonies |

Ay = Dy PR W'{ Violins marcato ‘
3 | violins con sordino

Violins non vibrate

Violins ricochet

Violins staccato up+down bow

Violins sul ponticello

Violins sul tasto

Violins tenuto up+down bow

Violins remolo

Violins tremolo accent

Violins tremolo sul ponticello

Violins halftone trill

Violins wheletone trill

Violins molte vibrato

Keyhoard Violins bartok pizzicato

Pitched Percussion Violins pizzicato

oy 1) Violins chamber

Wind Violins chamber legato

Violins chamber con sordino

Violins chamber non vibrato

Violins chamber staccato up+down bow

Violins chamber tenuto up+down bow

Violins chamber tremolo

Violins chamber tremolo accent

Violins chamber pizzicato

Violin 1 sclo

Vieolin 1 solo marcato

Violin 1 solo pizzicato

Violin 1 solo staccato up+down bow

Vielin 1 sclo tremolo

Violin 2 solo

Violin 2 solo marcato

Violin 2 solo pizzicate

| Violin 2 solo staccato un+down bow

Brass

Violoncello
Contrabass
String Orchestra

Adesso cambiate le righe Violino 2, Viola e Violoncello nello stesso modo, in modo che usino
rispettivamente i suoni Violino 2 Solo, Viola 1 Solo ¢ Violoncello 1 Solo.

Provare a riprodurre di nuovo la partitura per sentire la differenza - & opportuno bilanciare di nuovo il
mix con i nuovi suoni.
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Parametri degli effetti
Ciascun suono di strumento dispone di un massimo di sei parametri effetto, controllati dalle manopole
situate a destra della striscia rigo. Se uno strumento ha parametri extra, apparira un pulsante a freccia
(E3) in fondo alla striscia rigo. Fate clic su questo pulsante per espandere i parametri degli effetti.

Espandete tutte le strisce rigo della finestra Mixer usando Maiusc-clic su uno dei pulsanti freccia.

Provate a regolare le manopole per cambiare i diversi effetti e ascoltate i cambiamenti durante la
riproduzione di Sibelius. Se volete reimpostare le impostazioni predefinite di una manopola, fateci
clic due volte. (Potete farlo anche con le manopole del panning, i fader del volume e gli slider di riverbero
e chorus, il che & molto utile).

Per i dettagli completi su come usare il Mixer per cambiare la riproduzione di Sibelius,c2 6.3 Mixer
nel Manuale Operativo.

Eliminare uno strumento da una partitura
Ora che abbiamo aggiunto una parte d'archi, non abbiamo pi bisogno del Sintetizzatore nella nostra
partitura, quindi rimuoviamola. Ci sono due modi per rimuovere uno strumento dalla partitura:

« Fare clic tre volte sul rigo dello strumento per selezionarlo in tutta la partitura e premere Cancella
(molto comodo per rimuovere uno strumento su un solo rigo).

« Selezionare Home » Strumenti » Aggiungi o rimuovi e quindi selezionare tutti gli strumenti che
si vogliono rimuovere nell'elenco Righi nella partitura , in questo caso Sintetizzatore (a) e
Sintetizzatore (b). Fare clic su Elimina dalla partitura per rimuoverli e fare clic su Si quando
Sibelius vi chiede se volete veramente eliminarli. Fate clic su OK per tornare alla partitura.

Quest'ultimo metodo & molto pili utile per eliminare molti strumenti alla volta.
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Esportare un file audio
Quando si usano strumenti virtuali VST/AU, come Sibelius 7 Sounds, Sibelius permette di esportare la
partitura come file audio con un solo clic di un pulsante. Potrete usare i file audio per creare direttamente
un CD, o convertirli in altri formati, come MP3, in modo da poter passare le registrazioni a direttori o
musicisti per dar loro un'idea di come la musica suona, o anche solo per permettergli di far pratica
suonando sulla musica.

Proviamo a esportare il file audio di Urbane Filigree:

« Selezionate File » Esporta» Audio.

« Nel pannello Esporta audio assicuratevi che Esporta dall'inizio sia selezionato tra le opzioni
Linea di riproduzione.

« Fate clic sul pulsante Esporta.
+ Selezionate un nome per il vostro file audio e fate clic su Salva.
« Sibelius registrera la vostra partitura come file audio e lo salvera nella stessa cartella della partitura.

Per maggiori informazioni, consultare [ 1.11 Esportazione di file audio nel Manuale
Operativo.
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4.1 Impostare un quaderno di lavoro

Questo progetto vi mostrera come usare alcune tra le molte funzioni didattiche, utili nella creazione
di quaderni di lavoro e risorse per I'insegnamento, nonché come gestire l'uso di Sibelius in classe.

Il primo capitolo di questo progetto analizza I'impostazione da zero di un quaderno di lavoro all'interno
di Sibelius e come salvare il template per poterlo riutilizzare. Apprenderete a cambiare il font di testo
per lintera partitura e a modificare le proprieta di differenti tipi di testo.

Creatore Quaderno di Lavoro
La completa funzione Creatore Quaderno di Lavoro (£ 1.20 Creatore Quaderno di Lavoro
nel Manuale Operativo) produce automaticamente migliaia di differenti tipi di quaderni di lavoro,
esercizi, poster, schede e materiale di riferimento per studenti a tutti i livelli. Per questo, prima di
creare il vostro proprio quaderno di lavoro, verificate che Creatore Quaderno di Lavoro non ne abbia
gia uno pronto, o uno facilmente adattabile alle vostre esigenze.

Altrimenti, il Creatore Quaderni di Lavoro include una vasta gamma di template di quaderni in diversi
formati con battute vuote da riempire. Anche questo puo risparmiarvi parecchio tempo, quindi se un
template utilizzabile ¢ presente usatelo invece di creare un quaderno di lavoro totalmente da zero.

(Per accedere a questi template, selezionate File » Insegnamento, quindi fate clic sul pulsante Creatore
Quaderno di lavoro e nel riquadro che appare selezionate Template e fate clic su Successivo. Lelenco
di template di quaderni di lavoro disponibili appare sul lato sinistro; visto che creeremo il nostro proprio
quaderno di lavoro fate clic su Annulla).

Creare un quaderno di lavoro da zero
Se invece di usare uno dei template desiderate creare un quaderno di lavoro da zero, avrete bisogno
di una certa familiarita con gli strumenti di layout offerti da Sibelius, soprattutto come regolare la
spaziatura tra i righi e come creare interruzioni di accollatura o di pagina (ulteriori informazioni
su questi aspetti nel Progetto 2).

Useremo queste funzioni - e ne apprenderemo di nuove — per creare un template di un quaderno
dilavoro di esempio che aggiungeremo ai template di Creatore Quaderno di Lavoro.

Cominciamo impostando una nuova partitura:

« Selezionate File» Nuovo
« Apparira Avvio rapido , con la scheda Nuova partitura .
« Scegliere il foglio manoscritto Vuoto e fare clic su Cambia strumenti

+ Nel riquadro che appare, trovate Senza nome (rigo di violino) dallelenco di strumenti disponibili,
¢ nella categoria Altri.

« Fate clic su Aggiungi alla partitura e quindi su OK

« Fate clic su Crea per chiudere il riquadro Avvio rapido e creare una partitura
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Dovreste poter vedere questo:

PICIRE S senza nome 14 - Sibelius 7 =
Home  InserimentoNots  Notozioni  Testo  Riproduci  Layout  Aspetto  Parti  Revisione  Vista v sul nastro N7
= 4 Taglia T 2 Rigo Ossia == Dividi '/ Avanzato = Battute M Trova -
El 2 =] & | B m Y
B Copia ) _ v S £ Sopra o W nisci S Tutto == Passaggio Accollatura P Vaia~
Incolla Selezi Aggiungi Cambia Partitura Aggiungi  Elimina Filtri

a Mostrao  Colore | Propriets  Plug-ins
Catturaldea immagine o Elimina Trasposta T Sotto 8% Nessuno 4+ Ancora Nascondi~  ~  “vInverti E

Cartella Appunti Strumenti 5 Battute Seleziona Modifica Plug-ins
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s

Pagina1dil | Battute:5 | Messunaselezione | Altezza concerto o) O oof O [ 100.00% ©

Adesso inseriremo ulteriori battute e creeremo il layout di pagina iniziale:
« Fate clic sulla parte inferiore del pulsante Home » Battute » Aggiungi e selezionate Aggiungere
battute multiple o irregolari (comando rapido Alt+B o0 ~-B).

« Nella finestra di dialogo che appare sullo schermo impostate Numero di battute su 43 e quindi
fate clic su OK.

« Il puntatore del mouse diventa blu scuro, ad indicare che sta "portando un oggetto".
« Fate clic in un qualsiasi punto della partitura per aggiungere le nuove battute.

« Premere Esc per deselezionare tutto.

« Selezionate Layout» Interruzioni» Interruzioni automatiche.

« Nel riquadro che appare sullo schermo attivare Usa break di sistema automatico e scegliere
Ogni 4 battute.

« Fare click su OK e la vostra partitura dovrebbe aggiornarsi istantaneamente con i cambiamenti
appena apportati.

Prima di continuare con il nostro template ci sono un paio di regolazioni che dobbiamo fare:

« Nel gruppo Numerazione della scheda Testo del nastro selezionate Senza numeri battuta,
che fara si che i numeri di battuta non appaiano nel quaderno di lavoro.
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Ora apriremo la pagina Righi del riquadro Regole tipografia. Fate clic sul pulsante in Layout»
Spaziatura righi sulla destra. Cio aprira la finestra di dialogo Regole di tipografia, che
potrete usare per effettuare varie modifiche alle impostazioni della vostra partitura. Qualsiasi
modifica a nota o altro tipo di oggetto che effettuerete qui verra applicata ad ogni nota o oggetto
dello stesso tipo nella partitura:

(P

- Impostate Giustifica righi quando la pagina & almeno n% completa a 100%. Questo vi dara
controllo completo sul posizionamento verticale dei righi nell'impostazione dei vostri quaderni
di lavoro, perché evita che Sibelius usi automaticamente una spaziatura uniforme tra i righi man
mano che la pagina si riempie.

Dovreste disattivare la giustificazione verticale come avete fatto qui solo per la creazione di un quaderno
di lavoro, testo d'esame o0 qualsiasi altro tipo di eccezione: la giustificazione verticale & sempre consigliata
per qualsiasi altro tipo di partitura. Assicuratevi di leggere il consiglio in (1 7.3 Spaziatura
rigo nel Manuale Operativo.

Fate clic su OK per chiudere la finestra di dialogo Regole di tipografia.

Possiamo anche regolare la dimensione dei righi, in modo che tutte le battute entrino in un singolo
foglio A4:

« Cambiate il valore di Layout» Impostazioni documento» Dimensioni rigo a 6mm o 0,24 pollici,
come necessario.

Aggiungere un testo

Proviamo ad inserire un titolo ed uno spazio in cui lo studente dovra scrivere il proprio nome:

« Selezionate Titolo dalla categoria Comuni della galleria Testo » Stili» Stile.

« Il puntatore del mouse diventa blu, ad indicare che sta portando un oggetto.

« Fare clic in cima alla prima pagina e digitare "SCALE E ARPEGGI".

« Premete Esc due volte per interrompere l'immissione testo e deselezionare il tutto.

« Selezionate Sottotitolo dalla categoria Comuni della galleria.

« Fare clic in cima alla prima pagina e digitare "Quaderno di lavoro 1".

« Premete Esc due volte per interrompere l'immissione testo e deselezionare il tutto.

» Selezionate Intestazione quaderno di lavoro (prima pagina, r) dalla categoria Intestazioni e pié
di pagina della galleria (¢ I'ultimo stile di testo della categoria).

« Fate clic in cima alla prima pagina e scrivete: "Nome: " e premete Invio per iniziare
una nuova linea.

« Digitate "Classe:

« Premete Esc due volte per interrompere I'immissione testo e deselezionare il tutto.

Dovreste poter vedere questo:

Nome:
Classe:

SCALE E ARPEGGI

Quaderno di lavoro 1

CQ;’\D
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Modifica del font di testo

Adesso cambieremo il testo in questo quaderno di lavoro in modo da usare un font chiaro e leggibile.
Quando volete cambiare tutte le proprieta di tutto il testo di una partitura, modificate lo stile di testo
Testo normale. Tutti gli altri stili di testo prendono il font, le dimensioni, la posizione a altre caratteristiche
da questo stile:

« Fate clic sul pulsante in Testo » Stili » Stile, sulla destra. Cosi facendo aprirete il riquadro
Modifica Stili di Testo.

» Trovate Testo normale nell'elenco Stili e fate clic su Modifica.

l

+ Cambiate il font in Verdana selezionandolo dal menu a tendina e fate clic su OK e quindi su
Chiudi per tornare alla partitura.

Adesso il testo dovrebbe apparire cosi:

Nome:
Classe:

SCALE E ARPEGGI

Quaderno di lavoro 1

>

Modificare uno stile di testo
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Quando desiderate cambiare le proprieta di un certo tipo di testo & consigliabile modificare lo stile
di testo. Lo stile di testo determina il font, la dimensione, la posizione e altre caratteristiche di un
tipo di testo.

Nel quaderno di lavoro appena impostato modificheremo gli stili di testo per il Titolo e Sottotitolo,
in modo che il testo risulti allineato alla sinistra della pagina:

« Fate clic sul titolo per selezionarlo.

« Fate clic sul pulsante in Testo » Stili» Stile per aprire il riquadro Modifica stili di testo.

« Nellelenco di stili di testo disponibili, Titolo dovrebbe essere selezionato; fare clic su Modifica.
+ Nella pagina Pos Orizzontale scegliere Sinistra sotto Allinea alla pagina e fare clic su OK.

« Selezionare Sottotitolo dallelenco di stili di testo disponibili e fare clic su Modifica.

« Nella pagina Generale attivare Corsivo.

« Nella pagina Pos Orizzontale scegliere Sinistra sotto Allinea alla pagina e fare clic su OK.

« fare clic su Chiudi per tornare alla partitura:

Nome:
Classe:

SCALE E ARPEGGI

Quaderno di lavoro 1

N>
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Aggiungere ai template dei quaderni di lavoro
A questo punto aggiungeremo questa partitura agli altri template disponibili in Creatore Quaderno
di Lavoro. In questo modo la renderemo disponibile per usarla di nuovo in futuro, risparmiandoci
il tempo necessario per preparare il template.

« Selezionate File» Insegnamento e fate clic sul pulsante Aggiungi Quaderno di Lavoro.

« Scegliere Template dalle opzioni Tipo e dare al quaderno di lavoro un nome, per esempio Scale e
arpeggi.

« Se desiderate aggiungere qualsiasi altra informazione per facilitare I'individuazione di questo
template in futuro, inseritela nel riquadro Descrizione (per I'insegnante).

« Fare clic su OK per aggiungere il quaderno di lavoro allelenco dei template e ritornare alla partitura.

Creatore Quaderno di Lavoro per consultare la lista di template, il template Scale e arpeggi appena
creato apparira nellelenco.
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4.2 Scale e arpeggi

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 4 ¢
che la versione 2 Scale e arpeggi sia la Versione corrente, selezionando Revisiona» Versioni»
Modifica versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

In questo capitolo apprenderemo ad usare i plug-in per creare rapidamente set di scale dello stesso tipo,
pronte per essere usate in esercitazioni, revisioni e valutazioni. Analizzeremo come rinominare le
altezze nei loro equivalenti enarmonici, per esempio, cambiare G in Ab, e come re-inserire altezze
per modificare i tipi di scala; grazie a tutti questi strumenti sara possibile creare rapidamente e con
minimo sforzo una vasta gamma di spartiti contenenti scale.

Inserire scale

Useremo uno dei pit1 potenti plug-in di Sibelius per creare con pochi clic un foglio contenente scale in
tutte le tonalita, da usare come base per il quaderno di lavoro di esercizi che creeremo in questo progetto.
Aggiungiamo le scale maggiori in tutte le tonalita:

+ Selezionate Home» Plug-in» Plug-in» Altro» Scale e arpeggi.

« Nella finestra di dialogo che apparira assicuratevi di scegliere Aggiungi scale e arpeggi alla
partitura corrente, quindi fate clic su Successivo.

« Scegliere Scale maggiori dallelenco a tendina e fare clic su Successivo.

+ Una finestra di dialogo con numerose opzioni relative alle scale da aggiungere alla partitura apparira
sullo schermo; potrete scegliere tra scale ascendenti o discendenti, lestensione in ottave, la nota
di partenza, la durata delle note, e molto altro ancora.

* Assicuratevi che il Tipo di scala sia impostato su Maggiore e che lopzione Includi tonalita sia attivata.

« Scegliere Tutto tranne ottava dallelenco a tendina Numero di scale e arpeggi, e Cromatica
dallelenco Intervallo note iniziali. Questo inserira tutte le scale maggiori per ciascuna altezza
daCaB.

« Fare clic su Fine in modo che Sibelius inserisca le scale nella vostra partitura.
Dovreste poter vedere scale maggiori ascendenti e discendenti su due ottave, con un riquadro di testo

che identifica ogni scala. Sibelius inserisce automaticamente la tonalita prima di ogni scala e inizia
la scala successiva su un nuovo sistema.

Rinominare le alterazioni enarmoniche
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Potete passare istantaneamente a qualsiasi alterazione enarmonica semplicemente selezionando
una o pili note e premendo Invio (sulla tastiera principale). Proviamo a trasformare la scala di D# maggiore
in una di Eb maggiore:

« Selezionare le quattro battute di D maggiore.

+ Premere Invio per rinominare tutte le alterazioni.

« Premere Esc per deselezionare le note.
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La tonalita adesso non & piu corretta quindi dovremo cambiarla:

« Premete K per aprire la galleria Notazioni » Comuni » Tonalita.

« Selezionate Eb maggiore dalla categoria Maggiori bemolli.

« Il puntatore del mouse diventa blu.

« Cliccate all'inizio della prima battuta della nuova scala di Eb maggiore per inserire li la nuova tonalita.

« Fare doppio clic sulletichetta sopra il rigo (o selezionatela e premete Invio) per cambiare il testo
in Eb Maggiore:

__EbMa'or

0O J‘_ -of###gﬁ ﬁ#"_ [—
LT T e e P T e+
[ Fan W/ I | o el T T | . T I | T ] ¥ @& 4 I I
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Sibelius inserira un cambio di tonalita sul sistema precedente, ma visto che non sara necessario sul
nostro quaderno di lavoro lo nasconderemo:

» Selezionare il cambio di tonalita nellultima battuta del precedente sistema (dopo la doppia stanghetta);
diventera di color porpora a indicare che ¢ stato selezionato.

« Fate clic sulla parte superiore del pulsante Home » Modifica » Mostra o nascondi (comando rapido
Ctrl+Maiusc+H o ©#H) per nascondere i cambiamenti di tonalita.

« Per modificare la spaziatura tra le note e le doppie stanghette, selezionate Aspetto » Ripristina note »
Ripristina spaziatura note (comando rapido Ctrl+Maiusc+N o ©#N).

Per ulteriori informazioni su come nascondere e mostrare le note e altri oggetti, consultare
[J 2.10 Occultamento di oggetti nel Manuale Operativo.

Adesso provate a rinominare la scala di E4 maggiore in F maggiore (in seguito vorrete riportare di
nuovo le altezze Fb a E) e la scala di A$ maggiore in Bb maggiore, nascondendo i cambi di tonalita
nel modo appena visto. Non dimenticate di rinominare le etichette!

Cambiare una scala

Se volete cambiare un tipo di scala in un altro, esistono due facili modi per effettuare loperazione
allinterno di Sibelius. Potrete inserire di nuovo le altezze usando le stesse ritmiche, o usare un altro plug-in.

Notate come, dopo aver rinominato la scala di E4 maggiore, ci siamo ritrovati con due scale di F maggiore.
Proviamo a cambiare la seconda scala di F maggiore in una di F§ maggiore inserendo di nuovo le altezze:
« Prima di tutto, cambiate la tonalita a F4 maggiore, nascondendo il cambio di tonalita come gia visto.
» Selezionate la prima nota della scala, il F naturale.

« Selezionate Inserimento nota» Inserimento nota» Re-inserimento altezze (comando rapido
Ctrl+Maiusc+l 0 o &1).

+ Appare un cursore punteggiato (invece della normale linea continua); esso indica che Sibelius
sostituira le note esistenti ma non i loro ritmi.

- Suonate una scala ascendente e discendente di F4 maggiore su due ottave sulla vostra tastiera MIDI,
o digitate FGAB C D E F G A B C ecc. (Sibelius inserira automaticamente i diesis in base
alla tonalita).

« Cambiate letichetta di testo del riquadro in F§ Maggiore.
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A questo punto dovreste poter vedere:

Se desiderate cambiare il carattere della scala, per esempio, da maggiore a minore armonica, Sibelius
dispone di un'utile funzione per eseguire loperazione istantaneamente:

« Selezionare le quattro battute della scala di D maggiore.

« Selezionate Inserimento nota» Trasformazioni »Altro » Trasforma scala.

« Nel riquadro che appare, Scala corrente deve essere impostato su D Maggiore (lonica).

« Dallelenco a tendina Nuova scala scegliete F Minore armonica e fate clic su OK.

Le note vengono cambiate per formare un tipo di scala completamente diverso (dovrete comunque
cambiarne letichetta e la tonalitd):

F Harmonic Minor

Potreste anche inserire i nomi delle note sotto il rigo per aiutare gli studenti ad apprendere la scala.
Selezionate le battute alle quali volete aggiungere i nomi delle note e selezionate Testo » Plug-in» Plug-in»
Testo» Aggiungi nomi note per far si che Sibelius aggiunga automaticamente il nome di ogni altezza
sopra o sotto il rigo.

Per maggiori informazioni sulla gamma di plug-in di Sibelius, consultare £ 1.22 Lavorare con
i plug-in nel Manuale Operativo.
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4.3 Layout e formattazione

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 4 e che
la versione 3 Layout e formattazione sia la versione corrente, selezionando Revisione» Versioni»
Modifica versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

Questo capitolo mostra come eseguire layout e formattazioni piti complesse, utili nel caso vogliate
creare quaderni di lavoro incompleti da far completare ai vostri studenti. Apprenderemo a creare
esercizi per gli studenti in cui dovranno completare una scala, copiare una scala su un rigo con una
differente chiave e identificare il tipo di scala.

Aggiungere un altro rigo
Prima di tutto inseriremo un rigo di viola, con una chiave alto:

+ Selezionate Home » Strumenti» Aggiungi o Elimina (comando rapido I).

« Dalla famiglia Archi selezionate Viola e fate clic su Aggiungi alla partitura.

« Selezionate Viola nellelenco a destra e utilizzate il pulsante Giu per spostarlo sotto Senza nome
(rigo di violino).

« Fate clic su OK per tornare alla partitura.

Ora nascondete il nome dello strumento che appare all'inizio di ogni sistema cambiando le impostazioni
nel gruppo Aspetto» Nomi strumento. Selezionate Nessuno dai menu a tendina All'inizio e
Successivamente.

Nel caso vogliate inoltre nascondere le indicazioni di tonalita d'avvertimento create alla fine dei
sistemi nel rigo Viola potete selezionarli e fare clic sulla parte superiore del pulsante Home » Modifica »
Nascondi o mostra.

Scale incomplete
Adesso creeremo degli esercizi con scale incomplete, che gli studenti potranno completare. Prima
di tutto fate triplo clic sul rigo di violino per selezionare tutto, quindi Alt-clic o ~=-clic sul rigo di viola
per copiare tutte le scale, ed infine abbassate le altezze di unottava premendo Ctrl+\ 0 3. A questo
punto possiamo rimuovere dalla partitura il materiale che vogliamo venga completato dagli studenti:

« Selezionate le ultime tre battute della scala minore armonica di F sul rigo di Viola e cancellatele
premendo Cancella.

« Mentre le battute sono ancora selezionate, nascondetene le pause premendo Ctrl+Maiusc+H o
o3 H. (Se state creando un quaderno di lavoro da dare agli studenti in versione stampata, potreste
semplicemente nascondere le note invece che cancellarle, visto che non appariranno nella stampa.
In questo modo Sibelius lascera abbastanza spazio vuoto per gli studenti in modo da permettergli di
aggiungere le note corrette).

« Premere Esc per deselezionare tutto.
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Sul rigo di violino dovreste poter vedere una scala minore armonica di F completa e soltanto le prime
otto altezze sul rigo di viola, seguite da tre battute vuote:

b b
g [FHermonic]

Adesso facciamo lo stesso per la scala di Eb maggiore, ma questa volta nasconderemo l'intero rigo di
violino:

+ Una volta sistemata la versione incompleta di viola della scala di Eb maggiore, seguendo lo stesso
metodo appena visto, selezionate le quattro battute della versione per rigo di violino della stessa scala.
« Premete Cancella per rimuovere tutte le note.

« Selezionare Layout» Righi Nascosti» Nascondi Righi Vuoti (comando rapido Ctrl+Maiusc+Alt+H
0 o~¥H).

« Il rigo di violino scompare, lasciando visibile solo il rigo di viola:

Eb Major
102 Wy ) > T T T n
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In questo modo sara possibile offrire suggerimenti per aiutare gli studenti a completare le scale,
o semplicemente rimuovere le altezze e lasciare che gli studenti le inseriscano loro stessi.

Provate a trasformare altre scale in esercizi, usando i metodi di layout appena appresi.

« Cancellate le scale discendenti di E maggiore su entrambi i righi e nascondetene le pause.

« Cancellate le due battute centrali della scala di F maggiore sul rigo di viola, nascondetene le pause,
rimuovete la scala dal rigo di violino ed infine nascondete il rigo di violino completamente.

« Inserite un'interruzione di pagina tra le scale di E maggiore e F maggiore selezionando la doppia
stanghetta e scegliendo Layout» Interruzioni» Interruzione di pagina (potete rimuovere
un'interruzione di pagina selezionando nuovamente Layout» Interruzioni» Interruzione di pagina).

« Inserite un'altra interruzione di pagina tra le scale di G maggiore e A maggiore.
« Cancellate le scale di F4 maggiore, G maggiore e G§ maggiore dal rigo di violino e nascondete le pause.

« Cancellate le scale di A maggiore, B> maggiore e B maggiore dal rigo di viola e nascondete le pause.

Trascinare e ordinare i righi
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Il nostro quaderno di lavoro non comprende ancora delle domandi, quindi aggiungeremo alcune
operazioni per completezza. Prima, pero, dovremo spostare le accollature o inserire delle indentazioni
per fare spazio in modo da poter inserire del testo tra di esse.

Useremo le scale di C maggiore e C4 maggiore come esempi. Faremo rientrare i sistemi in modo da
aggiungere del testo alla loro sinistra:

« Passate a Visualizza » Invisibili » Maniglie (per mostrare piccoli rettangoli su oggetti come righi,
stanghette, gambi di nota, ecc. per indicare che € possibile trascinarli per cambiarne la posizione).

« Fare clic sul rettangolo all'inizio della prima battuta del rigo di violino.
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Trascinate il rigo fino a che la prima stanghetta appare alla stessa altezza della parola "e" del titolo
inserito precedentemente:

SCALE E ARPEGGI

Quaderno di lavoro 1

Allo stesso modo, trascinate l'inizio del sistema con le scale di C# maggiore fino allo stesso punto:

Nome:
Classe:

SCALE E ARPEGGI

Quaderno di lavoro 1

b b
H — b

Prima di aggiungere il testo trascinate in basso il rigo di violino con la scala minore armonica di F per

creare pil1 spazio tra questo rigo e quello superiore. Per far cio fate clic semplicemente su uno spazio vuoto
nel rigo e trascinate.

Allo stesso modo, trascinate il rigo di viola con la scala di Eb maggiore ed il rigo di violino con la scala
di E maggiore per far spazio sopra di essi.
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Inserire testo in un quaderno di lavoro
Dato che esistono molti tipi di testo che potremmo voler inserire in un quaderno di lavoro (domande,
citazioni, esempi, spiegazioni, ecc.), la migliore opzione per aggiungere testo € usare lo stile di testo
normale di Sibelius.

Qualsiasi normale testo che aggiungerete a questo quaderno di lavoro apparira usando il font di
testo principale (che abbiamo cambiato a Verdana in precedenza), senza alcun carattere o simbolo
musicale speciale, in modo che potrete usarlo esattamente come in un programma di scrittura.

Facciamo una prova inserendo una spiegazione alla sinistra dei due esempi di scale che abbiamo

appena ordinato:

« Seleziona Testo normale dalla categoria Comuni della galleria Testo » Stili» Stile.

« Il puntatore del mouse diventa blu.

« Fate clic per posizionare il testo in modo che il cursore lampeggiante appaia allo stesso livello
della parte superiore del primo rigo ed in linea con il titolo.

« Scrivete il testo seguente:

La scala maggiore & una delle scale pil importanti nella musica classica occidentale.

Completate tutte le scale incomplete presenti in questo quaderno di lavoro. Aggiungete le
altezze mancanti per la chiave di violino e alto.

« premete Esc due volte per interrompere I'immissione testo e deselezionare il tutto.

Notate come la posizione del testo lo faccia sovrapporre alla musica. Trascinate le maniglie negli
angoli della casella di testo per ridimensionarla e riposizionarla nello spazio che abbiamo creato a
sinistra della prima accollatura.

Adesso creeremo ulteriore testo normale per aggiungere spiegazioni sopra i differenti tipi di scale;
usate lo stesso metodo per inserire il seguente testo sopra la scala minore armonica di F:

Anche la scala minore armonica & molto importante nella musica classica occidentale ed in
molte altre tradizioni musicali. Completate la scala minore armonica di F qui sotto copiando
le note nella chiave di alto:

Ed ancora, sopra la scale di Eb maggiore:
Completate la scala di Eb maggiore nella chiave di alto:
E per finire:
Completate queste scale di E maggiore nelle chiavi di violino e alto:

Il testo normale ¢ utile in molti diversi contesti, dato che appare esattamente dove fate clic per posizionarlo,
in modo che possiate posizionare del testo in un qualsiasi punto di una pagina e ridimensionare
successivamente le cornici testuali in modo che il contenuto si adatti allo spazio fornito.
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Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 4 e che
la versione 4 Controllo classe sia la Versione corrente, selezionando Revisione» Versioni» Modifica
Versioni, selezionando questa versione dall'elenco e facendo clic su Rendi corrente.

Nel caso abbiate una versione di Sibelius con licenza di rete attiva sul Server delle licenze di Sibelius,
esistono varie funzionalita disponibili per gli insegnanti, pensate espressamente per ottimizzare
T'utilizzo di Sibelius in classe. Questo capitolo vi mostrera come distribuire rapidamente il lavoro
tra gli studenti o raccogliere la partitura su cui stanno lavorando. Apprenderemo inoltre ad effettuare
un rapido confronto tra il lavoro di uno studente e la versione con le risposte completate.

Distribuzione del lavoro usando il Server delle licenze di Sibelius
Per accedere alle funzioni di controllo classe di Sibelius, selezionate File » Insegnamento, e fate
clic sul pulsante Controllo Classe e inserite la password dell'insegnante che avete impostato nel
pannello di controllo del Server delle Licenze. La finestra di dialogo che appare mostrera una lista
di computer collegati al Server delle licenze e la partitura su cui stanno lavorando.

Proviamo ad inviare a tutti gli studenti della classe il quaderno di lavoro che abbiamo creato:

« Fare clic su Seleziona tutto per selezionare tutti gli studenti elencati.

« Fare clic su Invia partitura corrente.
Sibelius distribuira la partitura a tutti i computer collegati attraverso la rete.

In questo modo potrete inviare qualsiasi partitura all'intera classe (fare clic su Invia altra partitura se
non ne avete una aperta), o se desiderate inviare del lavoro ad un solo studente bastera selezionarne il
nome dallelenco e fare clic su Invia partitura corrente/Altra partitura.

Raccogliere le partiture usando il Server delle licenze di Sibelius
Nello stesso modo in cui abbiamo distribuito il lavoro attraverso una rete, potremo raccogliere le partiture
degli studenti con un solo clic. Proviamo a recuperare i quaderni di lavoro completati da tutti gli studenti:
« Fare clic su Seleziona tutto per selezionare tutti gli studenti elencati.

« Assicuratevi che il pulsante di opzione Salva e apri le partiture recuperate sul lato destro della
finestra di dialogo sia stato scelto.

« Fare clic su Ottieni partitura.

Sibelius raccoglie le partiture attraverso la rete da ciascun computer collegato e le salva sul vostro
computer, quindi le apre tutte.

Per trovare le partiture, aprite la vostra cartella Partiture: dentro una cartella chiamata Partiture studenti
ci sono delle cartelle singole per ogni studente contenenti le loro partiture.

Potrete recuperare una singola partitura da qualsiasi studente nello stesso modo, selezionandone il
nome dallelenco e facendo clic su Ottieni partitura.

Per maggiori dettagli, consultare I 1.19 Controllo classe nel Manuale Operativo.
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Passare da una partitura all’altra
Quando aprite tutte le partiture dei vostri studenti, potreste accorgervi che cambiare da una all'altra

puo essere abbastanza disorientante. Sibelius aggiunge il nome utente dello studente in coda al nome
del file della partitura, in modo che possiate vedere subito quali partiture sono aperte facendo clic
su Visualizza » Finestra » Cambia finestra e guardando i file aperti elencati.

Confronto tra quaderni di lavoro completati
Potrete usare la finestra Confronta di Sibelius per vedere rapidamente le differenze tra la versione

del quaderno di lavoro completata da uno studente e quella corretta!

Se non vedete la finestra Confronta, selezionate Revisione » Confronta » Confronta (comando rapido

Ctrl+Alt+C 0 ~#¥C):

ﬂ Confronta

[ S

Confronta: ‘ Frogetto 4

hd |

Com: ‘- Quaderni di Lavoro terminato |

=

Muove misure

bisure precedent Righi

Differenze

a8

Proviamo a confrontare la partitura di uno studente con quella contenente le risposte corrette. (Se non
avete recuperato la partitura dello studente potete semplicemente completare il quaderno di lavoro
voi stessi — assicuratevi di inserire qualche errore in modo da venire corretti!)

« Aprite la partitura desempio Progetto 4.

« Dalla finestra Confronta scegliete la versione completata dallo studente nellelenco a tendina

Confronta.
« Scegliere la versione — Quaderno di lavoro completato nel file Progetto 4 dallelenco a tendina Con.

« Fare clic sul pulsante Confronta ([5)).

« Sibelius visualizzera entrambe le partiture una di fianco all'altra e mostrera un resoconto delle differenze.
Da queste differenze dovreste essere in grado di capire se lo studente ha completato correttamente
o meno il quaderno di lavoro.

« Fare clic su Chiudi per tornare alle partiture. La finestra Confronta mostra adesso un elenco delle
differenze tra i due quaderni di lavoro:

Tutti

Tutti

Tutti

Tutti

Tutti

Tustti
‘

di
=

Confronte | Onchestrale

Con: | senza nome

Tuth
Tutt
Tutti
Tutti
Tutti
Tutti

Mugve misure  Misure precede Righi

Oboes 1 + 2 [er..
Double bass (e
Hemsl + 2 (era..
Basz Trembeone .

Flutes1 + 2
Viadin |

5

Differenze

Soprano sostitute con Oboes 1 + J

Tenor sostituito con Contrabass

Soprane sestituite con Horm in E

Banfone sostituite con Tuba

Flute aggiunto alla partitura rrvista

Wialen | saaiunts alls partiturs s ™
v
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Fare doppio clic su una qualsiasi differenza nellelenco per visualizzare le corrispondenti battute in
entrambe le partiture. Sibelius inoltre usera un fondo colorato per indicare gli oggetti che sono stati
aggiunti (verde), rimossi (rosso) o modificati (arancio).

Grazie a questo potente strumento sara possibile individuare rapidamente quali studenti non hanno
potuto completare un esercizio, e inoltre generare un resoconto dettagliato delle differenze riscontrate
da Sibelius — completo con schermate delle partiture — che potrete aprire allinterno del vostro software di
scrittura. Per ulteriori informazioni su versioni e sul confronto tra partiture, consultare 1 10.3
Versioni nel Manuale Operativo.
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5.1 Usare video

In Sibelius ¢ possibile aggiungere alla vostra partitura un video sincronizzato alla riproduzione, in
modo da permettervi di comporre musica per immagini senza dovervi preoccupare di SMPTE, LTC,
striping o nessun altro grattacapo tecnologico di sincronizzazione — tutto quello di cui avrete bisogno sara
il vostro computer, che lo rende ideale per I'impiego nelle scuole come a casa o in situazioni professionali.

Questo progetto introduce alcuni modi di usare video all'interno di Sibelius, tra cui la creazione di hit
point, la visualizzazione di timecode sulla partitura e l'adattamento della musica alle immagini
impiegando i plug-in. Apprenderete inoltre ad esportare audio da Sibelius per usarlo come colonna
sonora per un video all'interno del vostro software di edizione, come Avid Studio, per esempio.

Il primo capitolo di questo progetto esamina come aggiungere un video ad una partitura esistente.

Per riprodurre video in Windows, Sibelius puo usare sia Windows Media Player che QuickTime (se ¢
installato), e QuickTime su Mac. In altre parole, qualsiasi video riproducibile dal vostro sistema operativo
dovrebbe funzionare senza problemi all'interno di Sibelius. Per un elenco completo dei formati
normalmente supportati dal vostro sistema operativo, £1 6.10 Video nel Manuale Operativo.

Prima di tutto, scegliere File » Apri (comando rapido Ctrl+O o0 #0) e individuare la partitura desempio
Progetto 5, all'interno della cartella File Progetto presente nella cartella delle partiture desempio.
Aprite questa partitura.

Si tratta della partitura originale scritta da Howard Goodall per un estratto della serie animata TV
con protagonista il noto personaggio Mr.Bean.

Prima di aggiungere un video alla partitura, dovreste rendere 1 Uso della funzione video la
versione corrente, selezionando Revisione » Versioni» Modifica versioni, selezionando questa
versione dalla lista e facendo clic su Rendi corrente.

Aggiungere un video ad una partitura
Per aggiungere un video alla partitura:

« Selezionate Riproduzione» Video» Video » Add Video.
« Il file video Mr. Bean si trova nella stessa cartella della partitura Progetto 5; selezionatelo e fate clic

su Apri.

Il video apparira all'interno della finestra Video di Sibelius, mostrando il frame corrispondente alla
posizione corrente indicata dalla linea verde di riproduzione.

Dopo aver allegato il video, premete Space per iniziare la riproduzione e osservate come Sibelius
riproduce la partitura; guardate attentamente inoltre il filmato di Mr. Bean, dato che proveremo a
far coincidere la musica con le azioni dei personaggi pili avanti in questo progetto.

Notate come il video viene sempre riprodotto sincronizzato alla partitura, anche quando muovete
lo slider tempo per regolare la velocita di riproduzione. Il video rimarra sincronizzato anche se muovete
lo slider timeline nel pannello di trasporto: provate e vedrete!
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La

finestra Video
Per mostrare o nascondere la finestra video, selezionate Finestra » Pannelli» Video, oppure usate la
scorciatoia Ctrl+Alt+V o ~-#V.

Il video contiene gia dei dialoghi, ma sara possibile regolarne il livello in modo che non interferiscano
con il volume della partitura su cui state lavorando. Regolate semplicemente a vostra scelta la posizione
dello slider volume nella finestra Video. Con il cursore allestrema sinistra la colonna sonora del video
sara completamente muta.

Potrete regolare la dimensione della finestra video usando i quattro pulsanti alla sinistra del controllo
volume nella finestra Video stessa. Vi permetteranno di ridimensionare il video rispettivamente al 50%,
100%, 200% delle sue dimensioni originali, o a schermo pieno. In alternativa potete usare gli elementi
del menu nel menu Riproduzione » Video » Video.

Trovare video

124

Se desiderate comporre musica per immagini, Internet ¢ in assoluto la migliore fonte di video. Esistono
molti siti web con pubblicita o anteprime di film che potreste scaricare e usare come materiale per progetti
di composizione per gli studenti.

Potreste anche scrivere musica per i vostri propri video — pill avanti in questo progetto apprenderemo
come usare una partitura di Sibelius come colonna sonora all'interno di un software di edizione video.
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5.2 Comporre musica per immagini

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 5 ¢
che 2 Comporre musica per immagini sia la versione corrente, selezionando Revisione » Versioni»
Modifica versioni, selezionando questa versione dalla lista e facendo clic su Rendi corrente.

Per aggiungere il video a questa versione, selezionate Riproduzione » Video» Video » Aggiungi Video
e selezionate il file video Mr. Bean dalla stessa cartella della partitura Progetto 5.

1l video apparira all'interno della finestra Video di Sibelius, mostrando il frame corrispondente alla
posizione corrente indicata dalla linea verde di riproduzione.

Questo capitolo vi insegnera come usare timecode, hit point e i plug-in per adattare la musica alle
immagini.

Inserire timecode e durata
Timecode ¢ la posizione temporale di un punto in una partitura o video. In genere ¢ misurato dallinizio
della partitura, oppure in film/TV dall’inizio della bobina o da qualche altro punto particolare.
Quando si riproduce una partitura il valore timecode & visualizzato nel pannello Trasporto, insieme a

una lettura del tempo corrente in beat al minuto (3 6.1 Lavorare con la riproduzionenel
Manuale Operativo).

Hit point sono riferimenti di tempo nella partitura che evidenziano scene importanti in un film o video,
per semplificare la composizione in corrispondenza di questi punti.

Sibelius puo visualizzare automaticamente il timecode come testo nella vostra partitura. Calcola la
posizione temporale delle stanghette basata su numero di battute, durate battuta e segni di metronomo
fino a quel punto. Il timecode ¢ molto utile per lavorare sullesatta temporizzazione di particolari
passaggi musicali o per sincronizzare eventi musicali con gli hit point (o le scene in un film).

Proviamo ad aggiungere il timecode in modo che appaia nella partitura sopra ogni sistema, insieme
ad un marker con la durata calcolata:

+ Selezionate Riproduzione» Video» Timecode:

Timecode e Durata

Inizio

Timecode della prima
misura n

Inizisre video 3. @ Inizio partiturs
0.0 in partitura

Inizio video da: 00" nel video
Timecode Units

Sopra ogni misura Secondi (1:23' 047)

All'inizio di ogni accollatura @ 0.1secondi (1:23' 0457
© Messuno Frames (01:23:04:15)

1 Nascondi sopra la prima misura 15

Durata 23,97
Durata alla fine della partitura

Posizione

Visualizza timecode ¢ hot points su:

Rigo in alto -

ok [ Annulla_]
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« Scegliere il pulsante di opzione All'inizio di ogni accollatura per dire a Sibelius di visualizzare
il timecode su ogni sistema.

 Attivare Durata alla fine della partitura.

« Cambiare I'impostazione Unita a Frames (01:23:04:15) in modo da calcolare il timecode basandosi
sul numero di frame per secondo. (Si tratta del formato standard per comporre per film/TV).

* Assicuratevi che il numero di frame per secondo sia impostato su 24 e fate clic su OK per tornare alla
partitura.

Dovreste adesso poter vedere una lettura del timecode sopra ad ogni sistema della partitura. Sibelius
ricalcolera il timecode nel caso venga cambiato il tempo, vengano aggiunte o rimosse battute, vengano
cambiate le durate della battuta, e cosi via.

giungere gli hit point

Quando un hit point viene aggiunto alla partitura, viene inserito alla posizione corrente della linea
di riproduzione. Potete aggiungere un hit point facendo clic sul pulsante Aggiungi Hit Point (& )
sulla finestra Video, oppure facendo clic sulla parte superiore del pulsante Riproduzione» Video» Hit
Point. Un hit point viene inserito sopra quel punto nella partitura; Sibelius ricalcolera la posizione
di ogni hit point nel caso venga cambiato il tempo, vengano aggiunte o rimosse battute, vengano
cambiate le durate della battuta, esattamente come con il timecode.

Identificheremo ora dei punti specifici del video di Mr. Bean nei quali la musica dovrebbe coincidere
con l'azione, ogni volta che gli operai fanno cadere il piano:

« Assicuratevi che la linea di riproduzione sia all'inizio della partitura e premete Spazio per dar
inizio alla riproduzione.

« Ogni volta che gli operai lasciano il piano nel video di Mr. Bean fate clic sul pulsante Aggiungi
Hit Point.

Alla fine della partitura dovreste aver creato cinque hit point. Dovrebbero essere approssimativamente a
questi punti:

Hit 01 — 00:00:27:00
Hit 02 - 00:00:40:01
Hit 03 — 00:00:50:12
Hit 04 - 00:01:00:19
« Hit 05 — 00:01:07:23

Non preoccupatevi se gli hit point inseriti non coincidono esattamente con i valori riportati, visto che
adesso apprenderemo a modificare e rimuovere gli hit point.
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Modificare gli hit point
Modifichiamo gli hit point appena aggiunti alla partitura facendo clic sulla parte inferiore del pulsante
Riproduzione » Video » Hit Point (comando rapido Shift+Alt+P o &~P):
« Nella finestra di dialogo che appare dovreste poter vedere un elenco degli hit point appena aggiunti.

« Per cambiare il timecode di un hit point fate clic una volta sul valore Timecode per selezionarlo,
quindi fate clic di nuovo per immettere i valori esatti riportati qui sopra.

« Premere Invio (sulla tastiera principale) per apportare la modifica.

Potete modificare il Nome di un hit point nello stesso modo, per cui, come esempio, provate a cambiare

tutti gli hit point da Hit 01 a Piano Drop 01, ecc.

Potete anche cancellare qualsiasi hit point selezionandolo e facendo clic su Cancella, o creare un nuovo

hit point facendo clic su Nuovo. Al termine delle modifiche fare clic su OK per tornare alla partitura.

Per maggiori informazioni, consultare £J 6.11 Timecode e hit point nel Manuale Operativo.
Adattare la musica esistente alle immagini

Sebbene sia possibile cambiare il tempo della vostra partitura in modo che gli eventi musicali coincidano
con le scene del clip video, Sibelius dispone di un utile plug-in per rendere automatico il processo:

« Effettuate una selezione di passaggio nel rigo Bassoon dall'inizio della battuta 8 alla prima nota
della battuta 12.

 Selezionate Inserimento note» Plug-in»Plug-in» Strumenti di composizione» Adatta
selezione a tempo.

+ Cambiare lopzione Imposta fine selezione su Tempo dell’hit point selezionato.
« Scegliere Piano Drop 01 dallelenco a tendina e fare clic su OK.

« Sibelius calcolera il cambio di tempo necessario per far si che I'hit point coincida esattamente
con lo spazio nella musica, e visualizzera un resoconto dei cambi introdotti. Fare clic su Chiudi
per tornare alla partitura.

« Se riprodurrete la partitura adesso noterete che il video ed il suono sono perfettamente sincronizzati,
con gli operai che posano il piano sul secondo beat della battuta 12!

« Allo stesso modo, effettuate una selezione di passaggio dal secondo beat della battuta 12 al terzo beat
della battuta 16, quindi cambiate 'opzione Imposta fine selezione in modo che coincida con
T'hit point Piano Drop 02.

Continuate ripetendo loperazione con gli ultimi tre hit point, in modo che coincidano con questi punti:

« Piano Drop 03 sul secondo beat della battuta 20.

+ Piano Drop 04 sulla pausa da 1/8 (croma) prima dell'ultimo beat della battuta 23.

« Piano Drop 05 sulla pausa da 1/8 prima del secondo beat della battuta 26.

Infine, assicuratevi che la fine coincida con il momento in cui Mr. Bean sorride da solo:

« Eseguite una selezione di passaggio dalla pausa di 1/8 della battuta 26 fino al primo beat della battuta 29.

« Selezionate Inserimento note» Plug-in» Plug-in» Strumenti di composizione» Adatta
selezione a tempo.

+ Cambiare lopzione Imposta fine selezione a su Nuovo tempo fine.

+ Immettere 0 Ore 1 Minuti 17 Secondi e fare clic su OK.
A questo punto potete riprodurre I'intera partitura per vedere i risultati.
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5.3 Aggiungere una colonna sonora ad
un video

Se iniziate da questa sezione del progetto assicuratevi di aprire la partitura desempio Progetto 3 e che
la versione 3 Aggiungere la colonna sonora ad un video sia la versione corrente, selezionando
Revisione» Versioni» Modifica versioni, selezionando questa versione dall'elenco e facendo clic
su Rendi corrente.

Per aggiungere il video a questa versione selezionate Riproduzione » Video » Video » Aggiungi Video
e selezionate il file video Mr. Bean dalla stessa cartella della partitura Progetto 5.

Questo capitolo vi mostrera come esportare come file audio una partitura creata in Sibelius, in modo da
abbinarla come colonna sonora ad un video, usando il programma di edizione di vostra scelta.

Esportare un file audio
Quando si usano strumenti virtuali, come Sibelius 7 Sounds, Sibelius permette di esportare la
partitura come file audio con un solo clic. Potrete usare i file audio per creare direttamente un CD,
o convertirli in altri formati, come MP3, in modo da poter passare le registrazioni a direttori o
musicisti per dar loro un'idea di come la musica suona, o anche solo per permettergli di far pratica
suonando sulla musica.

Proviamo ad esportare un file audio della colonna sonora di Mr.Bean:

Selezionate Riproduzione» Trasporto» Sposta linea di riproduzione all’inizio (comando rapido
Ctrl+[ 0 &) o fate clic sul pulsante nel pannello Trasporto.

« Selezionate File » Esporta» Audio e fate clic sul pulsante Esporta.

« Scegliete un nome per il vostro file audio e fate clic su Salva.

« Sibelius registrera la vostra partitura come file audio e lo salvera nella stessa cartella della partitura.

Per maggiori informazioni, consultare 21 1.11 Esportazione di file audio nel Manuale Operativo.
Aprire un video nel vostro software di edizione video
A questo punto dovreste lanciare il software di edizione video di vostra scelta. In questo caso vedremo

come usare Avid Studio (solo per Windows ) per modificare un video, ma potreste usare anche iMovie,
Windows Movie Maker o qualsiasi altro programma.

Aprite il video a cui volete aggiungere la colonna sonora.
Aggiungere una colonna sonora in Avid Studio
Fate clic sul pulsante Importa.

Cercate il file audio esportato da Sibelius, fate clic sull'anteprima per selezionarlo e fate clic su Inizia
importazione per aggiungerne una copia nella vostra libreria. Ora passate alla scheda Video e trascinate
il file audio dalla vostra libreria a qualsiasi traccia sulla timeline.

Completare il vostro video in Avid Studio
Fate clic sul pulsante Esporta.

Selezionate se salvare il vostro video sul vostro disco per siti web, e-mail o presentazioni, masterizzatelo
o pubblicatelo direttamente su YouTube.

Per creare un Blu-Ray o un DVD, inserire un disco registrabile e fare clic sulla scheda Disco. Fare clic su
Crea disco per masterizzare il vostro video.
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